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Has autofocus ever annoyed you because it missed a moving target? Or

when it pumps back and forth searching for the right setting? Things get

even worse if a focus error exists that is too slight to see in the viewfinder but

is glaringly obvious when you view your images on a computer. Glitches like

these often spoil a whole sequence of photos and raise the question of

what’s wrong and how you can improve the situation.

The best solution is to get to grips with how the autofocus system built into

your DSLR or mirrorless camera works. Our Author Ralph Altmann has dug

deep into the technology behind today’s autofocus systems and has come up

with a great article that tells you all you need to know about how your camera

keeps things sharp. He has also invented a simple computer-based method

for testing your camera’s AF system and even explains how to improve its

accuracy. See page 68 and this issue’s free online content for details.

Now you can head off to the racetrack or your child’s birthday party safe in

the knowledge that your photos will come out pin sharp. And, if you’re

looking for the right universal lens for the occasion, check out our 70-200mm

zoom test on page 16 for details of the best name-brand and third-party

glass on the market.

Have fun and see you next time ...

Peter Nonhoff-Arps



How to Create Cool Headshots   40
Telephoto Zoom Test    16

Portfolio
Charlotte Steffan is a master of minimalistic
compositions and a shoots using a minimum of 
gear too.

10 Charlotte Steffan Portfolio

Telephoto Zoom Test
70-200mm zooms are great all-round lenses for a
wide range of situations. We test a selection of 
major brand and third-party models for DSLR and
mirrorless systems.

16 Market Overview

20 Individual Tests

Pentax K-3 II
The K-3 II is more than just an update and includes
innovative features such as ‘Pixel Shift Resolution’ 
for capturing enhanced-resolution images. 

36 Pentax K-3 II Test

Headshots
Headshots play an important role in estblishing
digital identities. Peter Hurley’s star student Gabriel
Hill explains the gear and the techniques you need 
to get started shooting your own.

40 Introduction

46 The Anatomy of a Headshot

50 Headshot Setups

All-weather Gear for Your Camera
Water, moisture, dust, sand, and extremes of cold and
heat are tough on your camera and lenses. Arctic tour
guide Sandra Petrowitz explains how to protect your
gear and capture great photos in bad weather.

54 Introduction

57 Water and Moisture

62 Cold and Heat, Dust and Sand

64 Shooting Tips

Autofocus Workshop
A photographic life without autofocus is impossible to
imagine, but how does autofocus work and what can you
do if it doesn’t function as intended?

68 How Autofocus Works

78 Autofocus Calibration Tool Test

82 Check and Adjust Your Cameras’s AF System

High-end Photo Printers
Wide-format printers produce high-quality images and
give you complete control over the printing process. We
test the best current models from Canon and Epson.

86 Introduction

91 Test Results

4 c’t Digital Photography 21 (2015)



All About Autofocus   68
George Lepp Panorama Workshop 116

Sharpening in Photoshop
Sharpening is an essential part of the digital image 
creation process. This article explains how to get the most
out of Photoshop’s sophisticated sharpening tools

94 What Is Sharpening?

98 Applying Unsharp Mask

101 Selective Sharpening

Magic Lantern
Creative developers have discovered a back door into
Canon’s DSLR firmware that enhances your camera’s toolset
with a huge range of additional features and functions.

102 Introduction and Installation

109 Focus Stacking

112 Trap Focus, Focus Peak and Magic Zoom

114 HDR

Creative Panorama Techniques
George Lepp is a master of the art of panoramic
photography and is constantly inventing new ways to utilize
this fascinating technique. This article introduces some of
his unique styles and the gear he uses to capture them.

116 Action Sequence Panoramas

123 Aerial Panorama Techniques

128 Gigapixel and Combined Panoramas

134 Macro Panoramas

About Us
3      Editorial

136      Book Review
138      Coming Up in Issue 22
138      Contact Info

Free Downloads
6      Highlights and Contents

Full Version Software
Movavi Photo Editor is a powerful photo editor
that enables you to give your images extra
polish with just a few simple clicks.

Special Edition Software
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Free Downloads
Navigate to www.ct-digiphoto.com/downloads212015
to download the content listed above for free
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Movavi Photo Editor 2.1.0 Full Version
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COLOR projects professional Special Edition
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Luminance HDR

Movavi Photo Editor 2.1.0 Full Version
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Visit www.ct-digiphoto.com/downloads212015 for free access to a full version of
Movavi Photo Editor, a special c’t edition of Franzis COLOR projects professional
and a range of exciting videos and video tutorials.

Spontaneous snapshots often contain color
errors, sloping horizons or unwanted details that
spoil the look of the photo. Movavi Photo Editor
provides the tools you need to remove these
annoying side effects with
just a few simple clicks and
the ‘Resize’ tool enables you
to scale your edited images
as you wish. A single click on
the ‘Magic Enhance’ button
automatically optimizes
contrast, saturation and
color temperature, while 
the ‘Cut Out’ tool makes
swapping out backgrounds
a snap and the ‘Delete’ tool
simply erases objects you
don’t like. You can also
create custom text overlays

and save your results in a range of formats.
Photo Editor has a clean, easy-to-use interface
that makes advanced image processing tasks
simple to perform.

c’t Digital Photography readers can register
via e-mail for a free copy of Movavi Photo Editor.
Windows users qualify for a 40% discount on a
purchase of Movavi Photo Studio, and Mac users
receive a 60% discount on Movavi Video
Converter. These offers are valid until January
15th 2016. (tho)

Movavi Photo Editor

Full version software: Movavi Photo
Editor lets you optimize your photos in
just a few clicks.

In this workshop, pro photographer Bert Stephani
puts his camera down and lets his assistant
Laurent photograph a model. Stephani has plenty
of useful tips for his less experienced colleague
and certainly proves his mettle as a photo coach,
constantly optimizing his assistant’s ideas. As well
as helping Laurent concentrate on the details, he
also discusses basics like composition, the choice
of background and communication with the
model. As a viewer, you can learn from Laurent’s
mistakes and use the results to improve your own
portrait photography skills. (sea)

Coached Shooting 

Video tutorial: Bert Stephani plays
coach and lets us in on some of his
secrets for great portrait sessions. 
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Highlights & Contents | Downloads 

Franzis COLOR
projects professional

Special edition software: This package
offers new and unique ways to
transform your photos into digital
works of art using smart tools and a
crystal-clear workflow.

With 84 fine-tuned presets, 85 high-quality
expert filters, 35 professional film emulations
with Grain Engine and a perfectly tuned tonal
value transformation, you can now create
unique high-end results in full 16-bit quality.

The supplied presets include Landscape,
Nature/Animals, Portrait, Nude, Technical,
Architecture, Reportage, Still Life, Long
Exposures, Graphics and Artistic Interpretation
and can easily be tweaked to create your 
own looks. The built-in expert filters include
Denoising, Sharpen, Gamma, Brightness 
and Shadow Optimization and can be 
applied globally or selectively. Other high-end
features include raw import and analog film
emulation. The software can be installed as a
standalone tool or as a plug-in for Photoshop
and Lightroom. 

Use of the Windows version requires a
two-stage online registration during
installation. Mac users need to install the trial
version and send an email to the manufacturer
containing the text c’t Digital Photography –
Color projects for MAC. You will then receive a
free serial number via email. Registered readers
also qualify for a 40% discount on upgrades to
the full version of PHOTO WORKS projects #3.
These offers apply until March 31st 2016. (tho)

www.ct-digiphoto.com/downloads212015
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Portfolio 

Charlotte Steffan
Lines, patterns, nuances of color… Charlotte Steffan likes things
minimalistic and tidy – and that’s how she likes her photographs
too, most of which she takes using her iPhone.

Church Windows, Mannheim, Germany (2004)



Photographing the patterns revealed in
felled tree trunks and sawn-off branches,

taking inspiration from road markings, looking
for graphic elements in rows of houses or
window frames – out and about with her
camera, looking for subjects and allowing 
the world to make its impressions on 
her, Charlotte Steffan is not seeking the
sensational and prefers instead to “show the
everyday in a new light”.

The 60-year-old artist came late to
photography after taking early retirement.
She lives in Mannheim and spends a lot of
time traveling the city and its environs, but
not with a heavy camera and multiple lenses.

In the last few years she has used nothing
more than an iPhone most of the time. 

“I’m totally happy with the quality,” she
says – and she knows what she’s talking
about. “Early on, as I concentrated more and
more on technical things like aperture,
exposure, noise and sharpness, my eye 
for subjects became less keen and my
photography was the poorer for it, despite
using a reflex camera and high-quality
lenses.” Acquaintances and critics constantly
commented on this shift too, she
remembers. 

At some point, she pulled the plug on it all,
having realized that the fun had gone out of

photography for her. Yet fun, rather than
technology, which she now keeps to a bare
minimum, was the essential ingredient for
good photos. Now, her phone’s fixed focal
length lens is perfectly sufficient, “and I don’t
care whether there is more noise in my
images than the ones I made with my
super-duper DSLR.” 

But what determines whether an image is
successful or not? Her answer is impartial and
personal: “My images are supposed to stir up
the viewer’s emotions,” she says. “For me, a
good image is one that I like.”

This is why Steffan also prefers to avoid
‘deep and meaningful’ discussion and
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Green Glass, Munich, Germany (2005)



interpretation of her photographs. “For me,
the subject is important, and the image has to
make the right impact.” She names her
images by describing them, rather than
inventing a prosaic title – a method borrowed
from Robert Haeusser, one of her favorite role
models.

“I like line, I like black and white, and I like
everything to be tidy,” is how she outlines 
her photographic preferences and favorite
stylistic devices. “Technical processes and
skills transform raw material into a form
which, thanks to intense observation,
evocative symbolization and visual
effectiveness, far exceeds the result of 

the present moment,” as the quote from
well-known photographer and writer Andreas
Feininger explains on her website. “If that can
be achieved, then it is a good photo; reality
has become art.” That is her goal.

Steffan is enjoying increasing success with
this approach, having now displayed her work
to a broad public at 17 exhibitions. Her most
recent show comprised only iPhone photos,
and she is now selling these images too. Even
the city council in Mannheim is a customer,
she says with a wink, although in this case, the
buyer acquired some of her equally
fascinating infrared images rather than her
more graphic works. (keh)
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Charlotte Steffan | Portfolio

Learn more about 
Charlotte Steffan at

www.charlotte-steffan.de

www.xing.com/profile/Charlotte_
Steffan

Office Building, Mannheim, Germany (2010)
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Portfolio | Charlotte Steffan

Locker, Stuttgart, Germany (2010)

Floor Lamp, Berlin, Germany (2006)
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Road Markings, Nuremberg, Germany (2015)



Sophia Zimmermann 

Universal Lens Test

70-200mm Zooms
Telephoto zooms are great all-around lenses for a wide range of
situations and enable you to bring distant subjects closer, create
great-looking background blur and give your photos added
impact. Understandably, they are especially popular with travel
photographers. We test a selection of camera manufacturers’
own-brand lenses for DSLRs and mirrorless systems and compare
them with their cheaper third-party rivals. 

Atelephoto zoom with a focal length
range from 70-200 mm and a constant

maximum aperture is an essential part of any
serious photographer’s gear. Ideally, such a
lens is robust, provides high optical quality
and offers pro-grade features into the bargain. 

These specifications make this type of lens
ideal for travel photography, enabling you to
bring distant subjects closer and capture
camera-shy wildlife subjects without scaring
them. The comparatively small angle of view
also helps to separate selected details from
the background – an attribute that opens up
new vistas for vacation snaps that go above
and beyond garden-variety postcard-style
compositions.

Heavy Duty 

Telephoto focal lengths enable you to fill the
frame with your subject without having to

move closer and to compress the field of view
so that the background and foreground
appear closer together. These characteristics
make fast telephoto zooms great for
capturing portrait subjects in front of subtly
blurred backgrounds. ‘Compressing’ the field
of view is an effective compositional tool that
you can use to combine multiple subjects that
don’t usually belong together in a single
frame. 

The downside of all this photographic
power is added bulk, especially in faster lenses
(i.e., those with larger maximum apertures).
For example, the Canon EF 70-200mm f/2.8L
IS II USM weighs 3.3 lb and is 7.8” long. Used
with a full-frame DSLR such as the EOS 6D, you
will have to lug nearly 5 lb of gear around,
which can be really tiring on a long hiking
tour. Used with the Nikon D610, The AF-S
NIKKOR 70-200mm f/2.8G ED VR II cracks the
5 lb mark. 
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Third-party Alternatives 
and Slower Lenses
Weight alone is probably not the only factor
that will scare off some hobby photographers.
The RSP for the stabilized f/2.8 L-series Canon
lens is $2,099, and the AF-S 70-200mm
NIKKOR is slated to sell for $2,400.  

But there are alternatives. The major
camera manufacturers all offer 70-200mm
zooms with a smaller maximum aperture of
f/4.0. The Canon EF 70–200mm f/4L IS USM
weighs less than 2 lb and costs just over half
the price of its faster sibling, while the AF-S
NIKKOR 70-200mm f/4G ED VR weighs in at
1.9 lb and costs $1,000 less than the faster

version. These models are definitely easier to
carry but sacrifice some capability for
portability.

This is also where third-party lenses come
into play. Sigma and Tamron both offer
70-200mm f/2.8 zooms for various mounts
and, although its RSP lies at $1,399, the Sigma
70-200mm f/2.8 EX DG APO OS HSM for
Canon and Nikon is available on the open
market for less than $1,200. The Tamron
70-200mm f/2.8 Di VC USD has an RSP of
$1,499 but can be purchased online with
various rebates. Both these lenses are
stabilized, which is a real boon when shooting
at long focal lengths. 

70-200mm Lenses 
for APS-C DSLRs

The lenses mentioned so far are all full-frame
models that can also be used with APS-C
cameras from the same manufacturer,
although you have to account for the crop
factor if you do. Dedicated APS-C telephoto
zooms are rare, and Canon only offers zooms
for its crop format cameras with variable
maximum apertures. Nikon, too, concentrates
on offering the maximum possible zoom
range and gives less emphasis to speed in its
APS-C lenses. 

To date, all Pentax DSLRs have APS-C
sensors, so the K-Mount DA* 50-135mm f/2.8
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Lens Test | 70-200mm Telephoto Zooms

This is the test chart we use to determine the number of line pairs each lens can resolve 

Sony makes no genuinely fast 70-200mm
zoom for its Alpha a7-series cameras, and
the best on offer has a maximum aperture
of f/4.0 (on the right). This means less
compositional flexibility and less bokeh but
also less weight to carry around compared
to the faster Nikon equivalent (above). 



ED (IF) SDM makes a great 70-200mm
(equivalent) lens with a constant maximum
aperture. Pentax has also recently introduced
the full-frame K-Mount HD D FA* 70-200mm
f/2.8 ED DC AW which was available for
pre-order for around $2,300 as we went to
press. Used with an APS-C camera, its focal
length range equates to 105-300 mm. 

Mirrorless Alternatives

Makers of mirrorless system cameras, too,
have realized how popular this range of focal
lengths is among photographers. Sony
makes 70-200mm lenses for its A-Mount SLT
cameras and its mirrorless E-Mount models.
The FE 70-200mm f/4.0 G OSS has a
geometry designed specifically for use with
the Alpha a7-series cameras and, due to its
modest maximum aperture of f/4.0, is
relatively compact. Its RSP of around $1,500
makes it slightly more expensive than the
direct competition.

The Fujinon XF 50-140mm f/2.8 R LM OIS
WR is designed for use with the Fujifilm
X-series APS-C cameras, weighs 2.19 lb and
sells at $1,600. Samsung’s APS-C 50-150mm
f/2.8 S ED OIS lens for its mirrorless
NX-mount cameras covers virtually the same
range, while the Panasonic 35-100mm f/2.8
Lumix G Vario (currently available for about
$1,500) does the same job in the Micro Four
Thirds camp. The  Lumix G Vario 35-100mm
f/4.0-5.6 ASPH. isn’t as fast but is much less
bulky and costs just $400. 

The Test Field

We tested a Nikon D810 with the AF-S
NIKKOR 70-200mm f/2.8G ED VR II, the AF-S
NIKKOR 70-200mm f/4 G ED VR, the Sigma
70-200mm f/2.8 EX DG APO OS HSM, the
Tamron SP 70-200mm f/2.8 Di VC USD and
the  Tokina AT-X 70-200mm f/4 PRO FX. The
Nikon’s high-resolution 36-megapixel sensor
is a challenge to the best of lenses, so this
wasn’t an easy task. The Sony FE 70-200mm
f/4 G OSS had a similarly tough job proving
its mettle used with the mirrorless Sony a7R,
which also has a 36-megapixel full-frame
sensor. We tested the two full-frame Canon
zooms using the pro-grade EOS 5D Mark III
which, with its 22-megapixel sensor, is more
forgiving than the Nikon or the Sony when it
comes to less-than-perfect detail rendition.
We weren’t able to get our hands on an EOS
5DS in time for this test, but we promise to
use one to re-test the Canon zooms as soon
as possible. 

In the APS-C camp, we tested the Pentax
DA* 50-135mm f/2.8 ED (IF) SDM on an APS-C
K-3 body as well as the Fujinon XF 50-140mm

f/2.8 R LM OIS WR and the Samsung
50-150mm f/2.8 S ED OIS. 

How We Tested

To achieve objective, measurable results, we
tested all the lenses listed above under
rigorous lab conditions. This involved taking
test shots of a chart comprising 25 Siemens
stars with sine wave-shaped brightness
gradients, and we photographed the chart to
fill the frame for a range of apertures. Our
testers always focus manually and capture
four or five shots for each combination of focal
length and aperture. They then use custom
software to analyze all the captured
frequencies and determine the degree of
contrast between the brightest and darkest
image areas. This value falls off with increasing
frequency (i.e., in finer details) until details are
no longer recognizable, which usually occurs
at a contrast value of around 10%. 

The cutoff frequency (i.e., the maximum
number of resolved line pairs measured over
the height of the frame) is calculated for
various points on each Siemens star and
averaged. Because our test cameras have
varying resolutions, the results in the tables

are given as an absolute number of resolved
line pairs.

Additionally, we use a chart made up of
printer’s register marks to measure distortion.
We measure how far the positon of a test
point deviates from the position it should
have under ideal shooting conditions, and the
results are expressed in terms of the degree of
warp in a line at the edge of the frame
measured against the height of the image.

We use a 10 x 10 bank of LEDs to
measure AF shutter lag. To do this, we focus
each lens at infinity and press the shutter
button while simultaneously triggering the
first LED. The other LEDs then light up in
sequence, moving on every one-hundredth
of a second. The LED that is captured in the
resulting image enables us to precisely
calculate how long the camera took to
focus and release the shutter. Because
shutter lag varies with focal length, we 
have printed results for wide-angle and
telephoto zoom settings.

To help you judge image quality for
yourself, this issue’s free online content
includes a full archive of lab-based sample
images captured using every camera/lens
combo we tested. 
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70-200mm Telephoto Zooms | Lens Test

For our subjective image quality tests we took the lenses to the
Hannover Town Hall, which is one of our favorite subjects for outdoor
test shots under real-world conditions

70 mm

200 mm
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EOS 5D Mark III | 200mm | f11

EOS 5D Mark III | 70 mm | f/2.8 (c’t lab test scene, top left corner) EOS 5D Mark III | 70mm | f2.8

EOS 5D Mark III | 70mm | f11 EOS 5D Mark III | 70mm | f8

EOS 5D Mark III | 200mm | f2.8EOS 5D Mark III | 200mm | f2.8

EOS 5D Mark III | 200mm | f8

The lens: This is one of the highest-quality
lenses we tested and, technologically as well
as price-wise, it is squarely aimed at pro
photographers. Used with an EOS 5D Mark III,
it weighs about 5.4 lb, making it unlikely to
find favor as a travel photography lens. Build
quality is excellent, with broader and grippier
focus and zoom rings than the Nikon
competition. The focus ring on our test lens
was a little too loose for our liking – but this is,
of course, purely a matter of personal taste.
The lens body houses switches for focus
mode, the image stabilizer and distance range
selection. The stabilizer has two modes for
shooting stationary subjects and horizontal
follow shots of moving subjects. The lens is
also dust- and moisture-proof. 

Test results and image quality: Overall, the
lens delivered great results, but was
nevertheless choosy. We achieved our poorest
results at maximum aperture at the
wide-angle end of the zoom range. At these
settings, center resolution came in at 76 per
cent of the potential maximum resolution
offered by the EOS 5D Mark III. However, this

was the only weakness the lens showed . At all
other focal lengths, the Canon produced
balanced center and edge performance.
Unlike many of the other lenses we tested, it
also produced excellent results at the longest
end of its range, with crisp-looking images
and smooth focus gradients. 

Canon EF 70-200mm f/2.8L IS II USM

Canon EF 70–200mm f/2.8L
Current price $2,100
Max. aperture  / No. of blades f/2.8 / 8
Minimum focus distance 1.2 m
Length / Weight 7.8” / 3.28 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1465 (1197) / 1684 (1572)
Telephoto edge resolution1 1666 (1538) / 1681 (1658)
Distortion at max. aperture (w-a/t) –0.4 % / +0.4 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.29 / 0.2

AF shutter lag 0.39 s / 0.45 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

Lens Test | 70-200mm Telephoto Zooms
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EOS 5D Mark III | 200mm | f11

EOS 5D Mark III | 70mm | f4 (c’t lab test scene, top left corner) EOS 5D Mark III | 70mm | f4

EOS 5D Mark III | 70mm | f11 EOS 5D Mark III | 70mm | f8

EOS 5D Mark III | 200mm | f4EOS 5D Mark III | 200mm | f4

EOS 5D Mark III | 200mm | f8

The lens: The cheaper Canon lens has one
f-stop less maximum aperture than its faster
sibling, and is consequently much lighter
and easier to handle. It is nevertheless well
specified and has the same two-mode
stabilizer and focus mode/range switches as
the f/2.8 version. It is also just as robust, with
built in dust and moisture protection. Build
quality is excellent, with smooth precise
focus and zoom rings. Our only gripe is the
stabilizer which, in our test lens at least, was
quite loud. 

Test results and image quality: The answer
to the question of whether $1,000 less make
a real difference to image quality is “kind of”.
Basically, the lens delivers very good optical
performance throughout the aperture
range, but doesn’t match the f/2.8’s quality
and also produces obvious pin-cushion
distortion at the telephoto end of the scale.
In other words, it is typical mid-range
telephoto zoom. We also spotted some
fringing at the edges of the frame, especially
at shorter focal lengths. 

Canon EF 70-200mm f/4L IS USM 

Canon EF 70-200mm f/4L 
Current price $1,200
Max. aperture / No. of blades f/4.0 / 8
Minimum focus distance 1.2 m
Length / Weight 6.8” / 1.67 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1605 (1455) / 1687 (1600)
Telephoto edge resolution1 1479 (1316) / 1561 (1449)
Distortion at max. aperture (w-a/t) –0.2 % / +0.5 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.23 / 0.36

AF shutter lag 0.46 s / 0.35 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

70-200mm Telephoto Zooms | Lens Test
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D810 | 200mm | f11

D810 | 70mm | f2.8 (c’t lab test scene, top left corner) D810 | 70mm | f2.8

D810 | 70mm | f11 D810 | 70mm | f8

D810 | 200mm | f2.8D810 | 200mm | f2.8

D810 | 200mm | f8

Lens Test | 70-200mm Telephoto Zooms

The lens: The NIKKOR is a little heavier than
the Canon competition but its build quality is
really just the same. There are no loose parts,
everything works smoothly and it all fits
together perfectly. The bayonet mount is
rubber sealed and the barrel is made of
extremely robust magnesium alloy. Unlike
other 70-200 zooms, only the foot of the
NIKKOR’s tripod collar can be removed. Overall
handling is simple and intuitive with
dedicated buttons for focus mode, focus limit
and vibration reduction (VR). Like the Canon,
the NIKKOR offers VR modes for stationary and
follow shots. The focus ring is narrower than
the one offered by Canon but has a firmer
action in use. 

Test results and image quality: This lens is
equal to the challenge posed by the D810’s
ultra-high-resolution sensor, although it does
have its weaknesses. It produced its best
results at its shortest focal length, recording
80 per cent (1970 line pairs) of center
resolution. Stopping down produced better
edge performance that virtually equaled
center performance at f8. At medium

apertures, performance was solid throughout
the zoom range. The long end is generally not
as good as the short end, especially at the
edges of the frame. At 200 mm and wide open,
the bokeh the lens produced was visibly less
soft than that produced by the Sigma, for
example. 

AF-S NIKKOR 70-200mm f/2.8G ED VR II

AF-S NIKKOR 70-200mm f/2.8
Current price $2,400
Max. aperture / No. of blades f/2.8 / 9
Minimum focus distance 1.4 m
Length / Weight 8.1” / 3.39 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1970 (1612) / 2291 (2075)
Telephoto edge resolution1 1862 (1238) / 2240 (1843)
Distortion at max. aperture (w-a/t) –0.1 % / +0.5 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.17 / 0.17

AF shutter lag 0.29 s / 0.38 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto



A fast telephoto zoom is ideal for capturing
sports events like the annual dragon boat 
race in Hannover. Using a full-frame lens on 
a crop-format camera lets you get even closer 
to the action. 

Nikon D810 with the AF-S NIKKOR 70-200mm f/2.8G
ED VR II | 200mm | ISO100 | f4.5 | 1/1250s  
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D810 | 200mm | f11

D810 | 70mm | f4 (c’t lab test scene, top left corner) D810 | 70mm | f4

D810 | 70mm | f11 D810 | 70mm | f8

D810 | 200mm | f4D810 | 200mm | f4

D810 | 200mm | f8

Lens Test | 70-200mm Telephoto Zooms

The lens: At $1,000 cheaper and half the
weight of the f/2.8 version, owners of the
‘baby’ NIKKOR have to make some
compromises. Build quality is not as good and
the focus ring on our test model was
noticeably loose. This model also has no
weatherproofing, the barrel is made of plastic
and, like with the f/4 Canon, the RT-1 tripod
mount is an optional extra that costs an
additional $170. The mount isn’t strictly
necessary if you use the lens with a heavy
full-frame camera, but you might need it if you
are shooting with a crop-format camera. The
switches on the barrel govern focus mode,
focus range limit and two vibration reduction
modes. Focus mode can also be selected via
the camera menu. The f/2.8 has three focus
modes, but the f/4 version only has a choice
between manual and AF with manual
override/AF priority.

Test results and image quality: The
mid-range NIKKOR proved a pleasant surprise,
utilizing the D810’s full center resolution at
maximum aperture and most of its edge
resolution too. This excellent performance

drops off at longer focal lengths, with an
obvious lack of detail contrast wide open at
the long end. This is, however, a minor gripe
and overall, the lens produces hardly any
distortion or other image errors. 

AF-S NIKKOR 70-200mm f/4G ED VR

AF-S NIKKOR 70-200mm f/4
Current price $1,400
Max. aperture / No. of blades f/4.0 / 9
Minimum focus distance 1 m
Length / Weight 7” /1.87 lb
Test Results Wide open / f8
Wide-angle edge resolution1 2456 (2304) / 2345 (2090)
Telephoto edge resolution1 2092 (1673) / 2289 (1903)
Distortion at max. aperture (w-a/t) –0.4 % / +0.6 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.1 / 0.08

AF shutter lag 0.44 s / 0.76 s
1 in line pairs    2 in pixel    w-a = wide-angle    t = telephotos
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D810 | 200mm | f11

D810 | 70mm | f2.8 (c’t lab test scene, top left corner) D810 | 70mm | f2.8

D810 | 70mm | f11 D810 | 70mm | f8

D810 | 200mm | f2.8D810 | 200mm | f2.8

D810 | 200mm | f8

The lens: Same maximum aperture, half the
price. The Sigma is available for Canon, Nikon,
Sony and Sigma’s own-brand cameras and, at
a first glance, is of equal quality. However,
once you pick up the lens, it is obvious that
Sigma uses plastic in a lot of the places where
Nikon and Canon use metal and that Sigma
has scrimped on weatherproofing. Build
quality is nevertheless very good. Switches on
the barrel control the focus mode and the
built-in image stabilizer, but there is no focus
range limiter. Unlike the Canon and Nikon
offerings, the Sigma’s focus ring is located
between the lens mount and the zoom ring.
The travel in the focus ring on our test model
was a little short, athough its movement was
firm and positive. 

Test results and image quality: The Sigma’s
weakest point showed up  at its widest-angle
setting and maximum aperture, where it
showed obvious weakness at the edges of the
frame that lagged way behind the quality
offered by the Canon and Nikon lenses.
Otherwise, It performed very well with the
Nikon D810. At maximum aperture and its

longest telephoto setting, the Sigma is not as
good as the major-label competition either,
but stopping down improves things
considerably and produces fairly well
balanced sharpness throughout the frame. We
detected no significant distortion or other lens
errors, but the Sigma’s performance with the
Nikon D810 was more sluggish than that of
the other third-party lenses used with the
same camera. 

Sigma 70-200mm f/2.8 EX DG APO OS HSM

Sigma 70-200mm f/2.8
Current price $1,200 (for Nikon)
Max. aperture / No. of blades f/2.8 / 9
Minimum focus distance 1.4 m
Length / Weight 7.8” / 3.15 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1828 (1092) / 2262 (1751)
Telephoto edge resolution1 1769 (1566) / 2070 (1981)
Distortion at max. aperture (w-a/t) –0.4 % / +0.5 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.26 / 0.16

AF shutter lag 0.78 s / 0.72 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

70-200mm Telephoto Zooms | Lens Test
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D810 | 200mm | f11

D810 | 70mm | f2.8 (c’t lab test scene, top left corner) D810 | 70mm | f2.8

D810 | 70mm | f11 D810 | 70mm | f8

D810 | 200mm | f2.8D810 | 200mm | f2.8

D810 | 200mm | f8

The lens: At a glance, the Tamron is difficult
to distinguish form the Nikon competition.
Build quality is excellent, with a really smooth
focus action that was a pleasure to use
mounted on a tripod. Only the focus ring
didn’t work as smoothly as we would have
liked. We found that gripping the lens barrel
hard made it more difficult to move the focus
ring, making focusing less precise. This is not
the case with the NIKKOR lens, and is probably
due to Tamron using plastic for some parts of
the lens chassis. However, it is still protected
against moisture. The removable tripod collar
is included with the lens, which also has a
built-in image stabilizer. 

Test results and image quality: In the lab,
the Tamron provided serious competition for
the NIKKOR, resolving 2000 line pairs wide
open at the wide-angle end. However,
sharpness fall-off toward the edges of the
frame was significant. Overall, the Nikon
performed better and also improved more
stopped down. Performance at the long end
was similar, with the NIKKOR winning the race
with regard to detail contrast and texture

reproduction. Nevertheless, at almost $1,000
less than the NIKKOR, the Tamron offers great
value for money and worked extremely well in
tandem with the D810’s autofocus system. 

Tamron SP 70-200mm f/2.8 Di VC USD

Tamron SP 70-200mm f/2.8
Current price $1,499 (for Nikon)
Max. aperture / No. of blades f/2.8 / 9
Minimum focus distance 1.3 m
Length / Weight 7.41” / 3.24 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1999 (1365) / 2293 (1863)
Telephoto edge resolution1 1963 (1459) / 2045 (1700)
Distortion at max. aperture (w-a/t) –0.2 % / +0.3 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.21 / 0.09

AF shutter lag 0.56 s / 0.51 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

Lens Test | 70-200mm Telephoto Zooms



The lenses we tested are true all-arounders that
are ideal for use in a wide range of situations,
including frame-filling portraits like the one
reproduced here. We captured this shot using a
Nikon D810 and the lens set to a medium focal
length of 135 mm, which created a nice feeling
of distance between the subject and the
photographer and natural-looking proportions
within the frame.

Tamron SP 70-200mm f/2.8 Di VC USD |
185mm | ISO100 | f2.8 | 1/1250s  
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D810 | 200mm | f11

D810 | 70mm | f4 (c’t lab test scene, top left corner) D810 | 70mm | f4

D810 | 70mm | f11 D810 | 70mm | f8

D810 | 200mm | f4D810 | 200mm | f4

D810 | 200mm | f8

The lens: This model is only available for
Nikon, and thus only competes with the
NIKKOR AF-S 70-200mm f/4 VR. The Tokina,
with it’s black barrel and gold lettering, looks
a lot like a NIKKOR at a first glance and has
about the same size and weight. Build quality
is fine but, with just two switches for focus
mode and stabilizer on/off, offers fewer
options for making settings directly on the
lens. The NIKKOR has additional focus range
and stabilizer mode switches. 

Test results and image quality: In the lab,
the Tokina held its own with the NIKKOR
original lens. Like many of the lenses tested
here, it showed some edge weakness at
maximum aperture at the wide end, but
things improved a lot the moment we
stopped down to medium apertures. Overall,
the Tokina’s image quality lags behind that of
the NIKKOR at medium apertures and
produces images that are obviously less vivid
at wide apertures. However, at the telephoto
end of the scale, the Tokina produced results
on a par with those from the NIKKOR, albeit
with a little pin-cushion distortion. 

Tokina AT-X 70-200mm f/4 PRO FX VCM-S

Tokina AT-X 70-200mm f/4
Current price $850
Max. aperture / No. of blades f/4.0 / 9
Minimum focus distance 1 m
Length / Weight 6.59” / 2.16 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1939 (1611) / 2132 (1887)
Telephoto edge resolution1 2002 (1752) / 2268 (2065)
Distortion at max. aperture (w-a/t) –0.4 % / +0.5 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.15 / 0.18

AF shutter lag 0.56 s / 0.82 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

Lens Test | 70-200mm Telephoto Zooms
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a7R | 200mm | f11

a7R | 70mm | f4 (c’t lab test scene, top left corner) a7R | 70mm | f4

a7R | 70mm | f11 a7R | 70mm | f8

a7R | 200mm | f4a7R | 200mm | f4

a7R | 200mm | f8

The lens: This lens is designed primarily for
use with the diminutive Alpha a7-series
cameras and is Sony’s first full-frame E-mount
telephoto zoom with a constant maximum
aperture. To keep the lens down to a size that
matches the small a7 bodies, Sony has stuck
to a maximum aperture of f/4.0 and, in spite
of a little play in the lens mount, our test
camera/lens combo felt well balanced in use.
We are used to f/2.8 telephoto zooms having
a little looseness, but this is the first f/4.0 lens
we have tested that displayed similar
symptoms. The lens offers plenty of onboard
settings, with dedicated switches for focus
mode, focus range, stabilizer on/off and
stabilizer mode. The lens also has three focus
hold buttons, which lock focus at its current
settings. The lens is dust and moisture proof
and overall build quality is high. The focus and
zoom rings are pleasantly grippy and enable
you to work quickly and precisely. 

Test results and image quality: The Sony
can’t quite match the quality offered by the
Canon and Nikon competition. It produces its
best results in the middle of the aperture

range and focal lengths around 135 mm,
where it resolves more than 2000 line pairs in
the center and almost as many at the edges of
the frame. At the long end, the competition is
clearly in front. Unlike many of the other
lenses we tested, the Sony performs best
overall at wide apertures with some
improvement in center sharpness at medium
apertures up to around f8. 

Sony FE 70-200mm f/4.0 G OSS

Sony FE 70-200mm f/4.0
Current price $1,500
Max. aperture / No. of blades f/4.0 / 9
Minimum focus distance 1 m
Length / Weight (ohne Stativring) 6.89” / 1.85 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1875 (1361) / 1579 (1536)
Telephoto edge resolution1 1533 (1218) / 1980 (1457)
Distortion at max. aperture (w-a/t) –0.03 % / +0.47 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.5 / 0.6

AF shutter lag 0.50 s / 0.57 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

70-200mm Telephoto Zooms | Lens Test
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X-T1 | 140mm | f11

X-T1 | 50mm | f2.8 (c’t lab test scene, top left corner) X-T1 | 50mm | f2.8

X-T1 | 50mm | f11 X-T1 | 50mm | f8

X-T1 | 140mm | f2.8X-T1 | 140mm | f2.8

X-T1 | 140mm | f8

The lens: This lens, designed for use with the
X-series mirrorless cameras, has an equivalent
full-frame zoom range of about 75-210 mm
and a constant maximum aperture of f/2.8.
Like the X-T1 body we used, the lens is
weatherproof and is cold-resistant down to 
-10 degrees Celcius. Build quality lives up to
the manufacturer’s promises and is absolutely
comparable with that of the equivalent
Canon and Nikon products, even though it is
shorter and lighter than both. Like the
NIKKOR, the tripod mount can be removed
from the built-in collar. The only switch on the
lens barrel controls the image stabilizer and
the supplied lens hood has a removable cover
that makes it easier to use polarizers and
other rotating filters. 

Test results and image quality: The images
we captured were clear and precise
throughout the zoom range, with a slight
tendency toward better sharpness at the wide
end. The lens resolves its theoretical
maximum center resolution at maximum
aperture, although edge sharpness lags
slightly behind throughout the range. Overall,

it produced well-defined textures and no
obvious lens errors, although background
highlights appear somewhat rough-edged.
Used with the X-T1, the lens focused quickly
and quietly. 

Fujifilm XF 50-140mm f/2.8 R LM OIS WR

Fujifilm XF 50-140mm f/2.8
Current price $1,600
Max. aperture / No. of blades f/2.8 / 7
Minimum focus distance 1 m (macro)
Length / Weight 6.93” / 2.19 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1632 (1485) / 1632 (1593)
Telephoto edge resolution1 1632 (1314) / 1600 (1406)
Distortion at max. aperture (w-a/t) 0 % / 0 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.06 / 0.05

AF shutter lag 0.37 s / 0.39 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

Lens Test | 70-200mm Telephoto Zooms



The Fujinon produces pin-sharp images with
beautiful soft bokeh, smooth focus gradients
and a unique, highly three-dimensional look

Fujifilm X-T1 with the Fujinon XF 50-140 mm | 
140mm (210mm equivalent) | ISO200 | f2.8 | 1/125s
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K-3 | 135mm | f11

K-3 | 50mm | f2.8 (c’t lab test scene, top left corner) K-3 | 50mm | f2.8

K-3 | 50mm | f11 K-3 | 50mm | f8

K-3 | 135mm | f2.8K-3 | 135mm | f2.8

K-3 | 135mm | f8

The lens: This is one of the lightest and
cheapest lenses in  our test field. In spite of
its low price, it is dust- and moisture-proof,
making it a great lens for taking on hiking
trips. Build quality is good, although the
focus ring on our test lens had detectable
play and was too easy to move accidentally.
Only the focus mode can be switched
directly in the lens and, like the Fujinon, the
supplied lens hood has an opening that
makes it easier to operate a polarizer filter
while it is mounted. 

Test results and image quality: The Pentax
delivered pretty consistent results
throughout the zoom range, although we
did notice some obvious weakness at the
edges and well into the center at 135 mm
and maximum aperture, giving the images
we captured a somewhat lifeless look. We
recorded our best results at the short end,
with clear textures and details and only a
very few visible fringing artifacts. Stopping
down produced more consistent results,
with center and edge sharpness that are
virtually the same at f8. Shutter lag was the

only metric that let the Pentax down and put
it on a par with the third-party lenses we
tested rather than the other manufacturer’s
own-brand products. 

Pentax DA* 50-135mm f/2.8 ED [IF] SDM

Pentax DA* 50-135mm f/2.8
Current price $860
Max. aperture / No. of blades f/2.8 / 9
Minimum focus distance 1 m
Length / Weight 5.35” / 1.51 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1549 (1257) / 1681 (1536)
Telephoto edge resolution1 1512 (1059) / 1653 (1357)
Distortion at max. aperture (w-a/t) –0.3 % / +0.4 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.59 / 0.23

AF shutter lag 0.79 s / 0.64 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

Lens Test | 70-200mm Telephoto Zooms
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NX1 | 150 mm | f11

NX1 | 50mm | f2.8 (c’t lab test scene, top left corner) NX1 | 50mm | f2.8

NX1 | 50mm | f11 NX1 | 50mm | f8

NX1 | 150 mm | f2.8NX1 | 150 mm | f2.8

NX1 | 150mm | f8

The lens: The design of the Samsung
underscores its pro-grade ambitions, and its
heavy, semi-matte dust- and moisture-proof
body feels good to hold. It has dedicated
switches for focus mode, focus range and
image stabilization, as well as the Samsung
i-Function button with which you can alter
major camera settings via the lens. We really
liked the finely ribbed rubber grips on the
focus and zoom rings, which enabled us to to
work quickly and precisely at all times. The
built-in tripod mount makes it easier to use
this heavy lens with the comparatively small
NX-series camera bodies.  

Test results and image quality: This is
another lens that works best at the short end
of its zoom range. Here, it resolved 83 per
cent of its potential center resolution 
wide open, and things improved slightly at
f5.6. Edge resolution was consistently good
up to f8 but dropped off a little at f11 and
beyond. Results were similar at medium and
long focal lengths, but were generally not
quite as good, with less detail sharpness 
and a slightly less crisp overall look. It

produced no significant lens errors and
focused quickly and precisely throughout
our test. 

Samsung 50-150mm f/2.8 S ED OIS

Samsung 50-150mm f/2.8
Current price $1,600
Max. aperture / No. of blades f/2.8 / 9
Minimum focus distance 0.7 m
Length / Weight 6.06” / 2.02 lb
Test Results Wide open / f8
Wide-angle edge resolution1 1798 (1630) / 1903 (1765)
Telephoto edge resolution1 1523 (1405) / 1801 (1623)
Distortion at max. aperture (w-a/t) 0 % / –0.1 %
Chromatic aberration at max. 
aperture2 (w-a/t)

0.3 / 0.16

AF shutter lag 0.25 s / 0.25 s
1 in line pairs    2 in pixels    w-a = wide-angle    t = telephoto

70-200mm Telephoto Zooms | Lens Test



During our test, no-one at the Heise offices
was able to walk past our test setup without
asking how many cars we could buy for the
money our 11 lenses were worth, or simply
which was the best.

Thanks to autotrader.com, the car question
was relatively simple to answer: a 1948 Lincoln
Continental, two 2007 BMW 525i sedans or
four 2001 Toyota Camrys. 

The question of which lens is the best is
more complex, especially in view of the wide
range of manufacturers and systems we
tested – from full-frame to APS-C, DSLR to
mirrorless, and established manufacturers to
market newcomers. 

The most impressive-looking lenses are the
f/2.8 Nikon and Canon models. Both are much
larger than the rest of the competition and
have rock-solid reputations that were backed
up by the performance we recorded. At
200 mm, the Canon produced balanced,
pin-sharp images with great contrast and
virtually no lens errors to speak of. The Nikon
displayed similar performance and was
surprisingly fast, even when used with a
slower camera such as the D810. 

A Question of Price

The speed of the high-end lenses is backed
up by their fast f/2.8 maximum apertures,
that give you maximum shooting flexibility
in low light, smoother bokeh, unobtrusive
focus gradients and images with a highly
three-dimensional feel. In practice, however,
the difference between maximum apertures

of f/2.8 and f/4.0 probably isn’t that great, 
as demonstrated by the two images
opposite, which we took at maximum
aperture and 200 mm using the two Canon
test lenses. Only the most diligent pixel
peepers will really be able to tell the
difference, even if the f/2.8 model does
produce a softer overall look. As far as bokeh
is concerned, the range of minimum focus

Lens Test | 70-200mm Telephoto Zooms

Three very different approaches to the same basic concept. 
From Left to right: Nikon D810; Fujifilm X-T1; Samsung NX500 

Finding the Right Compromise

High-quality photos often demand bulky gear, proved here by the Canon EOS 5D Mark III and
the  EF 70-200mm IS f/2.8L. This particular combo weighs in at over 5 lb. 
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distances offered by the lenses we tested
makes it tricky to directly compare all the
images we produced. 

The greatest disadvantage of the top
models from the market leaders is that they
are heavy and expensive, making them
impractical or simply unaffordable for all 
but the most dedicated photographers.
Additionally, their size and weight makes a
tripod essential in most situations if you want
to make the most of their excellent optical
characteristics. And, once you have made a
purchase, you will probably have to add the
cost of a few weight training sessions to bill!

Own-brand vs. Third-party

Third-party lenses offer the same basic
specifications, often for as little as half the price
of the camera manufacturers’ own-brand
lenses. The Sigma and Tamron models we
tested produced solid performance, but could
match neither the  edge nor overall telephoto
performance of the NIKKORs when used with
the demanding Nikon D810. In the autofocus
stakes, too, the third-party models lagged
behind the orignals, although it has to be said
that the Tamron was nevertheless reliable and
relatively snappy.  

An alternative approach is to take a look at
the f/4.0 models from the established
manufacturers. These lenses are smaller, lighter
and cheaper than their faster siblings, and
produce comparable image quality in a wide
range of situations. For example, the f/4.0
NIKKOR produced maximum center resolution
at f4 when used with the D810. The f/4.0 Canon,
however, wasn’t able to match the telephoto
performance of its f/2.8 counterpart. 

The build quality of the f/4.0 models is
generally not as high as that of the top-flight
lenses, and they often lack details such as
moisture-proofing and a choice of stabilizer
modes. The f/4.0 NIKKOR also focuses slower
than the f/2.8 version. 

Pentax is the only manufacturer in this test
lineup that has yet to release a full-frame
DSLR, and its 50-135mm DA* lens has an
equivalent zoom range of 75-200 mm.The lens
is smaller, lighter and cheaper than most of
the competition but nevertheless includes the
weatherproofing and fast maximum aperture
offered by the more bulky and expensive
competition. Apart from a little wide open
edge weakness at the long end, it offers great
image quality too.

Choices for Mirrorless 
Camera Owners
Sony, Samsung and Fujifilm all ensure that
mirrorless fans don’t have to go away

empty-handed when it comes to choosing a
universal zoom lens. The Sony lens produced
solid but unspectacular performance, while
the Fujifilm X-T1 with the XF 50-140mm R LM
OIS WR proved to be a well-built, highly
capable setup that is weather and cold-proof
to boot. However, quality once again has its
price (and bulk), and the Fuji products are
neither lightweight nor cheap. 

Samsung’s 50-150mm f/2.8 lens is part of
its ‘Premium’ range and has a price to match.
It is aimed at cementing Samsung’s ambitions
in the pro photography segment and is
designed to move the NX-series cameras
away from their image as pure ‘lifestyle’
products. We are keen to see which direction
Samsung takes in the further development of
its mirrorless system cameras. (ssi)  c
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70-200mm Telephoto Zooms | Lens Test

These two images show the difference between long zoom shots captured at
maximum aperture using the f/2.8 and f/4.0 Canon lenses. The bokeh is very similar,
but the background in the f/2.8 shot is a little softer. You will have to decide for
yourself whether this makes a difference in real-world photographic situations.

Canon EOS 5D Mark III with the EF 70-200mm f/2.8L IS II USM  
200mm | ISO100 | f2.8 | 1/1250s

Canon EOS 5D Mark III with the EF 70-200mm f/4L IS USM |
200mm | ISO100 | f4 | 1/160s



Just over a year after the introduction of
the K-3, Pentax has brought its new 

top-of-the-range K-3 II APS-C model to
market. What sounds like a run-of-the-mill
update in fact heralds the introduction of a
camera with the all-new ‘Pixel Shift
Resolution’ function that promises images
with greater resolution and sharpness, as well
as more vibrant colors and improved noise
characteristics. To achieve this, the K-3 II uses
its shake reduction system to capture four
separate images, each offset by a single pixel
upward, downward or to the side and the
camera’s firmware uses the resulting image
files to create a more precisely rendered final
image. The system is designed to overcome
the comparatively poor color reproduction
caused by conventional Bayer pattern sensors,
which record only red, green or blue color
data for each pixel and interpolate the other

two colors from neighboring pixels. It is also
said to utilize the full potential resolution of
the sensor more effectively. 

Pixel Shift and GPS

The Pixel Shift system is similar to the High Res
feature built into the mirrorless Olympus
OM-D E-M5 Mark II, which captures eight
exposures in 0.5-pixel steps and merges them
into a single 40-megapixel photo. However,
our tests showed that it is virtually impossible
to shoot succesful High Res shots handheld,
and all our attempts turned out to be a
gamble at best. 

We expected to run into similar issues with
the K-3 II, although with only four separate
files per Pixel Shift shot, the margins for error
are smaller than those inherent in the

Olympus system. Assuming you shoot at the
camera’s maximum burst rate of 8.3 fps, a
four-image Pixel Shift shot should take about
half a second to capture – a handheld
exposure time that is a real challenge for most
photographers, especially when you consider
that shake reduction itself is not available in
Pixel Shift mode. All in all, Pixel Shift isn’t really
practical for real-world use, and it only really
works under precisely controlled lab
conditions. Furthermore, each raw Pixel Shift
image takes up more than 100 MB of memory.
See the Test Results and Image Quality section
below for more details on the quality of the
images we captured during our test.

The K-3 II has built-in GPS functionality,
enabling you to add geodata to your image
files. It also has an electronic compass and an
ASTROTRACER function that uses the shake
reduction system to move the sensor to
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Sophia Zimmermann 

Pentax K-3 II
The K-3 II is not just an update of the much-loved K3, it is a new camera
in its own right with new features and functions, including GPS and
‘Pixel Shift Resolution’ functionality for capturing enhanced-resolution
images. We take a look at what the new camera has to offer.  



match the movement of celestial bodies
during nighttime long exposures. 

Market Position

The basic technical specs are almost identical
to those of the previous model. The APS-C
CMOS sensor offers 24 megapixels of
resolution and ISO sensitivity of 100-51 200.
The 27-point AF system has 25 cross sensors,
the pentaprism viewfinder offers 100 percent
image coverage and the 3.2” monitor has 1.04
million dots, equivalent to about 720 x 480
pixels. The stainless steel body is protected
against dust and moisture with 92 individual

seals and, according to the manufacturer, is
cold-resistant down to -10 degrees Celcius (14
Fahrenheit).

The K-3 II’s overall build and resolution 
are designed to compete directly with the
Nikon D7200 and the Canon EOS 7D Mark II.
Burst-wise, the Pentax, with its maximum rate
of 8.3 fps, is slower than the Canon (10 fps) but
faster than the Nikon’s 6 fps performance. The
Canon’s AF system has 65 cross sensors and is
the most sophisticated of the three, although
at around $1,000, the Pentax is a bargain
compared with the Canon, which currently
costs around $1,500. The Nikon D7200 lies
between the two at about $1,200.
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Unlike the High Res mode built into the
Olympus OM-D EM-5 Mark II, which
increases the number of megapixels in an
image file, the Pentax Sensor Shift
Resolution function is designed to utilize
the sensor’s existing resolution to the full 

Built-in GPS
The Mark II’s body differs
from its predecessor
only in the details like
the new GPS button on
the side of the
viewfinder housing.

Camera Back and
Status Screen 
The back of the K-3 II is tidy, with large,
clearly-labeled buttons and controls.
The ‘status screen’ is a display of all the
camera’s major settings in a single,
easy-to-read summary and enables
you to alter them to taste. 
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Handling
At a glance, the K-3 and K-3 II look identical,
but if you look carefully, you will see that the
Flash button on the viewfinder housing has
been replaced by a GPS button and the mode
dial now has white rather than silver lettering. 

These details make no difference to the
camera’s handling, which is every bit as solid
as that of its predecessor. The ergonomically
shaped, rubberized grip and the generous
thumb pad on the back ensure that it sits
snugly and safely in your hands. The body is
relatively compact, quite chunky and, at nearly
800 grams (1.76 lb) is heavier than it looks.

Build quality is excellent, with no loose
buttons or seams. Everything fits together
perfectly. In addition to its hidden dust and
moisture proofing, the Pentax has external
rubber caps for the memory card slot and 
the connectors on the left-hand side of its
body. The battery compartment, too, has a
heavy-duty locking knob to keep out dust 
and dirt. 

The menu system is virtually identical to its
predecessor, and the camera is controlled
using a main mode dial alongside subsidiary
‘e-dials’ and buttons for the individual
functions. A couple of controls (such as the
RAW/Fx button) can be customized, giving
you plenty of control and enabling you to
work fast once you are familiar with how the
camera works.

The new Pixel Shift Resolution function can
be found in the first menu tab, but can also be
accessed via the control panel menu revealed
by pressing the INFO button. Switching Pixel
Shift on automatically switches off Shake
Reduction. 

GPS Now On Board

Pressing the dedicated button on the
viewfinder housing switches on GPS, and the
action is confirmed by a beep and a satellite
icon on the monitor. GPS status is also
displayed in live view mode – in green for 3D
positioning, yellow for 2D positioning or red
if no position data is available. 

The camera’s GPS module adds geodata to
stills but not to video footage, and you can
select the logging interval and a logging
period of up to 24 hours via the GPS Logging
menu item. Log data can be saved to either of
the camera’s twin memory card slots. 

Test Results and 
Image Quality
Alongside other lenses, we tested the K-3 II
with the DA 70mm f/2.4 Limited lens which

worked extremely well with the K-3 II in our
lab tests. The new version’s noise
characteristics are very similar to those of the
original camera, delivering a signal-to-noise
ratio of 80 at ISO 100. Our subjective visual
noise test returned a value of 0.7, which is
below the threshold value of 0.8 that signifies
practically noise-free images. At ISO 1600, we
measured visual noise of 1.5, which is still a fair
way below the threshold value of 2.0 for
acceptable noise, although above ISO 3200, it
delivered a value above 2.0.

In the resolution stakes, the K-3 II recorded
1720 line pairs of a theoretical maximum of
2000 at ISO 100, and this value dropped off to
1600 at at ISO 400. We measured 1580 line
pairs at ISO 1600 and 1530 at ISO 3200, which
means that resolution fall-off is moderate
throughout the usable, everyday ISO range.  

Although the camera is technically capable
of capturing images all the way up to ISO
51 200, detail rendition begins to drop off at
ISO 1600. Images captured at ISO 6400 are OK
for full-screen viewing but, on closer
inspection, reveal some washed-out colors,
poorly defined textures and color noise,
resulting in pale, rather lifeless images.

Pixel Shift Mode 

The difference between normal and Pixel Shift
images couldn’t have turned out greater. The
edges of Pixel Shift images benefit especially
from the process, which produces an
extremely sharp, highly three-dimensional
look. The center of Pixel Shift images, too,
have greater detail contrast than their
standard counterparts. Our measurements
confirmed that the Pixel Shift technique
maximizes the sensor’s potential resolution at
ISO 100 and continues to do so in the center
of the frame all the way up to ISO 3200.
However, the difference between normal and
Pixel Shift detail is less significant at higher ISO
values (see the examples on the next page
and the test image archive included with this
issue’s free online content).

Overall dynamic range remained at around
10 stops, regardless of which mode we used
to capture images. 

One obvious downside of the Pixel Shift
technique is its tendency to produce purple
fringing artifacts in fine patterns and lined
textures throughout the frame. These artifacts
were especially obvious at angled edges and
in the highlights. 

Conclusions

The K-3 II is a nice addition to the Pentax
high-end APS-C range and offers functions
that many are sure to have missed in the
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PENTAX K-3 II 

Technical Data

Sensor resolution 6016 x 4000 pixels

Megapixels 24

Low pass filter no

Sensor size APS-C (23.5 x 15.6 mm)

Crop factor 1.5

Raw capture yes

AF system phase-detection

AF points 27 (25 cross sensors)

Shortest / longest 
exposure time

1/8000 s / 30 s (Bulb)

Sensitivity ISO 100-51 200 

Viewfinder optical pentaprism (100%)

Monitor type, size LCD, 3.2" 

Monitor resolution 1. 04m dots

Body construction stainless steel/magnesium alloy

Waterproofing 92 individual seals

Dimensions (W/H/D) 132 x 103 x 76 mm

Weight
(body only w/ memory card
and battery)

799 g (1.76 lb) 

Memory card support SD, SDHC, SDXC 
(twin card slots)

Interfaces USB 3.0, HDMI (Type D), 
microphone, headphones, GPS, 
Wi-Fi

Power source Li-Ion battery D-LI90, 
optional battery grip for
6 AA batteries

RSP body only $1,000

Test Results

better >

Sensor resolution (line pairs)

Center (ISO 100)

Center (ISO 400)

Center (ISO 1600)

Center (ISO 6400)

Dynamic range (ISO 100)

Dynamic range (ISO 400)

Dynamic range (ISO 1600)

Dynamic range (ISO 6400)

< better 

Visual noise (ISO 100)

Visual noise (ISO 400)

Visual noise (ISO 1600)

Visual noise (ISO 6400)

Shutter lag at 1000 lux 0.67 s

2000

1720

1596

1580

1464

10.3

10.4

10.3

9.9

0.7

0.9

1.5

2.8



original model. Nowadays, GPS really should
be standard in this class of camera. Even if it
has few practical applications, Pixel Shift
Resolution is a clever technology that really
does coax extra image quality out of the
camera’s sensor, and the free Pentax Digital
Camera Utility software removed the fringing
artifacts it causes with ease. 

This is a true outdoor camera that is quite
at home in bad weather, although Pixel Shift
mode only really works under controlled
studio conditions. However, the feature
sends a clear signal to other manufacturers
that Pentax is keen to innovate, and neither
Canon nor Nikon currently offers anything
like it. 

Overall, the K-3 II is a well-built, solid and
reliable DSLR, and features like twin memory
card slots, a choice of raw formats, USB 3.0 and
interchangeable focusing screens underscore
its pro-grade ambitions. Additionally, the fact
that it is cheaper than the Canon and Nikon
competition should help it gain traction in the
market. (ssi)  c
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Here, you can see the difference between normal and Pixel Shift images captured
at ISO 100 and ISO 1600. Our low-sensitivity Pixel Shift test images were clearly
sharper and more three-dimensional than their normal counterparts, while the
difference was not so pronounced at higher ISO values.

In our lab test, Pixel Shift images
showed obvious fringing throughout the

frame. These were particularly evident
at diagonal edges.

70mm | IS01600 | f8 | 1/100s | 
Tripod-mounted, 400% (Pixel Shift)

70mm | IS0100 | f8 | 1/8s | 
Tripod-mounted, 400% (normal)

70mm | IS0100 | f8 | 1/8s | 
Tripod-mounted, 400% (Pixel Shift)

70mm | IS01600 | f8 | 1/100s | 
Tripod-mounted, 400% (normal)



This article by Peter Hurley’s star student Gabriel Hill is all about what headshots
are, why you need one and what they have to do with your digital identity.
Whether you are a beginner or are already up to speed on headshots, the tips
and techniques introduced here are based on the work of the most sought-after
headshot photographer in the world and will help you take your people
photography to the next level.

Gabriel Hill

Headshots
not just a passport photo or a portrait ...





Headshots originated in the movie
industry and are often used by actors

and models in a casting context. Many
hopefuls attach several headshots to their
resumés to give the casting director a better
idea of their flexibility. 

Headhsots are increasingly being used in
the business world too, and dedicated
headshot studios can be found in most cities.

Passport Photo 2.0?

A conventional passport photo fulfills official
criteria and is captured in a way that makes it
as easy as possible to identify its holder. Every
country has its own guidelines for passport
photo capture, although the introduction 
of biometric ID documents that simplify
machine-based face recognition has brought
about some degree of standardization
around the world. Passport photos generally
have to show a neutral expression, which is
one of the major factors that differentiate
them from headshots.

Headshots are are anything but neutral
and expressionless because they are not
designed for identification purposes. Rather,
their intent is to put a face to a virtual identity
and convey an individual’s personality. This
means that they also go beyond just
capturing a ‘nice’ photo.

We all have highly personal expressions
and we all use body language in a way that
identifies us as unique. A successful headshot
should capture that uniqueness in an
authentic way and use it to grab the viewer’s
attention. Whether in the entertainment or
business worlds, a photo is of no use to
anyone if it conveys a different character from
that of the person who actually walks
through the door.

More Like a Portrait?

Headshots are often lumped in with portrait
photography, although they actually
constitute an entirely separate genre. Both
types of photo exist to capture the subject’s
personality, although business portraits
often include props to give clues to a
person’s occupation. 

Portraying a watchmaker with her tools, a
painter in a studio or a musician playing
immediately puts the emphasis on the
subject’s job rather than their personality.
Some business portraits even ignore work and
concentrate on underscoring how successful
the subject is by portraying them in a grand

42 c’t Digital Photography 21 (2015)

Headshots | Portraits for the Digital Age

A conventional, natural-looking headshot in which the makeup and
post-processing are so subtle that they are almost undetectable

A typical model headshot in which the overall look, the makeup and
the post-processing are all deliberately eye-catching



office, near a company building or with
expensive artworks in the background. Other
popular setups position the subject, whose
clothing often makes it possible to guess their
occupation without the help of additional
props, in front of a monotone (usually gray)
background or in outdoor situations with
plenty of bokeh.

Headshots are different. In my headshots,
clothing and hair styling are only hinted at.
The subject’s face takes up most of the frame
so that their charisma takes center stage. 
The entire setup is designed to convey a
self-confident yet appealing impression.

Headshots are not about he subject’s job
or personal achievements – it’s all about
personality!

43c’t Digital Photography 21 (2015)

Portraits for the Digital Age | Headshots

This headshot for an actor uses plenty of shadow to emphasize his roguish expression.
The colors, too, are unusual for a headshot and create a more cinematic feel.

Another typical headshot that is neither completely
natural-looking nor excessively posed

Gabriel Hill is a commercial and
editorial portrait photographer who
has looked at the world through a
viewfinder since he was a child. 
He learned his trade with star
headshot photographer Peter
Hurley and quickly became the
shooting star in Hurley’s
community. He now lives and works
in Switzerland and runs the Head
Quarters studio in Basel together
with his partner.

www.thegabrielhill.com

Gabriel Hill



44 c’t Digital Photography 21 (2015)

Headshots | Portraits for the Digital Age

Neither passport photos
nor portraits, headshots
are designed to put a face
to a virtual identity

As a comparison, this image
represents mixed passport and

portrait photo attributes. The
subject is facing the camera 

head-on and has a neutral 
‘passport-style’ expression.

The boundaries between the online
and offline worlds and between work
and leisure are becoming increasingly
blurred. We are all connected to the
Web, and our online activities can
quickly have offline consequences.
Headshots are there to help you build
up your online image.

Searching for yourself on the Web has less
to do with vanity than it does with
establishing your digital identity. Studies in
various countries show that a majority of
HR departments use online resources to
support their recruitment decisions, and
this is obviously a growing trend. Figures
published by www.saferinternet.at
revealed that 76% of HR departments use
search engines such as Google or Bing,
while 61% use social networks and 44%
use business networks like linkedin.com. 

Almost every third HR representative said
that their online research had a direct effect
on the application process. Most queries are
related to the applicant’s personality rather
than their professional life, so it follows 
that your digital identity can improve (or
damage) your prospects of getting a job.
Headhunters tend to give special emphasis
to an applicant’s comments, postings,
hobbies, interests outside of work and, 
of course, their photos. 

Business networks are used to search
directly for suitable candidates, and here
too, if a first look doesn’t leave a good
impression, people will be less interested
in looking further. 

Authenticity
Digital identities aren’t just a topic for job
seekers. Everywhere we go online, we can
upload images of ourselves, whether at
Facebook, LinkedIn, Trip Advisor, Tinder or
wherever. Of course, no-one is obliged to
use a photo, but what does it say about
you if you don’t and what are the
consequences of doing without?

Because a photo connects a virtual identity
with a real face, it lends any content you
publish an air of authenticity. Imagine you
are asking for help or advice in the real
world and the person you are consulting is
wearing a mask. How likely is it that you
will trust what this person says?

Establishing Your Image 
With more than 200 million members on
LinkedIn, more than 350 million on
Google+, 500 million on Twitter and at
least a billion on Facebook, your profile
picture and what it says about you plays an
important role. Your profile picture is the

21st century equivalent of a visiting card,
and this is where headshots come in. 

Profile pictures generally have either a
highly positive or a highly negative effect
on the viewer, and there is no gray area
between the two extremes. This is just as
true for companies as it is for individuals.
Did you know that ‘About Us’ pages are
some of the most often viewed on the
Web? We all want to know who we are
dealing with, whether in our personal life
or in the biusiness world, and the old cliché
really does hold true: a picture says more
than a thousand words.

Return on Impression

Investing in a headshot definitely pays off.
In the business world, people talk about
ROI, or ‘return on investment’, but I prefer
the term ‘return on impression’. A
high-quality headshot really helps you
stand out from the crowd and take your
digital identity up a notch. No-one gets a
job on the strength of a photo alone, but 
if you are competing with others who are
just as well qualified, a professional,
likeable appearance can make all the
difference. If you want to know how
effective your current profile picture is, 
visit photofeeler.com to get some
unbiased feedback.

Your Digital Identity: Why Headshots Are so Important





The following sections explain how I
create my headshots. There are, of
course, no hard-and-fast rules about
how to capture headshots, but the
following pages provide answers to the
questions I am most frequently asked.

Landscape Format

I always shoot headshots in landscape format.
This is because human beings view the world
horizontally and because I personally love the
negative (i.e., white) space surrounding the
subject. After all, headshots originated in the
movie industry, where a 4:3 aspect ratio ruled
the roost for decades and has only recently
been superseded in most cases by 16:9. 

Catchlights

Reflections of my lights in the subjects’ eyes
are a central element of my headshot style. I
use Kino Flo continuous lights, and my ‘wall of

light’ approach ensures that the pupils in my
subjects’ eyes stay nice and small and reveal
plenty of the color in the irises. The catchlights
are the brightest spot in the frame and ensure
that the viewer immediately makes eye
contact with the subject.

In business headshots, I usually use square
catchlights for men and triangular ones for
women, and I prefer a shadow-free look for
both. For actors, I tend to use slightly less light
and more shadow effects. 

I recently received an e-mail from a
photographer who told me how awful and
unnatural my catchlights look, and that the
Sun is circular. This last is of course true, but
when was the last time you saw the Sun
reflected in the eyes of a studio portrait
subject? If anything, it is windows that get
reflected in a subject’s eyes, or a mixture of
natural and studio light. 

As ever, such aesthetic decisions are a
matter of taste. It’s entirely up to you how you
handle your catchlights.

Croptimize!

My critics often say, “But half his head is
missing!” This too, is true visually, but as we
have already seen, headshots are all about
personality, not about the background or
someone’s figure or suit, or the top of their
head (unless the subject happens to be
Mikhail Gorbachev).

A headshot exists to give the viewer a
positive impression of the person being
portrayed. Take a look at the two photos
opposite. These are, in fact, one and the same
photo but the lower one has been cropped
more tightly and shows the subject’s face
about 40 per cent larger. This makes the
subject appear closer to the viewer and makes
it much easier to establish eye contact. A
subject can quickly be subsumed by a
single-color background, especially if it takes
up too much space within the frame, and too
much single-color background is simply not
very interesting.

Headshots | Composition

I always capture
headshots in 
landscape format
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Alongside the aesthetic issues, the crop I
have chosen has a practical side too. The size
of most online profile pictures is quite limited,
so it makes sense to fill the available space
with as much face as possible. 

I crop carefully to make it clear what type
of hairstyle a person has, even if the hair itself
is not fully visible. This means cropping about
an inch above the hairline. Cropping at the
bottom of the frame follows the same rule for
the subject’s clothing. I advise women not to
wear spaghetti-strap tops, as these quickly
give a headshot a ‘beach party’ look, which
isn’t terribly professional.

Shoot at Eye Level

I always place my subjects’ eyes just above the
center of the frame. This is a personal
compositional preference which I think
emphasizes the subject’s eyes very nicely.

Jewelry

Unless they feel very strongly about it, I always
advise my clients not to wear any jewelry. Our
aim is to establish eye contact, and earrings
and necklaces simply draw the viewer’s
attention away from the main subject.

Backgrounds

I prefer white backgrounds, which have a
more subtle, modern-looking effect than gray
or black. White is timeless too – many of
Richard Avedon’s most famous portraits were
shot against white, and I don’t think too many
people consider them outdated. Some
business clients explicitly request a black or
gray background, and I won’t refuse if that’s
what they need. Otherwise, I stick to white. I
think gray is dull and old-fashioned and black
tends to make images look too harsh.
Textured backgrounds are a no-no in my
headshots, as they tend to compete with the
subject for the viewer’s attention.

Makeup

Use makeup as sparingly as possible. In a
situation in which we only have a face and
white background to work with, every
additional detail runs the risk of outshining
the real subject.
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I have often been told that my subjects have half their heads missing. However, the
space available for most profile pictures is limited, so it is best to squeeze in as much
of the subject’s face as possible. These two pictures are two different crops taken
from the same image – the difference is obvious.

+40%



If the subject is standing diagonally, never have her hair down at the front on both sides (left).
This covers the subject’s neck and blocks the view of her face. But don’t put her hair over her
ear either (center). The image on the right shows the optimum position for long hair.

✕ ✕ ✓
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A raised chin often conveys arrogance, an attribute we really want to avoid in a headshot.
Have your subject lower her chin, as shown in the center image, and then ask her to move her
head slightly forward, as shown on the right. A bit more of a smile wouldn’t do any harm, but
the illustrations here are aimed at demonstrating what to avoid rather than how to create the
perfect headshot.

Never let your subject lean backward (left).
This creates a reserved impression and
makes the subject’s head appear too small.
The photo on the right shows how it should
be done.

Five Simple Tricks for Better Headshots

✓✕
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Wide open eyes make the subject look
scared. Closing the eyes a little raises the
lower eyelids, creating a more focused, 
self-assured look.
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Turning one shoulder toward the camera can
make the subject appear slimmer, but take
care that the movement doesn’t produce an
unwanted crease in the skin of her neck (left).
This movement also tenses the long muscle
in the side of the neck, which isn’t always a
positive thing – unless you are
photographing a bodybuilder. Rotating the
shoulder slightly away from the camera
almost completely negates this effect.

Successful headshots involve more than
just placing a subject in front of a white
background and shooting away. Here are
some tips on how to get started and how
best to capture a subject’s personality in a
photo.

Teamwork is essential. Give your subject
clear instructions. No-one knows how to
pose properly without help, and if you don’t
direct a session, it will look like you don’t
know what you’re doing. It is your job to
make your subject feel comfortable.

The effect of the finished photo. A white
background alone doesn’t turn a portrait into
a headshot. A great headshot gives the
viewer the feeling of direct contact with the
subject without the camera as intermediary.

Practice, practice, practice! The moment
you begin to charge for your work, you
have to be in complete control and work
without hesitation. 

If you keep adjusting your camera or the
lighting, your subject is sure to get the
impression that you are still learning your
trade. There is nothing worse than a client
who questions your professionalism.
Practice on friends or shoot for free until you
have mastered your art. 

Communication. Photography itself is only
a small part of a successful headshot
session. I always use the same setup to
ensure consistent results, as the most
complex aspect of a session is the
interpersonal communication it involves.

The moment you decide to ‘go
commercial’, you have to be prepared to
deal with all kinds of total strangers. A
musician may be easier to photograph than
a corporate boss, and an attractive young
person easier than someone who doesn’t
fulfill society’s current ideals of good looks,
but whoever you work with, you have to
get the best out of every situation.

Once again, the magic word is ‘practice’. I
photographed more than a hundred people
before I started charging for my services.

Shoot at eye level. Using a setup with the
camera at the subject’s eye level is usually
the best approach. Shooting from below
often makes the subject look stand-offish,
while shooting from above means the
subject has to look up at you.

A natural-looking smile is really
important. Nine out of ten portrait subjects
have forced smiles. Never demand a smile
from your subject – getting him or her to
laugh naturally by telling a good story or a
joke is always a better option.

Technical stuff. You will need to use a lens
with a focal length of 85 mm or more for
headshots, just as you would for a
conventional portrait photo. Shorter focal
lengths distort the proportions in a
subject’s face. 

How to Succeed in Headshot Photography

Heartfelt thanks go to model Tabea Damaris and
makeup artist Rebecca Vionnet, who put in a lot 

of work creating this sequence

✓✕

✓✕



The $10 Deal

The cheapest and simplest headshot setup
consists of a large piece of white paper,
athough fabric will do too. The most
important thing is that your chosen material
is clean and free of folds or creases. The 
only other things you need are tape and
something white to use as a reflector.

Look for a shady outdoor location near 
a wall – direct sunlight produces too 
many shadows in a subject’s face. Shadows
emphasize creases and rings around a subject’s
eyes, so the face in a headshot needs to be as
well lit as possible. A cloudy sky is the best
source of light, as it works like a giant softbox.

Tape the white paper to the wall and place
your subject as close as possible to it. If you
are using a gray background, have the subject
stand a little further away from it.

Because outdoor light comes mainly from
above, working without a reflector will
produce photos with obvious shadows
around the subject’s face and chin. To
eliminate these, use a piece of white card as a
fill reflector from below. You can ask your
subject to hold the card or, as in our example,
ask your makeup artist to help out.
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Headshot Setups from Cheap to High End
You don’t always need expensive gear to produce professional-looking headshots. In fact, just a few
dollars is all you need to get started. The following sections describe three effective setups that
range from virtually free to one based on professional gear that costs many thousands of dollars.

Nikon D3S, 85mm f/1.4G lens, 
ISO 250, f4.5, 1/100 s 
Savage background paper 
Painter’s tape

Ä Highly cost efficient

ä No guarantee of consistent 
results due to changing light

ä No catchlights in the subject’s
eyes

Setup #1

c’t Digital Photography 21 (2015)

Without a reflector With a reflector

Even this super-simple setup can produce
great-looking headshots



Cheap Studio Setup 
for around $100
I purchased this ‘Studio Lighting Set’ with
lights, stands and a bag for $100 on eBay. 
At this kind of price, you can’t expect 
high-end quality, and I won’t be using this
setup commercially, but it still enabled me to
shoot indoors, which meant I could work
independently of the weather and create
images of consistent quality. I was also able to
produce the all-important catchlights in my
subject’s eyes. 

This compact setup is great for practicing
and is small enough to be used at home. If you
want to use a setup like this with a white
background, you will need an additional
studio or accessory flash. 

Set up your lights and place them as close
as possible to one another to ensure that your
subject’s face is fully and evenly lit. The
additional flash is placed behind the subject
and aimed at the white background. If the
background flash produces unwanted stray
light, reduce its output. An alternative way to
avoid stray light is to use ‘V-flats’ – these are
large, hinged Styrofoam or card panels that
can be used as as reflectors or flags, as shown
in the photo bottom right.

There are countless setups like this for sale
online. When making a purchase, make sure
that the set you buy has daylight lamps with
a color temperature of 5000-5600 K.
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Nikon D3S, 85mm f/1.4G lens
ISO 250, f4.5, 1/100 s 
Elinchrom D-Lite RX2 studio flash, 
three 5000K softboxes, energy-saving
lamps, white wall

Ä Cost efficient

Ä Consistent image quality

Ä Weather-independent

Ä Catchlights included

ä Poor-quality, low-power gear

Setup #2

One of the headshots we captured using
our cheap studio setup This studio setup cost around $100 in an online

auction. This isn’t high-end gear but it’s 
perfect for experimenting with.



Pro Setup for $13,000

This is the most expensive setup and the one
I use every day. If you earn your living making
headshots, you definitely need pro-grade
equipment. Most of my clients are top-flight
businesspeople who work for one of the two
global pharmaceutical companies based in
the town where I live. 

Kino Flo lights, which come from in the
movie world, have calibrated flicker-free
fluorescent tubes that guarantee precise color
rendition. Build quality is excellent, and each
of the four tubes is individually earthed. Gear
has to be totally reliable, especially when you
are shooting on location at a client’s site. I use
two or three Kino Flo lights, and you can see
their distinctive shape in the catchlights in the
subject’s eyes. I also use two studio flash
heads positioned at shoulder height outside
the camera’s field of view to illuminate the
background. On location shoots, I often use
the collapsible Lastolite HiLite illuminated
background system and robust Avenger
Century stands to hold the heavy lamps. A
pro-grade setup like this certainly means you
have a lot to carry! 

Using a Hasselblad camera to capture
headshots may sound like overkill but is
actually a deliberate strategy. Many of my
clients own pro-grade, full-frame cameras, so
making sure I have an even better camera is
an important factor when it comes to
convincing my clients of the quality of the
services I offer. (jr)  c
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My pro-grade studio headshot setup

A perfectly lit headshot with attractive
catchlights in the subject’s eyes

Hasselblad H3DII-31, HC f/4 120mm
macro lens; ISO 200, f6.3, 1/60 s; 
Arca Swiss p0 Monoball on a
Manfrotto 055 tripod; Tether Tools,
15’ Firewire 800; two Kino Flo 4’ 4Bank
lights, two Kino Flo 2’ 4Bank lights;
Hensel Porty with two EHT flash
heads; two black V-flats; fourˇ Avenger
Century Stands

Ä Top quality and reliability

ä Very expensive

ä Complicated to use

ä Challenging for very light-sensitive
clients

Setup #3





Sandra Petrowitz

All-weather Gear
for photographers on the go
Many of the locations photographers visit on the search for exciting subjects
may present extreme weather conditions that are a real challenge for modern
photographic equipment. Dust, sand, heat, damp and cold aren’t ideal travelling
companions for cameras and lenses, so it’s up to you to protect your gear while
you use it as well as when you are just carrying it around.



According to their manuals, most cameras
are not suitable for use in rain forests,

deserts or sub-zero temperatures. The
operating environment of today’s high-end
cameras is often given as 0-40°C (32-104°F) at
a non-condensing humidity of 85% or less.
Moreover, manufacturers don’t guarantee
that their products will work properly if used
under circumstances that do not adhere to
these guidelines. Nevertheless, Nikon’s service
portal offers tips on using its products in
sub-zero conditions, which seems to indicate
that adverse weather conditions aren’t as
deadly for a camera as the specifications
imply. After all, how do all the wonderful
photos we see of wintery mountain
landscapes, the Arctic and Antarctic regions,
deserts, rain forests, the low-lying salt flats of
Ethiopia and the unbearable dry heat of Death
Valley get captured if not using modern
camera technology?  

Pentax has recently begun to make a name
for itself in weather-protected camera gear
and advertises products that enable you to
keep shooting when competitors’ products
are better left in the safety of their protective
cases. However, there is no cause for panic,
even if various manufacturers’ cameras react
differently to exposure to dust and moisture.
The relatively narrow range of specified
working temperatures has more to do 
with legal restrictions than mechanical
shortcomings. In my experience, DSLRs put up
with rougher treatment than some users are
prepared to believe, and it is often the
photographer who gives up long before a
camera threatens to stop working. 

I have taken Nikon’s D70, D200 and D300
models on numerous trips to the Sahara, up
to over 16,000 feet in the Andes and the
Himalayas, and have used them to capture
countless images of the rain forests in Peru
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and Venezuela. I spend several months of
every year traveling with my D700 and D800
bodies in the polar regions, the deserts of
Jordan, the Savannah in Botswana, the West

Coast of New Zealand’s South Island and
other similarly challenging locations. I assume
that comparable cameras from other
manufacturers are just as hardy.

But Accidents Do Happen ...

There are, of course, times when my gear
gives up the ghost. For example, a Leica
compact of mine broke due to moisture that
got in through the bottom of a supposedly
waterproof backpack. I also had to spend
several hundred dollars having one of my
lenses taken apart and freed of sand following
a trip to Mauritania. I am constantly battling
with steamed-up lenses, damp eyepieces,
dripping water, sand where it shouldn’t be,
suspect crunching sounds when I rotate my
cameras’ dials, salt water spray that wrecked
the contacts on my flash shoe and all manner
of similar environmental challenges.  

But I have always found that there is 
no need to worry too much about my gear. 
Of course, you shouldn’t deliberately 
expose your cameras to the elements, but a
little common sense and a few sensible
preventative measures that have proved their

worth in the course of my years on the road
are all it takes to protect your gear against
most of what the world can throw at it. 

Quite apart from saving yourself the
expense of having to replace your gear, you
need to make sure it works reliably when you
are traveling in places where there is no hope
of finding spare parts or replacement lenses. 

Over the years, I have learned that there
is nothing more frustrating than ending up
with broken gear in the middle of a
long-planned tour. I remember well how
utterly disappointed one member of a group
was when he returned from a hike to a
penguin colony on the island of South
Georgia in the Southern Atlantic with a
camera that had capitulated to driving rain,
sleet and wind. We removed the battery,
saved the photos captured before the
camera stopped working and dried it out in
the ship’s cabin overnight. Fortunately, it
worked again the following day, but things
could easily have turned out differently. For
trips to remote and environmentally harsh
areas, I recommend that you carry a
replacement set of gear or at least a reserve
camera body with you at all times.
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The Pentax K2 is especially well
protected against environmental
influences, but other cameras also stand
up to more punishment than their
specifications would lead us to believe

Many DSLRs are more robust than their owners think,
and it is often the photographer rather than the camera
who gives up when the going gets tough

All-weather Photography | Introduction



Clouded lenses, fogged-up viewfinders,
broken cameras ... moisture is not good for
optics or electronics, and a water stain can
spoil even the most exquisitely composed
photo. Using a lens hood is an effective way
to fend off raindrops and snowflakes and,
used with telephoto and super-telephoto
lenses, makes it possible to shoot in constant
rain without any water hitting the front
element of the lens. However good your
protective gear, it is still essential to regularly
check your lens or filter for droplets and wipe
them off using a soft cloth if necessary – it can
be extremely frustrating to discover the water
on your lens when you are viewing your
images on your computer at the end of a
session. If you have to swap lenses in rain or
snow, always check that the rear element is
free of raindrops and snowflakes too.

Praise Be to Everything 
that Keeps You Dry
Clear plastic sleeves that are thin enough to
allow you to control your camera as usual are
a great way to keep water and some dust or
sand at bay. These sleeves are usually fixed to
the hood mount of the lens and the
viewfinder, and the cheapest models start at

around $7 for a pack of two. Sleeves made of
waterproof nylon with a separate viewing
window for the camera controls are more
expensive (see the table below).

Some plastic housings, such as those from
ewa-marine, are available in a range of sizes
for various combinations of camera, lens and
flash, and can even be used under water. They
have an optically neutral sheet of glass
mounted in front of the lens and cost up to

$400, making them a relatively high-cost
solution for use in the wet.

Home-made Solutions

A great way to prepare for unexpected
showers is to carry a clear plastic bag and
rubber bands or cable ties in your camera bag.
An impromptu camera cover can be a useful
weapon against dust too. The cover I made
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Sleeves, Underwater Housings, Bags and Wraps
Manufacturer Product URL Price

Rain covers and
sleeves

OP/TECH Rainsleeve www.optechusa.com Starting at $6.50

Ruggard Rain cover www.ruggard.com $9.49-$89.95
Flexible plastic 
underwater 
housings

ewa-marine Dive-capable modesl for DSLRs and 
compacts

www.ewa-marine.com Starting at $69 for com-
pacts, up to $500 for DSLRs

Aquapac Waterproof bags and cases for smart-
phones, tablet computers, cameras, 
camcorders etc.

www.aquapac.de Starting at $25.95

Waterproof bags Ortlieb Dust- and waterproof bags with roll-type
closure in various strengths

www.ortlieb.com Various sizes and materials
starting at around $60

Sea to Summit Dry Bag, Dry Pack, Dry Sack – light, 
waterproof bags in various sizes

www.seatosummit.com Starting at $11.95 

Exped Waterproof backpacks and packsacks with
roll-top closure

www.exped.com Starting at $22.95

Wraps Novoflex Protective Wrap (neoprene) www.novoflex.com Starting at $16.99

Water and Moisture

Water droplets can produce beautiful visual
effects but are better kept away from your

lenses. Constant checks and a soft cloth are
usually enough to keep them at bay.



from a freezer bag, a piece of neoprene and
cable ties wasn’t exactly pretty, but it kept my
camera safe during a trip in the Sahara. A little
improvisational talent and some ingenuity will
take you a long way. Neoprene wraps also do
a god job of keeping unwanted moisture at
bay if you are prepared to fiddle around a bit. 

On numerous trips in the Arctic and
Antarctica, I have found that it pays to zip the
camera hung around my neck in to my jacket
when getting in and out of rubber dinghies.
This leaves both my hands free and protects
the camera against rain and spray. I have even
used the plastic bags provided by the

onboard laundry service to protect my gear –
at the end of the day, anything that keeps a
camera’s expensive electronics dry is a worthy
tool.

A rain cover doesn’t necessarily make a
photo backpack truly waterproof but is
definitely better than nothing at all.
Heavy-grade trash bags with a drawstring are
also very effective for keeping backpacks and
camera bags dry. For trips in regions where
constant rain is on the cards, the best solution
is to use waterproof bags with roll-type
closures, like those made by Ortlieb and
Exped. If you take this route, make sure your

bag is large enough to hold all your gear when
the top is rolled down. Roll-top bags are
relatively cheap and heavier-grade models
make extremely effective weather protection.

For a genuinely waterproof transport
solution that still allows relatively easy
access to your gear, you will need
high-quality waterproof bags and backpacks
or expedition-grade cases. I can thoroughly
recommend the custom bags made by
König Photobags in Germany (www.koenig-
photobags.de), which are made from
tarpaulin combined with custom foam
inserts. Ortlieb and Lowepro also make
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The snow on this shoot in the Antarctic wasn’t nearly as perilous as the sea
water spray. Although this image was shot using a conventional DSLR, I always
carry a completely waterproof camera with me for use in hardcore situations.



effective waterproof photo backpacks. 
A good supplier of general-purpose bags 
is Sagebrush Dry Goods in Alaska
(www.sagebrushdrygoods.com), who also
offer clever waterproof gear bags for water
sports enthusiasts and anglers. 

In case you were wondering, in the context
of this article the term ‘waterproof’ refers to
products that effectively repel moisture but
aren’t necessarily designed for use in or under
water. Always check the manufacturer’s
specifications carefully when you are
considering acquiring an item of equipment
described as ‘waterproof’ or ‘water-resistant’. 

And by the way, a simple umbrella is a
great help in many situations, and there are
even adapters available for attaching
umbrellas to tripods to keep your hands free
while you work. Of course umbrellas are less
useful in high winds or if you are shooting
handheld.

Silica gel packs are great for absorbing
any moisture that does find its way into your
bags and can be dried out and recycled

when they are full. Look out for sealed silica
gel packs in the packaging of any electronic
devices you buy. 

Underwater Housings

I am often asked about the usability of
underwater housings at the beach or in the
desert. Unfortunately, genuinely waterproof
DSLR housings are bulky and expensive and
are only really useful for snorkelers and divers
who can cancel out the weight of a housing in
the water and offset the cost involved against
the money they make from their photos.  

Flexible plastic housings are a simpler
solution for use in the desert or heavy rain,
and some models can be used under water for
short periods.

Because my job as a guide takes me to the
Arctic and Antarctic regions for several
months of every year, I have acquired a water,
dust, shock and freezeproof Nikon 1 AW1 for
regular use under tricky conditions. I haven’t
managed to break it so far, and it still
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A little improvisation goes a
long way toward protecting

your gear against all sorts of
adverse conditions

This ‘emergency set’, consisting
of a plastic bag, cable ties and

a strip of neoprene, is easily
stowed in any camera bag and

fits together in seconds.
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produces images of a quality that should
satisfy most DSLR enthusiasts, despite having
taken a dive or two. 

How to Deal with 
a Wet Camera
Photographers are naturally cautious when 
it rains, as even a short downpour can
completely ruin a camera if you are not
careful. It doesn’t take long for a mass of tiny
droplets to form larger drops that can easily
get into a lens or camera body, and the ability
of drizzle to wreck electronics is often
underestimated. 

If your camera or lens does get wet, dry it
off as soon as possible. Always carry one or
two clean, dry microfiber or lint-free cotton

cloths with you for removing water droplets
from your lens, the lens barrel and the camera
body. Remove water from the lens by dabbing
it, as rubbing can cause tiny scratches.

I have found that zoom lenses dry out
faster if you fully extend them. If a lot of water
has got between the components, I zoom in
and out several times, removing moisture
with a cloth each time. 

Once you have removed any external
moisture, the inner workings of your camera
or lens will need time to dry out too. If your
camera is so wet that it doesn’t work, remove
the battery and memory card, save your
images and leave the camera switched off for
a while. Switching on a damp camera can
permanently damage its electronics. If
possible, leave it to dry thoroughly overnight

and only try switching it on again once it is as
dry as possible.

Watch Out for Salt Water
Salt water is a real problem for camera gear. If
your camera has been sprayed with salt
water – for example, during a walk on a
beach – you need to clean it immediately and
thoroughly to prevent the salt from sticking in
place and eating into the material of the
camera or lens. Too much contact with salt
water or an impromptu ocean dive usually
kills a camera, so take special care when
shooting from boats, piers, and jetties. If the
situation makes it impossible to hang the
strap around your neck, wrap it around your
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A Selection of Waterproof Photo Bags
Manu-
facturer

Model Type and Capacity Material/
Closure

Protection offered 
(standard adhered to)

URL Price

König 
Photo-
bags

liteBag Shoulder bags.
liteBag 1: Rangefinder or
 mirrorles camera with lens plus 
2 lenses.
liteBag 2: Rangefinder or 
mirrorless camera with multiple
lenses or DSLR with standard
zoom and 1 other lens.
liteBag 4: Pro DSLR and 3 lenses
(incl. 70-200mm f/2.8) and 
accessories or two pro DSLRs 
with lenses attached.

Tarpaulin/
Roll-top

Dustproof, waterproof to
a depth of 1 meter 
(IP67)

www.koenig
-photobags.de

liteBag 1:
$185

liteBag 2:
starts at $185

liteBag 4:
starts at $320 

Lowepro DryZone
Duffle 20L

Shoulder bag for for a pro DSLR
with a 70-200mm lens, 
1 or 2 other lenses, flash and 
accessories

210D 
tarpaulin/
Wide-mouth 
roll-top

100 liters per minute
water spray for at least 
3 minutes 
(IPX-6)

www.lowepro.com $110

Ortlieb Digi-Shot Shoulder bag. Medium holds 
a DSLR with a zoom lens and 
2 other lenses. Large holds the
same plus a second body, 
one lens and a flash.

Tarpaulin,
main com-
partment with
watertight
zipper

Dustproof, waterproof to
a depth of 1 meter 
(IP67)

www.ortlieb.com Medium: $195
Large: $215

Ortlieb V-Shot Holster for a DSLR with a
telephoto or zoom up to 200 mm
and accessories

Tarpaulin with
watertight
zipper

Dustproof, waterproof to
a depth of 1 meter 
(IP67)

www.ortlieb.com $160

A Selection of Waterproof Photo Backpacks
Manu-
facturer

Model Capacity Material/
Closure

Protection offered 
(standard adhered to)

URL Price

König 
Photo bags

foto
Rucksack

2 DSLR bodies, lenses up to
800mm (or 500mm with
camera attached), 
3-4 additional lenses, flash, 
accessories

Tarpaulin/
Watertight
zipper

Dustproof, waterproof to a
depth of 1 meter 
(IP67)

www.koenig
-photobags.de

Starting at
around $450

Lowepro DryZone 
Backpack
40L

Pro DSLR with lens (up to 
70-200m), 1 or 2 additional
lenses, flash, accessories

210D TPU 
tarpaulin/
Wide-mouth
roll-top 

100 liters per minute water
spray for at least 3 minutes 
(IPX-6)

www.lowepro.com $150

Lowepro DryZone
200 
Backpack

Pro DSLR, 4-5 lenses (up to
300mm f/2.8 with hood)

600D TCXP and
2000D nylon
/Watertight
zipper

Water resistant, ballistic
nylon 
(–)

www.lowepro.com $260

Ortlieb Day-Shot DSLR with zoom lens, two 
additional small lenses + 1
medium telephoto, flash, 
10" notebook/tablet 
computer

Tarpaulin/
Watertight
zipper

Dustproof, waterproof to a
depth of 1 meter
(IP67)

www.ortlieb.com $300



wrist a couple of times to maximize your
chances of saving it in an emergency.

If you are shooting in a location where the
water has a high mineral or sulfur content (in
areas of volcanic activity, for example),
remove any moisture immediately before it
begins to eat its way into your equipment. 

Olympus suggests cleaning dirty cameras
using a mild detergent and a soft, slightly
damp cloth followed by a second round of
cleaning with a dry cloth.

Always clean underwater housings and
waterproof cameras in fresh water after use in
a salty environment and carefully inspect all
seals for dirt, dust and hair. Even the tiniest
foreign bodies can prevent a water seal from
working properly.
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A relatively long exposure time of 1/25s made
these raindrops look like diagonal stripes

Home-made solutions are often
more effective than you may

think, but for reliable protection
from water and dust on long trips,

consider a pro-grade solution
from a specialized manufacturer 
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Sub-zero temperatures are a big challenge
for a camera’s power supply. Whether you
are high in the mountains, on a trip to the
Antarctic, photographing the Northern
Lights or simply out on a cold winter’s day,
low temperatures significantly shorten a
battery’s lifespan. However, my experience
has shown that this well accepted rule of
thumb doesn’t always apply to the same
degree. On shoots in the Arctic summer with
an average temperature around zero Celsius,
I have never had serious problems with short
battery life. 

Nevertheless, if you are shooting in
sub-zero temperatures, always carry spare
batteries and stow them close to your body in
a pants pocket or the inside pocket of a jacket
or fleece.

Using an additional battery grip not only
makes it simpler to shoot in portrait format,
it also means you have to swap out your
batteries less often, which is a real boon in
the cold. I always use original manufacturer’s
brand camera batteries and Sanyo ‘eneloop’
batteries for my battery grips, as these
provide the best performance I have
discovered. 

Condensation is the other major issue that
occurs at extreme temperatures. When you
enter a warm room from cold surroundings,
the moisture in the air immediately
condenses on or in your camera, often
causing serious damage. The solution here is
either to leave your gear in the cold between
sessions or let it slowly acclimatize in a
slightly warmer place (hall, stairwell, trunk of

the car etc.) in a closed plastic bag or
backpack before getting it out in the warm.
Never swap lenses until your camera is fully
acclimatized or you will end up trapping
condensation in the camera body.

In the desert, photographers usually
crumple in the heat long before a camera fails,
and I assume that most photographers don’t
expose their sensitive gear to harsh sunshine
for long periods anyway. 

On one trip to the Sahara, we left a
thermometer out in the sun while we ate
lunch in the shade. After our break, the
thermometer was showing over 50 degrees
Celsius (125 Fahrenheit). On that particular
trip, none of our cameras failed to cope with
the heat, although some did develop
problems due to dust and sand.

62

All-weather Photography | Cold and Heat

Shooting in the cold is tough
on batteries, so always take

along a spare set

Extreme Cold and Heat

It is virtually impossible
to prevent swirling sand
from getting into every
nook and cranny, but if

you take care you can
make life easier for

yourself. Never put a
camera bag down, as

sand drifts most at
ground level.
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Dusty and sandy environments require the
same basic approach as for water and
moisture. Deserts and dirt roads everywhere
produce fine grains of dust and sand that
get into even the tiniest openings in
vehicles, cameras, lenses, clothing and
photo bags. 

The Big Scrunch 

You would think that waterproof bags should
be dustproof too, but there really is no such
thing as 100 percent dustproof. On a recent
trip to Mauritania, a coating of extremely fine
sand found its way into all of our bags. 

The best way to combat the effects of
dust and sand is to adjust your behavior to

reduce the length of time your equipment is
exposed to the elements. Keep bags and
backpacks closed when you are not actually
using the gear stored in them. However, this
is often easier said than done, and you will
have to practice to find out which gear you
use most often and how you can best
protect the rest.

Even your ‘always on’ camera requires
protection, and an old pillow case or towel
is a great way to keep the worst dust off a
camera with a telephoto lens in safari
situations. Stuff sacks with roll-top closures
are great too and can be opened fairly
quickly when you need to grab your camera
in a hurry. If you have your camera on your
lap in a moving vehicle, you can always use
your jacket or any other piece of clothing to

cover the front element of the lens –
provided your jacket isn’t covered in 
dust too!

Avoid putting your camera bag on the
ground in any sandy environment where the
wind is blowing. The wind is always
strongest at ground level and the lower
layers of air always carry the most sand. If
you have to shoot from a low viewpoint,
either lying down or crouching, you and
your gear are sure to feel sandblasted
afterward.
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Dust and Sand

If your gear is well protected you will
spend less time worrying about it and

more time concentrating on your subject
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‘Bad Weather’ is often synonymous with
dramatic light and unusual atmospheres.
People tend to associate vacation and travel
photos with sunshine and great weather, so
it can be really annoying if it rains when
you’re on the road. However, since we can’t
influence the weather, it is often better to
accept what it throws at us and use adverse
conditions to capture spectacular photos
that aren’t possible in sunny weather.

Gray, overcast sky with low cloud isn’t usually
ideal for capturing wide-angle landscape
images. The nuances between gray tones
that the human eye can differentiate usually
disappear completely when captured in a
photo, while raindrops veil the landscape
and restrict visibility. Such conditions usually
produce sad-looking images that lack color
and contrast. Although a monochhromatic
landscape on a gray day sometimes has a

melancholy charm, the great contrast
between the sky and the landscape is often
too much for the camera’s built-in metering
systems to cope with. Without the use of a
neutral density (ND) filter or subsequent
image processing, the resulting photos are
often difficult to pull into shape. 

One way to work around these issues is to
leave the sky out of the picture – but only, of
course, if doing so doesn’t ruin the concept
or the composition. Many outdoor subjects
look fine without a horizon. Including
brightly clothed people is a great way to
bring the dimensions of a scene into
perspective, and signal colors such as red
and yellow show up best against a muted
background.

Dull weather can actually be quite helpful
when it comes to shooting close-ups. Soft,
diffuse light is perfect for accentuating small
details, and the reduced contrast it provides
is easier to capture than subjects lit by the
sun. The closer you are to your subject the
less rain, snow or sleet can get in the way and
the clearer your photos will be. A fill flash is a
useful accessory for brightening details and

You’ll need patience and somewhere dry to wait
if you want to capture the moment the sun
breaks through the clouds after a storm 

The high degree of
contrast between bright
backgrounds and dull
foregrounds is especially
accentuated in dull
weather. Rather than
using all the gray filters
you have, the simplest
way to get great results is
to leave the sky and the
horizon out of the frame.
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Bad-weather Shooting Tips
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accentuating colors in close-ups, but take
care when using flash in rain or snow.
Raindrops or snowflakes captured with
flash tend to overexpose and produce
bright white specks that blot out the real
subject. This can be used to produce
creative effects but can also ruin a photo if
you don’t keep it under control.

The clouds that accompany storms often
make a spectacular subject in their own
right. They can be captured factually to
document a coming storm, creatively as
abstract colors and shapes, or as studies of
movement using long exposures. Natural
light is often at its most dramatic when the
sun breaks through the clouds after a
storm, but to capture the right moment
you need patience and a dry place to wait.
With a little luck, Mother Nature will reward
you with wonderful views, clear air and
intense colors. 

Like any other moving subject, rain, snow,
wind and waves require short exposure
times to ‘freeze’ the action. Branches of
trees bending in the wind, spume on the
crest of a wave and fluttering flags make
effective subjects when frozen in time, but
you can also use longer exposure times to
capture the movements they make. To
capture the rainstorm in the image on
page 61 in Hwange National Park in

Zimbabwe, I used an exposure time of
1/25 second. The individual raindrops are
transformed into ethereal streaks that give
the image fascinating additional texture.
Alternatively, using an exposure time of
1/200 second allows you to capture
individual snowflakes as fluffy white dots,
while using a telephoto lens compresses
perspective and accentuates the effect.

Fog and mist can create intense moods
too, but these are almost impossible to
capture using autofocus, which cannot
identify details that are sharp enough to
lock onto. In situations like this, you can
either focus on a subsidiary subject located
at the correct distance or simply focus
manually. Fog and snow can also cause the
camera’s light meter to underexpose, so
check the histogram to see if you need to
compensate. I often find that a half or even
a full stop of exposure compensation is
required to keep snow shots properly
exposed.

Bad weather can be inferred in an image
by portraying the effects of weather rather
than the weather itself. Colorful umbrellas,
warmly dressed people with their breath
condensing in the air around them,
puddles, reflections on wet tarmac,
raindrops running down a window pane, 
a rainbow in the desert, the foaming crest

of a wave snatched by the wind,
snow-covered trees, spider webs covered
in dew... the list is virtually endless.

Fog and mist can cause autofocus to
fail, so you will often have to focus

manually in these kinds of conditions

Bad weather throws up a wealth 
of interesting subjects – some 

figurative, some abstract



Don’t Scrimp on Accessories

When you are shooting in tricky conditions,
only change your lens if you really have to. It
is much better to use separate bodies with
their own dedicated lenses for wide-angle and
telephoto shots than it is to constantly swap
lenses. If you have to swap lenses, do it in a
closed space such as a tent, a vehicle or a
sleeping bag. Even if it does not seem to be
windy, there will always be dust flying around
wherever you happen to be.

Always screw loose body and lens caps
together. This makes it more difficult for dust
and sand to get in and also makes it easier to
find a matched pair when you need them. 

Clean your camera regularly with a blower
brush wherever you are shooting. To get
tough dirt off a lens or filter, use a lint-free
cloth or a LensPen (a kind of extremely fine
eraser). To clean your filters, use a couple of
drops of optical cleaning fluid on a soft cloth
and rub them gently using a circular motion
from the center to the edges. A clean, soft
cloth is the best tool for cleaning a camera
monitor. 

Use a new toothbrush to remove grains of
sand from the grooves in the focus and zoom
rings on your lenses. Dust, dirt and scratches
on the rear element of a lens have a much
greater effect on the quality of your results
than those on the front element, so take
special care when cleaning this part of your
lens. I recommend using just a blower brush
and no other tools at all. 

Before and After a Trip 

Because I am never anywhere dust-free, I
don’t usually clean my cameras’ sensors when
I am away on a trip. I have never had any
problems using the camera’s own built-in
sensor cleaning mechanism, backed up by a
quick clean of the mirror box using a blower
brush. I clean the sensor properly before every
major trip and again when I return.

Generally speaking, high-end DSLRs stand
up to the elements much better than simple
compacts. A single grain of sand is often all it
takes to jam a compact’s shutter or lens, so it
is doubly important that you clean your
smaller cameras regularly and pack them
away carefully when they are not in use. 
Even then, you cannot be sure your compact
will survive unscathed. If you are planning 
to spend time in a desert environment, it 
is much better to acquire a purpose-built
weather-sealed camera.

If things do get out of hand and your
equipment begins to click and crunch when it
shouldn’t, the answer is to have it thoroughly
cleaned once you return home. I have an
authorized repair shop dismantle and clean
my cameras and lenses. This is not the
cheapest approach but is definitely better
value than buying a new camera every time
some sand gets in the works.

And by the way, don’t forget to protect
your memory cards from the elements too. I
keep my SD and CF cards in cases with
transparent sleeves for up to 10 cards. This

saves fiddling about with individual cases for
each card and makes it easier to keep full and
empty cards separate. (jr)  c
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Accessories

A single grain of sand can stop the lens in a
compact camera from working properly, whereas
most DSLRs are usually quite robust and stand
up to a fair amount of harsh treatment

Sandra Petrowitz is a journalist and
photography tour guide who spends
several months a year working all
over the world and on Arctic and
Antarctic cruises. She also leads photo
workshops and is the author of the
book The Traveling Photographer,
published by Rocky Nook.

www.sandra-petrowitz.de
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Keeping Things Sharp with

Autofocus
Autofocus is a standard feature in all contemporary cameras, and aging
phase-detection technology is still considered to be the most reliable
method of autofocus control, even though the technology is complex
and prone to errors. This article takes a close look at autofocus
technology and the latest developments that are finding their way into
today’s DSLRs and mirrorless system cameras. We also show you how
to check the precision of your own camera’s AF system and explain how
to test and improve it using our custom tools.





The Konica C35 AF, introduced in1977, was
the first commercially available autofocus

camera in the world. This revolutionary
technology has since been a raging success,
making life much easier for legions of amateur
photographers, while professional sub-genres
such as sports, wildlife and action
photography wouldn’t exist in today’s form
without automatic focusing. Autofocus is a
necessity in any situation in which you need
to capture fast-moving subjects, especially
when you are working with wide apertures
and the shallow depth of field this entails. 

Measuring Distance

To capture an in-focus image of a subject on
film or an image sensor, you can measure
the camera-to-subject distance, set the lens
appropriately and hope that the results are
sharp, or you can simply inspect the entire
image area and keep adjusting focus until
you achieve maximum overall detail
contrast, which always gives you maximum
optical sharpness. The second method
requires no knowledge of the distance to the
subject. Early autofocus systems were based
on active distance measurement using
infrared light, laser or ultrasound like the
Polaroid cameras built in the early 1980s.
However, these techniques no longer play a
role in today’s camera technology. Modern
autofocus systems are passive and are
based on either phase- or contrast-detection
technology. Most cameras use one or other
of these two systems, although some more
recent cameras have hybrid systems that
combine both. Phase-detection AF has 
long been considered the faster of the two,
but is less precise. It is also more complex,
requiring extra sensors and mirrors, and is
therefore more expensive to build and is
used more often in DSLRs than other types
of camera. The earliest analog AF cameras,
such as the Minolta Maxxum 7000,
employed the phase-detection technology
still found in many of today’s DSLRs.

Contrast-detection autofocus analyzes
image data directly in the image plane, so it
simply wasn’t possible to implement back in
the analog days. Contrast-detection AF is
often used in mirrorless system cameras
because there isn’t enough space within the
camera body for a phase-detection system. It
is also used in live view mode in many DSLRs.
Contrast-detection AF is less prone to errors,
but phase-detection systems are usually
faster. In practice, the speed of an AF system
also depends on other factors such as the type
of  subject and the quality of the lens.

Canon’s latest Dual Pixel CMOS AF system
is said to combine the advantages of both

systems. The following sections explain the
various systems in detail, but we can tell you
this much in advance: traditional
phase-detection AF is still a force to be
reckoned with in a whole range of  situations.    

Autofocus Modes

Depending on the type of subject, you can
choose between single and continuous
AF,  and many cameras offer the option of
switching automatically between the two.
Contemporary cameras have many AF areas
distributed across the image area, so you
can always select an appropriate one for the
subject at hand. Touch screen control like
that offered by the Canon EOS 70D makes
selecting AF areas a lot easier than it is with
button-controlled systems. Depending on
which mode you use, the camera can
automatically select one or more AF areas
and, in the case of contrast-detection AF,
can detect and focus specifically on faces
and even the eyes of a subject. Continuous
AF can track moving subjects when they
move out of the current AF area and can

even follow them if they are momentarily
covered by other objects within the frame.
By default, single AF usually works in focus
priority mode, which prevents the shutter
from firing if the subject isn’t in focus. The
alternative is to use shutter priority, which
enables you to shoot even if the subject isn’t
perfectly sharp. Some cameras and lenses
allow you to make manual focus corrections
in auto mode by rotating the focus ring on
the lens, while others require you to set a
dedicated mode (Sony, for example, calls it
Direct Manual Focus). In Nikon cameras,
focus behavior depends on which lens you
use. Newer lenses with built-in AF motors
can be manually focused at any time,
whereas older lenses that focus using the
motor built into the camera body don’t
support this kind of adjustment. In such
cases, it is better to set focus to manual
before rotating the focus ring.

Focusing in Low Light

Due to the lack of subject contrast,
phase-detection AF has a hard time focusing
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Phase-detection uses separate sensors to capture light from parts of the 
lens light path that are as far apart as possible. The mirrors and lenses 
required to make the system work are complex to build and take up a lot 
of space within the camera body.

How Phase-detection Autofocus Works

Pentaprism

Focusing screen Viewfinder

Image sensor

Main mirror
(translucent)

Secondary mirror

AF sensors



in low light, although it still works, albeit
slowly, even in moonlight. The limit of an AF
system’s sensitivity is stated in terms of
logarithmic exposure values (EV). Zero EV
represents a level of brightness that requires
an exposure time of 1 second at ISO 100 
and f/1.0 to reproduce medium gray. In
photographic terms, this is equivalent to 8
seconds at f2.8, which is pretty dark. The best
AF sensors work at levels as low as -3 EV 
(1 minute at f2.8), and even contrast-detection
AF works at these and lower levels. It is
important to have a large AF area when
focusing in low light, and a wide maximum
aperture helps dedicated AF sensors to work
effectively. Spot metering in the dark isn’t
recommended as this uses only a limited
number of AF sensors and reduces its
sensitivity accordingly. 

Many cameras have a built-in AF assist
lamp that can be used when the ambient
light isn’t bright enough for accurate focusing
on nearby subjects. Accessory flash units
usually have more powerful AF assist lamps
that are effective over greater distances. 
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Alongside the actual sensors, a phase-detection AF module also includes a beam splitter, a field lens and an infrared cut-off filter.
The AF sensors shown here are from a Canon EOS 1D X, in which 41 of the 61 sensors are of the cross type. 

Focusing Systems | Autofocus

This graph shows Canon‘s own speed test results for its new 
Dual Pixel CMOS AF system compared with the hybrid 
system in an EOS Rebel T5i/700D and a camera with simple 
contrast-detection AF.

Comparing Dual Pixel AF with Other Systems
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Phase-detection AF has been the standard
system in reflex cameras since the 1980s.
However, in cameras with articulated mirrors,
the system only works as long as the mirror
isn’t flipped up. As soon as the mirror moves
out of the light path, the AF sensors no longer
receive any light so, in live view mode, camera
manufacturers have to use contrast-detection
AF or other techniques that utilize the main
image sensor to set focus. 

Phase-detection AF works like a pair of
micro-cameras that view a scene through
different parts of the lens. If both cameras
view the same point on a surface, they capture
the same detail. However, if they are viewing
a point in front of or behind the surface, the
captured details will be slightly offset. This
occurs because the two sensors view the
subject from different angles. The resulting
effect is called parallax and is the basic
principle behind stereoscopic and ‘3D’
photography. In this case, the effect is used to
help the camera focus. The two sensors are set
up so that their light paths meet at the
distance at which the lens is focused, making
the details captured by both identical. If the
two details are offset, the result will be an
out-of-focus shot, although the direction and
degree of offset can be used to precisely
calculate the adjustments required to capture
the subject in sharp focus. This makes it
possible for the camera to set focus directly
without having to zero in on the correct
setting.

A simple AF sensor consists of two strips of
photodiodes coupled with a mirror and
special lenses that split off two narrow beams

from the light entering the lens. The farther
apart the two beams (i.e., the distance
between the system’s ‘eyes’), the more
sensitive the system and the greater the offset
between the twin captured details for a
certain degree of defocusing. This means that
the system achieves its best results when the

sensor strips are placed as close as possible to
the edges of the image projected by the lens.
However, in cameras with interchangeable
lenses, the maximum aperture of the lens
plays a role in determining the number and
sensitivity of the AF sensors it can effectively
use. All-around AF sensors are arranged so
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Phase-detection Autofocus – Fast but Error-prone

Groups of four sensors in the  AF sensor unit
from a Canon EOS 7D (below left) are used
to form various cross sensor configurations,
of which the EOS 7D has 19. The center AF
area in the viewfinder (marked in red in the
upper diagram) has two cross sensors
associated with it, made up of the eight
individual sensors circled in color in the
lower diagram. The diagonal sensors
marked in yellow detect image areas close
to the edges of the lens and are therefore
more sensitive than the others. However,
they only work with lenses that have a
maximum aperture of f/2.8 or larger. The
sensors marked in blue and green work at
maximum apertures of up to f/5.6.

Te
ch

n
ic

al
 t

ip
 a

n
d

 s
en

so
r i

m
ag

e 
b

y 
 R

ai
n

er
 H

o
en

le

The fixed, semi-translucent mirror built into the Sony Alpha a77 steers light toward the
image sensor and the AF sensors. Although the mirror is fixed, the system requires just as
much space as one with an articulated mirror and actually transmits slightly less light to
the image sensor than a conventional setup.
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that they can be used by lenses with a
maximum aperture of f/5.6 or even f/8, while
quality cameras have additional sensors that
can only be utilized by lenses with maximum
apertures of f/4, f/2.8 or, occasionally, even
larger. If the camera detects a lens with a
smaller maximum aperture, these sensors lie
in the shadow of the lens barrel and are
automatically deactivated.

Because autofocus sensors view the world
through a tiny portion of the lens opening,
their effective aperture is very small indeed. In
turn, this means that they have extreme depth
of field and produce much sharper images
than the camera’s main image sensor. This is
essential if they are to produce usable signals
when focusing on heavily defocused subjects.
This tiny effective aperture means that the
aperture in the lens plays virtually no role at
all and it is simply a myth that fast (i.e.,
large-aperture) lenses can focus faster or
‘better’ than ones with smaller maximum
apertures when they are used with identical
AF sensors. However, even if the maximum
aperture is irrelevant, light itself is extremely
important to the success of the autofocus
process. If there is too little light available, the
AF sensors can no longer differentiate
between degrees of contrast. In such
situations, an AF assist lamp creates artificial
contrast by projecting a striped pattern onto
the subject. 

AF sensors that consist of two strips of
photodiodes are called line sensors and can
only detect horizontal or vertical differences
in contrast. They work by measuring the
signals produced by the distribution of

brightness levels along the two strips and
calculating the phase shift that exists between
them – hence ‘phase-detection’ autofocus.
Higher-quality cameras also have cross
sensors that consist of combined horizontal
and vertical strips or pairs of diagonal strips.
The latest type of AF sensor to hit the market
are on-sensor models whose characteristics
can be altered using the camera’s software.

Because the distance between the two 
AF images can be precisely measured, it 
is theoretically possible to set focus to 
precisely the right point using a single 
AF measurement. In practice, however,
measurements are usually repeated several
times during the focusing procedure 
to increase accuracy. Conventional
phase-detection AF systems have to ensure
that the distance between the subject and the

AF sensors is identical to the distance
between the subject and the image sensor –
otherwise the system will register correct
focus even if the image on the main sensor
isn’t sharp. 

This issue and variations in tolerances
during lens manufacture are the reasons
phase-detection AF can produce inaccurate
results. In the early days, errors could only be
rectified by having the manufacturer make
appropriate mechanical adjustments, but
today’s cameras often have menu options
that enable the camera to automatically
adjust focus to suit the lens you are using.
Some Sigma lenses can even be ‘personalized’
independently of the camera using a supplied
USB dock. This enables you to tweak the lens
firmware to fix focusing issues and adjust
other lens parameters too.  
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Fehlfokussierung

A piece of card with two pinholes mounted on the lens makes a great tool
for visualizing the principle of phase-detection autofocus 

Test shots captured using an APS-C camera and a Tamron SP AF60mm lens

Front focusing reveals that the two test images
are not congruent. The plane of focus is in front
of the subject.

Focused correctly, the twin test patterns appear
as a single image

Back focusing, too, reveals two incongruent
patterns. In this case, the plane of focus is
behind the subject.

This example, shot without using a pinhole,
shows just how much using a pinhole can
improve depth of field

Front focus (close)

Back focus (distant) without pinhole Back focus (distant)  with pinhole

Correct focus



Compared with phase-detection AF, using
image contrast gleaned directly from 
the image sensor to determine the focus
setting appears a much simpler solution. 
This approach requires no additional
components, you can select AF points via the
camera’s software, and there is always a
usable degree of contrast to be found
somewhere within the frame – provided of
course that the camera can ‘see’ details that
are better defined than the surrounding
noise. The AF points used for
phase-detection AF are hardwired into the
camera’s hardware, whereas using
contrast-detection AF enables you to
position them anywhere within the frame
and to move them at any time – for example,
using a touch gesture on the camera’s
monitor or by switching in a face recognition
algorithm. Additionally, because it uses the
image itself to check focus and requires no
hardware fine-tuning, contrast-detection AF
is extremely accurate. Nevertheless, there are
one or two drawbacks that have so far made
contrast-detection AF most camera

manufacturers’ second choice. Firstly, a
blurred subject cannot be used to determine
how much and in which direction focus has
to be adjusted. The camera’s focusing
mechanism has to make some trials to see
whether the direction it uses is the right one
(i.e., contrast increases) or the wrong one
(i.e., contrast drops off further). The required
degree of adjustment, too, can only be
determined once an initial attempt has been
made and, because local contrast is a value
that is not set in stone, focus ‘success’ 
is subjective, especially if you are
photographing a low-contrast subject. In
some cases, you can only detect the point of
sharpest focus once you have passed it. This
is why contrast-detection AF systems ‘pump’
back and forth when they begin to focus and
again just before the shutter is released. This
approach is just as complicated as it is for a
human being to focus manually using just
the viewfinder image and no other focusing
aids. Today’s mirrorless system cameras
often incorporate extremely fast and
sophisticated contrast-detection AF systems.

While phase-detection AF needs to take 
a single reading to establish focus,
contrast-detection systems have to make
several, each of which requires the camera’s
firmware to analyze at least some of the
pixels detected by the sensor. This process
simply takes time. 

Slow DSLRs

For a long time, the inherent weaknesses  of
contrast-detection AF made it unsuitable for
high-speed photography and relegated it to
use in consumer-grade compacts with no
space for a complex phase-detection system
within their bodies. It was only with the
introduction of mirrorless system cameras
that manufacturers like Panasonic, Fujifilm
and Samsung began to work hard on
improving the performance of their
contrast-detection AF systems. Around the
same time, the first DSLRs with live view
began to appear. Live view requires the
reflex mirror to remain in its raised position,
making phase-detection AF impossible.
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Contrast-detection AF – Slower but more reliable

A phase-detection AF system sees two versions of the out-of-focus subject and uses the distance between the two 
images to calculate the correct focus setting. The twin AF images are sharp, even if the subject itself is out of 
focus. To a contrast-detection AF system, a defocused subject is simply blurred, making it impossible to tell 
whether it is front or back focused.

Phase-detection vs. Contrast-detection AF

Front focus

Using an optical 
viewfinder

In live view

Correct focus

Back focus

Front focus

Correct focus

Back focus

Phase-detection AF Contrast-detection AF



Initially, the live view functionality built into
DSLRs was used to aid manual focusing 
and check focus in captured images.
Contrast-detection AF in DSLRs remains a
somewhat half-hearted additional feature
that is too slow to be much fun. In spite of
all these shortcomings, contrast-detection
AF still has great potential.  Because light of
different wavelengths refracts differently,
the chromatic aberrations produced by most
lenses can be used to overcome the
uncertainty regarding the direction in which
the lens has to focus. Green fringes usually
signify front focus, whereas pink fringes
signify back focus. Patents have already
been filed that exploit this technique, but
we have yet to hear of its real-world use in a
production camera. 

Depth from Defocus 

With the Lumix GH4, Panasonic introduced
the Depth From Defocus (DFD) method of
contrast-detection AF, which uses data 
from the sensor to estimate the point of focus
even before the focusing process begins. 
The technique uses the known bokeh
characteristics of the lens in use and helps 
the camera to zero in on the true point 
of focus more quickly than conventional
contrast-detection systems. However, precise
focusing using just one reading is still not
possible using DFD. Even if it estimates the
focus point correctly, DFD still has to focus

back and forth a couple of times to be sure of
hitting exactly the right spot, which in practice
makes it only slightly faster than conventional
contrast-detection systems. 

Another drawback of DFD is that
Panasonic only has access to the bokeh

characteristics of its own lenses, so third-party
lenses cannot take advantage of the new
technology. This is a shame in view of the 
high degree of manufacturer-independence
of the Micro Four Thirds sensors Panasonic
bases its cameras on. 

Depth from Defocus | Autofocus

While conventional contrast-detection AF systems zero in on the true point of focus 
using a series of slow steps, Depth From Defocus can roughly predict where it lies in 
advance of focusing. Phase-detection AF is the only system that can focus directly on 
the correct point without having to search for it first.

Comparing Depth from Defocus with Other Techniques
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Hybrid autofocus is designed to combine the
best parts of contrast-detection and
phase-detection systems and do away with
complex moving mirrors. 

Phase-detection AF is based on the
simple idea of using selected sensor 
pixels to aid focusing, but successful
implementation is not as simple as the
concept itself. AF pixels work best if they
only detect light from one side or just a small
portion of the field of view of the lens.
Fujifilm solved this challenge using a
technique that temporarily masks some of
the AF receptors. Sony, Canon, Nikon and
other manufacturers soon followed suit and
dedicated phase-detec tion pixels can
nowadays even be found in the cameras
built into high-end smartphones and tablet
computers. The masked pixels reduce the
amount of light hitting the sensor, so the
data they record cannot be used without
first being corrected. The simplest way to
deal with these pixels is to treat them as
dead and interpolate data from neighboring
pixels during demosaicing. 

To prevent too great a reduction in image
quality, this mapping process must not be
applied to too many pixels, so it is impossible
to reserve entire strips of pixels for
autofocusing. According to Fujifilm, its AF
pixels are distributed over 40 per cent of the
surface of its X-Trans sensors, and we
estimate that the distance between an AF
pixel and the corresponding portion of the
image is six pixels. Olympus uses a system

with a distance of five pixels. This offset is
simply too great for the system to be really
accurate. 

Combined AF Systems

Sensor-based phase-detection AF therefore
performs only the donkey work in a hybrid
AF system, detecting and passing on the
rough direction the lens has to look in. 
This means the camera no longer has to
experiment to find out whether the subject
requires back or front focus. Once this part
of the job is done, the contrast-detection
part of the system takes over and fine-tunes
the focus setting by taking a couple more
readings. Although direct focusing is still not
possible using hybrid systems, some
mirrorless system cameras can focus as 
fast as, or even faster than, many DSLRs 
with pure phase-detection systems. At its
introduction, Sony claimed a focusing time
for its Alpha a6000 camera of just 0.06
seconds. Of course, other manufacturers,
too, claim to make the ‘fastest camera in the
world’, but test results are highly dependent
on the conditions under which they are
produced, the lens being used and the type
of subject. Unfortunately, contrast-detection
AF still has its drawbacks, even when it is
used as part of a hybrid system. Every 
time the shutter button is pressed, it has to
‘pump’ a little to see whether the current
focus setting can be improved, whereas a
high-quality phase-detection system can

focus immediately, sometimes without
having to move any lens elements at all.
During our tests, we found that the Sony
Alpha a7 II actually took more time to check
an existing focus setting than it did to focus
properly on a new distant point. 

Canon Dual Pixel CMOS AF

Canon has further developed the idea of
sensor-based phase-detection AF, and its
‘Dual Pixel CMOS’ system reduces light loss
and uses all the pixels in the sensor to aid
the phase-detection process. A ‘dual’ pixel is
located behind each of the sensor’s
microlenses, which ensures that each pixel
receives light from both sides of the lens. If
the camera’s firmware reads each half of the
dual pixels separately, the result is a pair of
images that can be used to perform phase
detection, whereas reading each dual pixel
as a single unit creates a normal image at 
full brightness. According to Canon, The 
EOS 70D’s conventional contrast-detection
AF is no longer required in live view 
mode and the focus overshoot common in
contrast-detection systems is no longer
present. Focus fine-tuning in already sharp
subjects disappears too. The system is ideal
for shooting video, as all you have to do to
perform smooth, natural-looking focus
tracks is tap the appropriate place on 
the touch screen monitor. The sytsem is
even said to be able to track subjects 
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Hybrid Autofocus

Temporarily masked phase-detection AF pixels (shown here in
black and white) can be placed virtually anywhere on the
sensor’s surface, but shouldn’t be distributed so broadly that
they impair the quality of the resulting image. The illustration
demonstrates the principle involved and the portion of the
frame that is covered by the contrast-detection
implementation used in the Olympus OM-D E-M1.

right 

right

left

left 



that are moving along the optical axis of 
the lens, either toward or away from the
camera.

No Cross Sensors

Like masked hybrid AF pixels, dual pixels are
only right/left sensitive, and thus form
virtual horizontal line sensors that can only
detect vertically oriented edges. The system
doesn’t include vertical line or cross sensors,
so the EOS 70D’s live view autofocus doesn’t
work for subjects that consist exclusively 
of horizontal patterns. In this respect, the
camera is no better than the very first
autofocus SLRs such as the Minolta Maxxum

7000 or the Nikon F-501. (Cross sensors were
first introduced in analog SLRs in the early
1990s.) However, the fact that the Canon’s
dual pixels cover around 80 per cent of the
frame means that you can distribute AF
points just about anywhere to help you
track all manner of stationary and moving
subjects.

Dual pixel technology is still in its infancy,
but nevertheless offers plenty of potential for
further development. It could, for example, be
used to record separate depth data for each
pixel that could then be used to aid image
processing, adjust depth of field, simplify
object selection or recognize certain types of
subject. 

The Downside of 
Phase-detection AF

The major issue facing sensor-based 
phase-detection systems is that they ‘see’ the
subject with the same degree of sharpness as
the image sensor. If the lens is sufficiently
defocused, the camera can no longer detect the
details necessary to detect phase differences. In
contrast, conventional dedicated AF sensors
have a comparatively small effective aperture
and have greater depth of field than the image
sensor. This means that both hybrid and dual
pixel systems tend to ‘pump’ more than
conventional phase-detection systems while
searching for the correct point of focus.
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Contrast-det. pixels

In the APS-C Alpha a6000 (left), Sony covers the entire frame with phase-detection pixels. To preserve image
quality in the full-frame Alpha a7 (right), the phase-detection pixels are located in the center of the frame.
Unlike phase-detection systems, contrast-detection AF doesn’t require the use of dedicated pixels, so the AF
points can be located anywhere and can be redistributed using the camera’s software.

The two halves of the
‘dual’ pixels in the Canon
EOS 70D’s 20-megapixel

sensor can be read
together or separately.
When used separately,
they collect data from
both sides of the lens 

and can thus act as 
phase-detection

AF sensors.
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The simplest way to test your camera’s
autofocus is to mark a focus target point on a
ruler leant diagonally against a wall. The
problem here is that the diagonal surface can
too easily cause unwanted focus shifts, so the
solution is to combine a diagonal ruler with a
vertical focusing target. There are various
commecial products that take this route, such
as the Datacolor SpyderLensCal ($64) or the
LensAlign MkII ($85). These devices are, of
course, much more expensive than a ruler, but
are also much more capable. There is also a
Long Ruler Add-On available for the
LensAlign, with a 32” ruler for testing at
greater distances or using longer lenses. To
achieve the best possible results with this type
of tool, you have to ensure that the camera’s
sensor is parallel to the target. The easiest way
to do this is using a small mirror, although
none of the tools we tested has one built in.
We decided to improvize and glued a 
pocket-sized mirror to the target. To align
your camera using this method, set it up so
that you can see the half of the lens cut off by
the edge of the mirror in the viewfinder. Our
tests showed that such a high degree of
precision is only really necessary at close
distances – for instance, when calibrating a
macro lens. In such cases the available depth
of field covers just a few millimeters and even
small deviations from parallel cause focus
errors.

Manufacturers of calibration devices
recommend shooting at a distance of 25-50x

the focal length of the lens. Note that the
greater the distance, the greater the depth of
field, which can make it tricky to find the point
of sharpest focus. Online tools such as
dofmaster.com help to precisely calculate
depth of field. Let’s look at an example: using
a factor of 50 at f2.8 with a full-frame camera
gives us a depth of field of around 20 cm,
regardless of the focal length of the lens, but
the SpyderLensCal has a total depth of just
13 cm. Even accounting for a reduction 
of depth of field to about 15 cm at 100%
magnification, the device can only be used to
detect rough focus errors. Using a longer ruler
doesn’t help much either, simply because it is
difficult to pinpoint the exact center of a long,
soft focus gradient. Unless you are checking a
really fast lens, you should stick to using short

subject distances to run your tests. Focus
errors are more critical at close distances
anyway, where depth of field is at its
shallowest. 

Free Test Charts

There are plenty of free autofocus test charts
available online that you can print out and
stick to a piece of card for home use. The one
at regex.info/blog/photo-tech/focus-chart is
a great example that includes comprehensive
instructions for setup and use. 

However, because cameras don’t allow
you to directly enter focus adjustment values,
accurate detection and measurement of focus

errors is only half the battle. This means you
have to use trial and error to find out which
values work best, so make sure you note
which values you measure using which
particular camera/test chart setup. Using the
Canon EOS Utility software, you can enter the
number of steps that are necessary to achieve
your target value in the form of an AF
microadjustment value.  

FocusTune by Michael Tapes
(www.michaeltapesdesign.com) is a software
solution for measuring and entering AF
microadjustment values and is designed to
work as a standalone tool or in conjunction
with the LensAlign MkII focus calibration
device.
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Autofocus Calibration Tool Test

The Datacolor
SpyderLensCal is a

commercial calibration
tool with a built-in

vertical focusing target

c’t Digital Photography 21 (2015)

It is relatively simple to check how precisely your camera’s autofocus works and you can
often compensate for lens-specific inconsistencies using the tools included in the camera’s
menu system. There are many free and commercial calibration tools available, and the
following sections take a detailed look at some of the more popular models. 
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FoCal (www.reikan.co.uk) is an automated
focus calibration system available in a number
of different versions that includes its own
printable test charts. The system can
automatically enter microadjustment values
into a wide range of Nikon and Canon
cameras via a USB connection.

Checking Focus using Moirés

Moiré effects are normally one of a
photographer’s worst enemies, but they can
also be used to check the accuracy of an
autofocus system. Moirés occur where
regular patterns with similar frequencies are
superimposed on one another, such as the
pattern in a piece of clothing and the pixel
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Autofocus precision depends on a number
of factors, some of which have to do with
physics and cannot be corrected by making
adjustments to your hard- or software. The
following are some of the more important
factors influencing the autofocus process.

Correct hardware adjustment: To avoid
systemic focusing errors, a camera’s AF and
image sensors have to be positioned on the
same optical plane. This is automatically
the case for all sensor-based contrast-
detection, hybrid and dual pixel AF
systems. The AF sensors used in most DSLR
phase-detection systems are located away
from the image sensor beneath the mirror
box and have to be extremely precisely
adjusted in order to work correctly.

AF system precision: Focus anomalies
that go undetected cannot be adjusted. All
AF systems have limits to their resolution,
and in phase-detection systems, this is
determined by the distance between the
sensors (the ‘baseline’). And by the way,
one hundred percent accuracy isn’t
actually a good thing, as the AF motor can
only come completely to rest if the system
has a built-in degree of tolerance.

Working vs. actual aperture: Spherical
lenses (i.e., those in which both surfaces
are curved) refract light more strongly at

their edges than in the center. The
focusing inconsistencies that result from
these differences are known as spherical
aberrations and are a common error in
many lenses. Because focusing takes place
with the aperture wide open, the edges of
the lens play a significant role in
determining the focus setting. If the photo
is then captured using a smaller aperture,
light only enters the center portion of the
lens and the point of focus will be more
distant then the one measured at
maximum aperture. 

Differences in color: Light rays of varying
colors (i.e., with differing wavelengths) are
refracted to different degrees when they
pass through glass. The resulting image
errors are called chromatic aberrations and
often cause unsightly colored fringes at
high-contrast edges. AF sensors detect the
same color differences as the image sensor
and adjust focus according to the
dominant color. Theoretically, camera
firmware can compensate for these types
of errors using the color temperature of
the light entering the lens as a guide – we
were, however, unable to confirm whether
this technique is actually used by camera
manufacturers. For example, in warm,
reddish light, focus needs to be shifted
slightly rearward.

Imprecise focus travel: Modern AF lenses
are designed for speed and are
consequently fitted with high gearing and
short focus travel. This makes it tricky to
find precisely the right focus point when
focusing manually using the focus ring on
the lens. With some cameras, such as the
mirrorless Panasonic Lumix DMC GM1, you
can operate the focus motor using a lever
or by way of touch screen gestures,
although this can be quite fiddly.
Mechanically focused lenses such as the
Zeiss Otus series, with their long focus
travel, are much easier to adjust accurately.
Focusing AF lenses manually always
involves compromises.

Mechanical play: Especially with older,
well-used lenses, focus accuracy depends
on whether it has to be adjusted from a
distant or a nearby point. Autofocus
mechanics simply wear out with frequent
use and excessive play affects the precision
of the results.

Heavy lens elements: The elements used
in telephoto lenses can be quite heavy
and, once they are in motion, can cause AF
systems to overshoot the point of focus
they are targeting. If this overshoot is
within the tolerances of the lens, a focus
error will result. 

Sources of AF Errors

This series of
SpyderLensCal test
shots was captured
using a Sony A580
fitted with a Tamron
60mm f/2 macro lens.
This particular combo
shows an average back
focus of about 1cm.



grid in a camera’s image sensor. When it
comes to checking focus, patterns that are
similar to the sensor grid (i.e., with consistent
horizontal and vertical stripes or regularly
distributed dots) are particularly useful.
Check out www.komar.org/faq/camera/auto-
focus-test/ for some test patterns that
produce mild moirés. Our own test pattern
(included with this issue’s free online content)
produces strong, striped moirés and can be
used for checking focus and other aspects of
a camera’s functionality. To use them, these
test charts have to be displayed on a
computer monitor, where the monitor pixel
grid compounds the moiré effect. You can
then observe the moirés on your camera’s
monitor or in its electronic viewfinder. 
The effect is not visible if you view the 
test pattern through an optical viewfinder.
This technique works best in the small 
camera monitor/viewfinder because it
superimposes the patterns from the chart,
the image sensor grid, the pixels selected by
the camera and the pattern of the

monitor/viewfinder’s own pixels to create the
displayed image. This multiplicity of patterns
ensures that moirés are produced at varying
magnifications (i.e., at different zoom settings
or different camera-to-monitor distances)
that can then be used as effective focus
indicators. The moirés are not visible viewed
at 1:1 in live view mode or in the photo
itself, although in both these cases, you can
judge focus visually anyway. If you set up
your camera to reproduce the points on the
chart at life size on the sensor, the resulting
photo will also contain obvious moirés. In
this case, the low pass filter whose job it is
to prevent moirés doesn’t really help, and
we captured all our moirés using cameras
with low pass filters.

To check focus, set up your camera on a
tripod in front of a monitor with the moiré test
pattern displayed at 100% magnification. If
necessary, you can set magnification to 200%
for greater camera-to-monitor distances or if
you are checking focus in a wide-angle lens.
Whichever option you choose, do not use
magnifications between these two values.
Select your distance (or zoom setting) so that
a striped moiré appears in the 100% live view
image of the computer monitor. Everything is
set up correctly if the stripes are horizontal
and distributed evenly across the frame. The
broader the stripes, the better the
superimposed patterns coincide. However,
stripes that are too broad are less useful when
assessing focus accuracy, so it is best to select
a camera position that produces a total of five
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Most high-quality camera have a
menu item for entering 

lens-dependent AF microadjustment
values. The Canon EOS 70D even

enables you to enter separate values
for the wide and telephoto settings

in a zoom lens. The camera uses
serial numbers to differentiate

between lenses of the same type.

The AF test chart offered by Walter
E. Schoen at www.weschoen.de/
af-testtafel.html has sets of double
lines and multiple scales for use
with the distortion produced by
various focal lengths. The area of
maximum sharpness 1 lies
between the points where the
double lines meet – in this case,
between about -40μm 2 and
+100μm (not shown in the
illustration). The in-focus zone is
quite large at f4.5, making it tricky
to zero in on the sweet spot.
Because it is positioned diagonally,
it is also quite tricky to focus
precisely on the relatively small
focus target 3.
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or six stripes. Ignore any dark flickering stripes
that race across the image, as these are a
product of the monitor’s refresh rate
coinciding with the camera’s live view
sampling rate and have no effect on the test.

Once the camera is set up, switch live view
off, or at least make sure that only the
phase-detection part of the AF system is in
operation. Some cameras have some kind of
‘Quick AF’ function that aids focusing by
lowering and raising the mirror to give the AF
sensors a brief look at the world outside. The
camera monitor now displays the image as it
has been targeted by the camera’s AF system.
Now switch to manual focus and observe how
the moirés change when you adjust the focus
setting. If the contrast in the moiré stripes
increases, the camera has failed to find the
point of maximum sharpness, or ‘sweet spot’
as it is often called. 

If you have to rotate the focus ring toward
infinity to achieve correct focus, the AF system
is suffering from front focus, wheras if you
have to rotate it toward its close focus setting,
the camera has back focus. Set focus manually
to infinity and repeat the experiment. If
several consecutive attempts produce the
same type of focus error, chances are you 
will be able to correct it using AF
microadjustments.

Readjusting Autofocus

Mid-range and high-end DSLRs usually 
have a built-in AF microadjustment 
function, whereas mirrorless cameras with
contrast-detection AF or sensor-based
phase-detection AF don’t. The function
enables you to set values for a range of lenses
identified automatically using either the

model or the serial number. Legacy lenses are
identified by way of their maximum aperture
and focal length. Our Nikon D750 supports up
to 12 lenses, while the Sony Alpha a99
supports 30 and the Canon EOS 70D up to 40.
The Canon system also enables you to set
separate microadjustment parameters for the
long and short ends of the zoom range and
automatically interpolates an appropriate
value for zoom settings between the two
extremes. The Canon microadjustment
setting has a scale from -20 to +20 but doesn’t
let on which units it uses. Positive values shift
focus toward infinity (i.e., for correcting front
focus) and negative values correct back focus.
The only way to find out which values correct
which focus errors is by trial and error.
According to Canon, the degree of correction
required also depends on the maximum
aperture of the lens in use. 
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The stripes produced by correct use of our moiré test pattern make it possible to set up the camera and
monitor extremely precisely – an ideal setup produces uniform horizontal stripes. Any remaining pin-cushion
or barrel distortion is due to inherent lens errors that are greatly magnified by the process.

Bright circular moirés like the ones
shown on the right (captured using a

Sony Alpha a7 II) are a sure sign that the
patterns on our test chart have been
reproduced at 1:1 on the sensor. The

enlarged detail on the left shows 
part of the chart as it appears on the 

computer monitor. Near-perfect 
camera-to-monitor alignment causes the
camera to reproduce a highly magnified

view of its own Bayer pattern 
sensor pixels.



Our custom focus test chart is an animated GIF
designed for display in a web browser. If your
browser is set up to prevent web-based
animations from playing, check the ‘Play
animations in web pages’ option in the
Multimedia section of the Internet Options >
Advanced tab in Internet Explorer. The GIF has
to be displayed at 100% magnification, so
make sure that automatic image resizing is
disabled. The Toggle Animated GIFs add-on for
Firefox lets you play and pause GIFs with a
mouse click, which makes using our tool
simpler but is not essential when performing
the test.

The test GIF measures about 1700 x 1200
pixels and is divided into three sections with
vertical stripes of differing thickness. On a
monitor with 108 ppi pixel density, the two
scales display the focal depth (in centimeters)
when you view the monitor at a 45-degree
angle. Every six seconds, the GIF displays a

large black-and-white rectangle in the center
of the test image to ensure that the camera
has a predefined focus target located in the
center of the screen. Three seconds later, the
focus target disappears and gives the camera
an unhindered view of the test image.

Set your monitor up vertically and check it
using a spirit level. Mount your camera on a
tripod so that it is aimed at the center of the
monitor at a 45-degree angle. This angle of
view visually shortens all horizontal lines to
about 70 percent of their original length. The
test image and the focus target are designed
to appear virtually square to the camera. Use
a camera-to-monitor distance of 25-50x or,
alternatively, the distance at which you most
often use your lens (i.e., close up for a macro
lens). Note, however, that the closer your
camera to the monitor, the more perspective
distortion comes into play and the larger the
stripes at the end of the monitor image closest

to the camera will appear. This effect
produces results that give preference to the
test stripes closest to the camera, which
appear larger and therefore sharper. This is an
issue in all conventional focus test charts and
tools, and only Walter Schoen’s chart (see
page 80) takes distance-related distortion into
account.

Before you start the test, make sure you
load the accompanying Photoshop Actions by
double-clicking the <ctDP_AF.atn> file
included with this issue’s free online content. 
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How To Measure and Compare Deviations in Focus

Our focus test pattern consists of two images that alternate every three seconds. The left-hand
image is the focus target and the shutter is released as soon as the right-hand image appears.

We have developed a custom technique for assessing autofocus precision using a specially
designed image displayed on a computer monitor. The method is quick and, because the
focus gradient in the resulting images can be extracted in the form of a curve using a
Photoshop Action, it is extremely accurate too. The technique simplifies the laborious task
of searching for the sweet spot. All of the files mentioned in the following tutorial are
included with this issue’s free online content.
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If you shoot at a distance that is constant
relative to the focal length of the lens (30x

for example), the test image will always be
captured at around the same size. This is
because the reproduction ratio at relatively
close distances is determined by the ratio of
focal length to subject distance. At a
distance of 30x focal length, the

reproduction ratio is about 1:30. This means
that our test image, which is 28 cm high on a
108 ppi monitor, will be reproduced
approximately 1 cm high on the sensor. The
size of the test image in the resulting photo
depends on the size of the sensor. For
example, in an APS-C camera such as the
Canon EOS 70D, the sensor measures

22.5 x 15 mm and the test image covers
about two thirds of its height. This equates
to a height of 2158 pixels on the Canon’s
5472 x 3648-pixel sensor. In turn, this means
that every pixel of the monitor-based test
image is captured by almost two sensor
pixels. The black and white line pairs in the
test image are 4, 6, and 8 pixels wide but are
compressed by the 45-degree angle of view
to 1/√2 (about two thirds) of their original
size. As a result, each line pair is captured by
5, 8, or 10 sensor pixels. At this kind of
resolution, any lack of sharpness can only be
a result of focus errors, not inadequate
sensor resolution.

The math looks a little different if you use a
full-frame camera. At the same
reproduction ratio, the test image covers
less than 39 per cent of the 24mm height of
the sensor. Using a Canon EOS 5D Mark III,
with its 5760 x 3840 22.3-megapixel sensor,
this gives us a subject height of 1498 pixels,
which is dangerously close to the 1:1
reproduction ratio that would plunge the
image into a mass of blurry moirés. This
issue is less critical for a 50-megapixel
camera like the Canon 5DS because the
8688 x 5792-pixel sensor provides more
pixels per line pair. Moirés can, of course, be
used to judge sharpness, but cleanly
resolved line pairs are usually the better
option. The best way to avoid this type of
issue is to move the camera closer to the
test image or use broader stripes for your
final assessment. Remember that the object
of the test is to check autofocus precision,
not measure the resolution of the camera’s
image sensor. 

The centimeter units on the scales located
between the stripes in the test image are
displayed at life size on a 108 ppi monitor, so
you can read any front or back focus values
directly from the image. If you prefer to use
one of the 300 ppi versions included with
this issue’s free online content, print it at
40 x 28.3 cm (15.75 x 11.1”) on a sheet of
ledger/A3 paper. Viewed at a 45-degree
angle, the print will contain 15 of the finest
line pairs per centimeter and is ideal for
testing an APS-C camera at a distance of 30x

focal length. The other line patterns (with 10
and 7.5 line pairs per centimeter) are better
suited to testing at greater distances or for
cameras with larger sensors, and are also less
prone to producing moirés. 

Setting the Distance and the Size of the Test Image

Camera-to-monitor
distance

45°

Set the camera up at 45
degrees to the monitor at a
distance of 25-50x the focal
length of the lens

For the test to work, you
have to enable web-based
animations in your browser
and disable automatic
image resizing. The
illustration shows the
setting in Internet Explorer.
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Tutorial: How to Measure Focus Deviation

3⎢Rename your test images and load them into a stack. If you 
are shooting multiple sequences to test various lenses, it is a
good idea to rename the resulting image files accordingly. 
Load the sequence into a layer stack in Photoshop or any other
layers-capable image processing program. In Photoshop, use the
File > Scripts > Load Files into Stack command or in Bridge use

Tools > Photoshop > Load Files into Photoshop Layers.
Alternatively, open one of your images in Photoshop and drag
the remaining files onto it from the Windows Explorer window.
The resulting layers will be automatically named using the
filenames. This method also works with Photoline and possibly
other image processing programs too.

1⎢Set up the camera. Because the camera is mounted on a tripod,
you can switch the stabilizer off. Select one-shot AF and set the
camera up so it points precisely at the center of the focus target
that appears every three seconds on the monitor. Select JPEG
format and the highest resolution and quality settings available
(raw isn’t necessary for this test). Switch off any automatic image
enhancements such as in-camera sharpening and lens
corrections. Now set the camera to single shooting mode, set a

low to medium ISO value, switch exposure metering to ‘spot’
and open the aperture to its widest setting. Take a test shot in
aperture-priority mode. If it is correctly exposed, switch to
manual (M) mode and use the exposure time determined by the
camera to ensure that all your shots are exposed the same. To
avoid camera shake, use mirror lockup and a remote release (or
the self-timer).

2⎢Shoot a sequence of test images. Press the shutter button
halfway while the animated GIF is showing the focus target and
only press it all the way once the GIF has reverted to the striped
test image. This is then captured using the focus setting you
have locked in. Set focus manually to close focus or infinity
before each shot to ensure that the autofocus mechanism
switches in, then shoot at least three shots from each focus
‘direction’. This ensures that your results provide meaningful
data for any consistent focus deviations and on the precision of
the repeated focusing process. 

4⎢Crop your images. The test pattern often takes up only half of
the width of each frame, so it is safe to crop the rest of each
image. This saves computing power while you work and disk
space when you archive your stacks. 

Use your camera’s viewfinder or monitor to focus but
only release the shutter once the focus target

disappears and the striped test image is displayed

The rectangular test pattern
appears almost square when

photographed at a 45-degree angle
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5⎢Run our custom Action. Select the uppermost layer in your
stack and start the AF_analysis Action. This creates two
adjustment layers for optimizing contrast and grayscale
conversion and a layer group called analysis. The Action extracts
the contrast data from the uppermost layer in the stack and

inserts the result in the form of a curve into the new layer group.
By default, the tool is located on the 
medium-resolution line pair pattern in the middle of the image.
You can, however, drag it to one of the other patterns or
duplicate it to simultaneously display the curves for all three. 

6⎢Analysis. We performed step 5 for all three line pair patterns and
marked the position where the curves were broadest. These were
consistently located at around +4 on the scale, indicating that our
Nikon D750/Tamron 90mm F/2.8 Macro test setup has a front focus
shift of about 4 cm. The other images in the stacks, captured with the
lens set initially to infinity or close focus, confirmed this. Mark the
point of focus with a red dot above or below the curve on each layer.

To check our results, we generated the curves for
all three test patterns. It is best to assess the

position of the focal point at 100% magnification.

c

7⎢Extract the curves. The other Photoshop Action provided with this
issue’s online content extracts the curves generated by the first Action
so that you can save them separately and superimpose them on one
another for comparison purposes. To do this select the analysis layer
group and run the AF_extract_curves Action. This creates a new layer
containing the currently displayed curve above the selected group.
Repeat this step for each layer in your test image stack and arrange
the resulting layers in the correct order. These new layers are arranged
in the order you create them using our Action and are automatically
labeled Layer 1, Layer 2 etc., so it is best to rename them immediately
before you lose track of which is which.

Once you have created and renamed all your curve layers, 
unhide them and place them next to each other for comparison. 

The illustration shows a sequence captured using a camera 
that consistently produces images with front focus.

8⎢Determine and save the microadjustment value. Once you
have established how your camera’s autofocus system behaves,
you can use its AF Microadjustment function to enter an
appropriate correction value. These values have no units, so 
you will have to use trial and error to find out which values
correspond to the focus deviation you have determined. Try
shooting a sequence of test images at 5-point increments to
cover the entire range from -20 to +20. Note which value
corresponds to which image number, as these usually end up
being saved as proprietary Exif tags that not every program 
can read. The ExifTool freeware is a notable exception.



Inkjet printers are ideal for making high-quality prints of digital
photos. They have ultra-precise print heads that use ink droplets

between 2 and 4 picoliters (pl) in size to faithfully reproduce even the
finest details. Up to ten separate ink cartridges provide a huge range
of printable colors and make it possible to reproduce ultra-fine color
nuances and grayscale gradients. Pigment inks ensure high color
density and saturation, while color profiles fine-tuned to suit individual
print media make printing on even the most exotic fine-art papers a

precisely controllable task. Additionally, the many software-based print
options give you an unprecedented degree of control over the look of
your prints.

We tested the high-end PIXMA PRO-10 and PRO-100 models from
Canon and the Epson SureColor P600, which is the follow-up model to
the popular Stylus Photo R3000. With an RSP of $499.99, the PIXMA
PRO-10 is the cheapest of the three, while the PRO-100 goes for $699.99
and the P600 for $799.99. Canon’s three-year-old top-of-the-range
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Rudolf Opitz

Pro-grade 13” Photo Printers
from Canon and Epson
High-end printers produce print quality at home that many specialized photo
labs cannot match. With up to ten individual ink cartridges, comprehensive
color management functionality and dedicated software, these printers give
you complete control over your paper-based results.



PIXMA PRO-1 (see A3 Printers in Practice in Issue 13 for a detailed review)
has an RSP of $999.99. As ever in the electronics market, heavy
discounts can be found if you shop around.

The two Canon printers look identical but have different print
mechanisms. The PRO-100 uses eight separate cartridges of
ChromaLife100+ dye-based ink, whereas the PRO-10 uses nine of
Canon’s LUCIA pigment inks plus a tenth cartridge of ‘Chroma
Optimizer’ – a specially developed fluid that fills the spaces between
ink droplets on glossy paper, providing uniform ink height and
preventing the unwanted reflections that reduce the visual saturation
of dark colors. The PIXMA PRO-1 uses additional light and dark gray
inks, giving it a total of 12 cartridges and print heads.

Like the PIXMA PRO-10, the Epson SureColor P600 uses pigment
inks. The new UltraChrome HDR inks are said to provide extremely
dense blacks and smooth color gradients, especially when used with
glossy papers. It also uses two black inks: photo black for glossy papers
and matte black for deep, saturated blacks on normal and fine-art
papers.

While the PIXMA PRO-10 has a separate print head for both blacks,
The Epson P600 has just one black print head for use with its two black
cartridges – an annoying feature inherited from its predecessor, the
Stylus Photo R3000. The paper settings in the printer driver usually
determine which black is used, although you can choose which to use
yourself if you are printing on normal paper. You can also switch blacks
using the controls built into the printer but, depending on the settings
you are using, the driver often resets user-controlled settings
automatically for the next print you make. Every switch between photo
and matte black involves cleaning the black print head and wastes
costly ink, so it is best to avoid switching if you can. During our test,
switching to matte black took about 90 seconds and switching back to
photo black took almost three minutes of head cleaning, so patience
is required when switching modes.

There’s Ink, and then There’s Ink ...

Dye-based and pigment inks have their own specific advantages and
disadvantages. Cheap and mid-range printers usually use dye-based

inks, which are absorbed by the surface of normal paper and dry
quickly. Colors are mixed by applying multiple layers of different
colored inks. 

In contrast, the colored particles in pigment inks remain on the
surface of the paper, so adding a layer of another color would simply
cover the previous layer. To produce mixed colors, the printer therefore
has to place ink droplets next to each other. The major advantage of
this system is that the resulting colors have better coverage and don’t
bleach out as fast as their dye-based counterparts. Different ways of
mixing colors have little effect on the available color space, so using
additional inks (such as the red available for the PIXMA PRO-10) is a
more effective way to enhance color reproduction.

The stability of printer ink in sunlight depends very much on the
paper you use. Sensitive dye-based inks are well protected by the
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The Canon PIXMA PRO-100’s print head has 6,144 separate 
nozzles, which equates to 768 for each color

The PIXMA PRO-10’s print head houses ten ink cartridges. Nine
are color inks and the tenth is the ‘Chroma Optimizer’ fluid that
ensures uniform ink height in prints.

The Epson SureColor P600 has nine separate ink cartridges but only
eight print heads. Switching between photo and matte black mode
involves cleaning the black head, which wastes precious ink.



carrier layer in photo papers but fade more quickly when used with
normal paper. We used a xenon lamp in our lab to emulate 100 and 200
hours of exposure to sunlight, and our sample prints on normal and
Canon Pro Platinum photo paper confirmed these assumptions.

Canon’s LUCIA and the Epson Ultrachrome HDR pigment inks both
proved extremely stable when used with Canon Pro Platinum and
Epson Premium Glossy photo papers and showed no significant signs
of bleaching on normal paper (in our case, a no-name ‘premium’ paper)
following 100 hours of exposure. The samples we made using the
PIXMA PRO-10 only began to show slight signs of fading in the red
tones when we extended our test to cover 200 hours of exposure to
simulated sunlight, whereas the samples we printed on photo paper
using the PIXMA PRO-100 showed significant fading after just 100
hours, and those printed on normal paper turned out even worse.
Nevertheless, the Canon ChromaLife100+ inks proved to be much more
fade-resistant than the standard inks Canon uses in its entry-level and
mid-range PIXMA printers, especially in the more sensitive red tones.

Ink Costs

It is always difficult to estimate the ink costs involved in printing 
photos, as the amount of ink required depends on the type of 
subject and the paper being used. Generally speaking, photos printed
on glossy paper use less ink than those printed on normal or 
fine-art matte papers. 

Measured using the ISO/IEC 29102 standard for determining photo
yield for color inkjet printers, a 6 x 4” print made using ChromaLife
(CLI-42) ink on a PIXMA PRO-100 costs about $0.38, while the same print
costs about $0.47 using LUCIA (PGI-72) inks with the PIXMA PRO-10.
These estimates do not include paper costs. The larger ink cartridges

used in the PIXMA PRO-1 make a standard print slightly cheaper, at
about $0.41.

Strangely, Epson quotes print capacity for the SureColor P600 using
the ISO/IEC 24711/24712 standard, which covers text and graphics
printing. While this results in an estimate of 12,000 pages of text, it
sheds no light on its photo printing capabilities. We tried to find out
from the manufacturer why the more relevant photo standard isn’t
used, but our query remained unanswered as we went to press. 

We compared the prices and the amount of ink contained in Epson
and Canon LUCIA cartridges and concluded that, milliliter for milliliter,
both types of ink cost about the same. 
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The dye-based inks used by the Canon PIXMA PRO-100 faded visibly during our sunlight test, and yellows especially
suffered from the treatment. The pigment inks used by the PIXMA PRO-10 faded only slightly, and the Epson inks
weren’t visibly affected, even after 200 hours of exposure.

Canon PIXMA PRO-100
100 hours 200 hours

Canon PIXMA PRO-10 
100 hours 200 hours

Epson SureColor P600 
100 hours 200 hours

Inkjet printers
cannot usually
print at maximum
resolution on
normal paper. 
In the Epson P600
driver interface,
the higher-quality
settings are simply
grayed out.

Normal paper Normal paper Normal paper Normal paper Normal paper Normal paper



The high ink costs make these devices unsuitable for printing
6 x 4” vacation snaps, as you can get prints made at a drugstore for
$0.10 or less. The price differential is smaller for 8 x 11.5” prints and,
when it comes to making prints that are 11” or 13” wide, it is nearly
always cheaper to print at home. Remember too, that most printers
produce their best results on the manufacturer’s own-brand paper,
and home-printing enables you to select the paper yourself. Perhaps
most significantly, home printing gives you complete control over
every step in the print creation process, enabling you to fine-tune
the process to suit your own personal requirements, just like in an
analog darkroom.

Choosing the Right Paper

The choice of paper is key to the success of a high-end photo or
image-processed art print. The paper you use determines the maximum
resolution the printer can use and the effect produced by the inks.
Inkjet printers cannot usually print at maximum resolution on normal
paper. In the PIXMA PRO driver dialog, for example, you can only select
‘Fine’ resolution if you first select a glossy photo paper. If you select
normal paper in the Epson SureColor P600 driver dialog, print quality
levels 4 and 5 are simply grayed out.

Many paper manufacturers recommend that you stick to ‘high’ or
‘720 dpi fine’ resolution when using fine-art and other textured photo
papers. Our test showed that using the Canon devices at maximum
resolution with fine-art paper produced pinprick-sized blank spots
where the ink wasn’t able to completely fill the deep indentations in
the surface of the paper (see the example below left). Such artifacts are
very small but, in a finished print, can be just as distracting as dead
pixels on a monitor.

Inkjet printers generally produce their best resolution on glossy
photo paper although in this respect, paper manufacturers’ own figures
are often highly theoretical. Canon often quotes maximum resolution
for its low-end printers at an unbelievable 9600 dpi, but only 4800 dpi
for the high-end models tested here. However, our real-world tests and
close inspection using a microscope proved that the high-end printers
produce much finer details than their cheaper counterparts. 

The Epson P600 didn’t quite equal the resolution produced by the
Canon printers, probably due to the 768 nozzles per color built into the
Canon print heads, compared to the Epson’s 180 nozzles per color.
Note, however, that Epson uses its proprietary ‘Micro Piezo’ technology
in its print heads, enabling them to produce much finer droplets than
the Canon ‘Bubble Jet’ print heads. Epson advertises its products with
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Photo paper helped protect the PIXMA PRO-100’s dye-based inks from fading but didn’t completey eliminate the effect.
Both types of pigment inks we tested weren’t visibly affected, even after 200 hours of exposure.

Printing at
maximum

resolution on
textured paper

produces pinprick
artifacts because
the ink droplets
don’t fill all the
indentations in

the paper

Canon PIXMA PRO-100 
100 hours 200 hours

Canon PIXMA PRO-10 
100 hours 200 hours

Epson SureColor P600 
100 hours 200 hours

Photo paper Photo paper Photo paper Photo paper Photo paper Photo paper



the slogan “variable-sized droplet technology”. Canon’s technology
heats up the ink to produce a tiny bubble of gas that propels the ink
onto the paper and cannot be regulated as finely as the piezoelectric
crystal used by Epson. As far as absolute resolution is concerned, Canon
more than compensates for its less sophisticated technology by using
more nozzles.

Color Fidelity

Print color management is controlled either by the printer driver itself
or by your image processing program. The color space specified in the
input color profile – usually sRGB or Adobe RGB – has to suit your
printer and paper. The program responsible for rendering the image
uses ICC (International Color Consortium) output profiles, which exist

for every type of paper supported by the system. These profiles contain
color lookup tables (LUTs) of adjustment values that the printer driver
uses to ensure that the printed hues turn out as authentically as
possible on the paper you select.

The ICC profile usually controls the operating system’s color
management module. In Windows, the settings can be found in the
Color Management section of the Control Panel. A generic paper profile
and ICC profiles for manufacturer’s own-brand papers are automatically
installed when you install the printer driver, and profiles for third-party
papers and high-end printers are usually available from the paper
manufacturer’s website.

Canon offers its own profiles for its PIXMA PRO printers and a wide
range of popular papers. We tested the Canon and Hahnemühle
profiles with Hahnemühle German Etching 310 fine-art paper, and
found that while the Canon profile produced stronger, more detailed
blacks, the Hahnemühle profile produced more authentic colors.

The quality of an ICC profile depends on the size and degree of
precision of its LUTs, and you can create your own profile for your
favorite paper using a photospectrometer. Canon’s Color Management
Tool Pro software (downloadable for free from the Canon website) can
be used to calibrate Canon printers, and Epson offers its own free
ColorBase 2 software for calibrating the P600. The Epson software
cannot, however, be used to create custom ICC profiles, and both
programs only work with the ColorMunki and i1-series photometers
from X-Rite. The Canon tool requires you to print a color target on your
chosen paper and measure the resulting colors using the photometer.
It then enters any discrepancies between the standard and measured
colors in an LUT and saves it to a new ICC profile.

If you don’t wish to purchase a photometer or if the calibration
process is too complicated, you can always use a Web-based service
such as printerprofilesonline.com instead. All you have to do is print a
target on your chosen paper and send it to the service provider, who
then sends you a custom ICC profile. Typical profiles cost around $100,
but they vary from provider to provider and according to the number
of color fields in the target (the more fields, the more precise the results
will be).

Hard- and Software

The two Canon printers we tested are almost identically equipped and
handling is the same too. Both have a rear tray for 150 sheets of paper
up to 13” wide and a dedicated manual feed for thicker papers.
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Canon’s PIXMA PRO printers offer extremely fine resolution that the Epson P600 can’t quite match. From left to right, these samples
are from the PIXMA PRO-100, the PIXMA PRO-10, the Epson SureColor P600 and, as a comparison, Canon’s value PIXMA iP2700.

In Windows, ICC color profiles are found in the Color Management
section of the Control Panel
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The Epson SureColor P600’s top-loading feeder can handle up to 120
sheets of 13” normal paper or 30 sheets of photo paper, while its
front-loading manual sheet feed can handle paper up to 1.3 mm thick.
Such media have to be aligned by hand and the feed activated using the
printer’s touch screen controls. For media up to 0.7mm thick, the P600
feeds finished prints into the single sheet feed holder, whereas thicker
media are fed directly out the back of the device, so you have to make
sure you have enough space behind the printer to catch your work.

The Canon printers can only print the paper formats listed in the
device driver, whereas the Epson P600 can also print on roll paper up
to 13” wide using the holders supplied with the device.

The P600 has a tiltable 2.7” touch screen control panel and three
large buttons. The menu displays remaining ink levels and tips for
loading custom media and also includes settings for a Wi-Fi connection
and switching between photo and matte black modes.

The Canon printers have just three buttons: ON, RESUME/CANCEL
and Wi-Fi for automatic WPS-based network setup. The lack of a
monitor makes some settings quite tricky – for example, to switch from
Wi-Fi to LAN-based printing, you have to keep the RESUME button
pressed until the LED in the power button blinks 11 times.

The Canon Printers have a USB socket on their front panels for direct
printing from PictBridge-compatible cameras, but USB sticks are not
supported (the lack of a monitor makes this impractical anyway). The
P600 does not have the PictBridge-compatible USB connector that was
included in the earlier Stylus Photo R3000.

Both PIXMA PRO printers are Apple AirPrint-compatible and can
print borderless prints on compatible papers. The Google Cloud Print

feature included in 4.4 (KitKat) and later versions of Android requires
you to install the Canon Print Service plug-in from the Play Store, which
allows you to select custom paper type, format and setup settings. The
free Pixma Printing Solutions app is also available for earlier versions of
Android.

The P600 uses Epson’s own Wi-Fi Direct functionality for connecting
to mobile devices. The default setting in AirPrint creates borderless
prints from Apple devices. The Epson Print Enabler plug-in for Android
scaled our test photos incorrectly during our test, whereas the iPrint
app for Android versions prior to 4.4 worked without any issues and
offers more paper and print quality options than the newer app.

Results in Detail

All three test printers produced excellent quality borderless 13 x 19”
prints using each manufacturer’s own-brand luster paper and Canon’s
Pro Platinum and Epson’s Premium glossy papers. They all produced
bright, authentic-looking colors with great detail rendition and shadow
detail. The PIXMA PRO-10 and the Epson both took 10 minutes or more
to create a borderless 8.5 x 11” print, compared with the dye ink-based
PIXMA PRO-100, which took only three and a half minutes to do the
same job.

The Epson produced the most neutral monochrome grayscale tones
and the deepest blacks, although these showed slightly less detail than
those produced by both Canon printers. The PIXMA PRO-100 produced
cool, almost blue-tinged grays, while the PRO-10 produced warmer

Tonality, optical density and the highlight point can all be precisely
controlled in the Epson driver dialog, although there is only one
generic image available for checking the effects of your settings

The Canon Print Studio Pro plug-in’s ‘pattern print’ function
enables you to print a sheet of thumbnails with varying color,
brightness and contrast settings. This is a great aid to selecting
the appropriate settings for a particular paper type.



tones more in line with those of the Epson. For monochrome printing,
the Color Controls dialog in the Epson driver offers a comprehensive
range of settings for fine-tuning your results (see the screenshot on
page 91).

The P600 and the PIXMA PRO-100 print borderless on normal
paper, although the Canon only offers this option at its rather pale,
stripy-looking ‘Normal’ quality level. At the ‘High’ setting, too, results
from the PIXMA PRO-100 looked rather weak, and the results from
the P600 showed slight vertical stripes. In contrast, the PIXMA
PRO-10 prints at its highest possible quality on normal paper, but
with a 0.5 cm border.

Both Canons print on fine-art paper with a broad border of at least
1”, while the Epson’s more flexible driver enabled us to make borderless
prints on fine-art paper too.

Alongside its standard driver, Canon also offers the Print Studio Pro
plug-in for Photoshop (Elements) and Lightroom. This useful piece of
software combines the Canon and Adobe print options in a single
easy-to-use interface and offers a few features of its own, including the
‘pattern print’ function that enables you to print a sheet of thumbnails
with varying settings (see page 91, top right). For added clarity, the
corresponding settings are printed beneath each thumbnail. Print
Studio Pro adds real value for free, while Mirage Small Studio v15, a
similar offering for Epson, costs around $135.

The devices tested here are not really suitable for printing letters or
other office-based tasks. Even in fast mode, the PIXMA PRO PRO-100
takes two minutes to print 10 letter pages, while the P600 takes two
and a half minutes and the PIXMA PRO-10 more than three. None of
these devices offer duplex printing, although they do produce
pin-sharp, laser-quality type when you need high-class results for
important documents. For these types of jobs, the pigment inks used
in the PIXMA PRO-10 and the SureColor P600 produce deeper blacks
and more vivid colors on normal paper than the PRO-100’s dye-based
inks. For optimum results, use the P600’s matte black cartridge and
deactivate bidirectional printing for type.

All three can print appropriately coated CDs, DVDs and Blu-ray discs
using the supplied templates, which are inserted between guides into
the front of the Canon machines and into the single sheet feeder on
the Epson.

For printing CD labels, Canon supplies its My Image Garden software,
which has virtually no user-adjustable settings. The print area cannot
be altered, although the default Standard disc 4.7” (small inner circle)
setting prints all the way up to the margin around the hole in the
middle of the disc and leaves a 3mm margin at the outer edge. Epson
supplies its own Print CD software, with which you can alter the print
area to suit your own particular needs.

The PIXMA PRO-10 delivered excellent quality CD prints, but the
PRO-100 produced results with an obvious green cast in grayscale
image areas. Checking the auto color correction option alleviated the
problem but did not eliminate it. The Epson delivered good color
rendition but quite a coarse raster in our sample CDs.

Conclusions

All three printers offer extremely high-quality results and a wide range
of options for tweaking the look of your prints. The cheaper PIXMA
PRO-100 is faster than the other two, but it is worth investing in the
more expensive PIXMA PRO-10 or the Epson P600 if you plan to exhibit
your prints or hang them on your walls at home, as the pigment inks
these two devices use offer better color stability and print longevity.

If your work involves printing on unusually thick paper or roll media,
the Epson is the best choice. The Canon printers cannot feed thick
paper without bending it, so they cannot print on papers with a
thickness of 0.6 mm or more.

If you need to make even larger prints, check out the 
Epson SureColor P800, which can print up to 17” wide and costs 
about $1,200. (rop)
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Using additional ink cartridges enables you to produce finer color
nuances than normal, and the raster effects they produce only
become visible at high magnifications. From top to bottom, these
details come from the PIXMA PRO-100, the PIXMA PRO-10 and the
Epson P600.
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HIGH-END PHOTO PRINTERS
Device PIXMA PRO-100 PIXMA PRO-10 SureColor P600

Manufacturer Canon (www.canon.com) Canon (www.canon.com) Epson (www.epson.com)
Printing
Print technology Bubble Jet, 8 x 768 nozzles Bubble Jet, 10 x 768 nozzles Piezoelectric, 8 x 180 nozzles
Number of cartridges 8 (ChromaLife100+ dye-based) 10 (9 LUCIA pigment inks + Chroma Optimizer) 9 (Ultrachrome HDR pigment inks)

Smallest droplet 3 pl 4 pl 2 pl
Max. photo resolution 1 4800 x 2400 dpi 4800 x 2400 dpi 5760 x 1440 dpi
Paper weights 64 g/m2 … 350 g/m2, 

Single sheet feed max. thickness 0.6 mm
64 g/m2 … 350 g/m2, 
Single sheet feed max. thickness 0.6 mm

64 g/m2 … 255 g/m2 (main tray), 
Single sheet feed max. thickness 1.3 mm 

Paper feed 150 sheets of normal paper up to 13” wide (A3+), 
manual feed

150 sheets of normal paper up to 13” wide (A3+), 
manual feed

120 sheets of normal paper up to 13” wide (A3+), roll
media holders, rear single sheet feed

Borderless printing v v v

Automatic duplex printing – – –

CD printing v v v

Network and Cloud Functionality
Network printing v v v

App Pixma Printing Solutions (Android, iOS) Pixma Printing Solutions (Android, iOS) Epson iPrint (Android, iOS)
NFC – – –

AirPrint / Android Print (Mopria) v / v ( –) v / v ( –) v / v ( –)
Manufacturer Cloud service IJ Cloud Printing Center IJ Cloud Printing Center Epson Connect
Google Cloud Print – – v

Other Features
Interfaces USB 2.0, Ethernet, Wi-Fi (IEEE 802.11n, 2.4 GHz) USB 2.0, Ethernet, Wi-Fi (IEEE 802.11n, 2.4 GHz) USB 2.0, Ethernet, Wi-Fi (IEEE 802.11n, 2.4 GHz)
Dimensions in use (W x H x D) 27.2 x 8.5 x 15.2” 27.2 x 8.5 x 15.2” 24.2 x 32 x 16.6
Weight 43.2 lb 43.9 lb 35 lb
Monitor – – 6.8 cm touch screen
Windows drivers Windows XP (SP3, 32 Bit) and later, 

.NET Framework 4 or 4.5 required
Windows XP: 
XPS Essentials Pack required

Windows XP (SP3, 32 Bit) and later, 
.NET Framework 4 or 4.5 required
Windows XP: 
XPS Essentials Pack required

Windows XP and later

Mac / Linux drivers OS X 10.7.5 and later / – OS X 10.7.5 and later / – Mac OS 1.6.8 and later / –
Software Print Studio Pro, My Image Garden, Quick Menu, 

IJ Network Tool
Print Studio Pro, My Image Garden, Quick Menu, 
IJ Network Tool

Epson Easy Photo Print, Print CD, Software Updater

PictBridge / DPOF v / – v / – – / –
Ink Cartridges
Black2 CLI-42-ChromaLife100+: CLI-42BK (810 prints), 

CLI-42GY (452 prints), CLI-42LGY (855 prints)
PGI-72-LUCIA: PGI-72PBK (430 prints), 
PGI-72MBK (1100 prints), PGI-72GY (172 prints)

T760x Ultrachrome HD: T7601 (Photo Black), 
T7607 (Light-BK), T7608 (Matte Black), T7609 (Light Light
Black)

Color2 CLI-42C (484 prints), CLI-42M (410 prints), 
CLI-42Y (279 prints), CLI-42PC (269 prints), 
CLI-42PM (206 prints)

PGI-72C (452 prints), PGI-72M (685 prints), PGI-72Y (430
prints), PGI-72PC (346 prints), PGI-72PM (303 prints), PGI-
72R (1,000 prints), PGI-72CO (Chroma Optimizer, 181 prints)

T7602 (C), T7603 (M), T7604 (Y), T7605 (Light Cyan), 
T7606 (Light Magenta)

Cartridge capacity 13 ml 14 ml 25.9 ml
Price per ISO print2 $0.38 $0.46 No ISO/IEC 29102 data available
Results and Ratings
Power consumption 0.42 W (off), 1.2 W (standby), 16 W (print) 0.45 W (off), 1.3 W (standby), 16.4 W (print) 0.3 W (off), 1.4 W (sleep), 4.8 W (standby), 18.7 W (print)
Noise level 38.5 dB(A) 33.9 dB(A) 38dB(A)
Color deviation (ΔE) Minimal: 0.7 (average: 6.1, max.: 29.3) Minimal: 1.0 (average: 6.5, max.: 30.9 Minimal: 0.5 (average: 6.2, max.: 24.9
Text / Graphics printing + / + ++ / ++ ++ / ++

Photo print Color / Normal paper / B+W ++ / - / + ++ / + / ++ ++ / ± / ++

CD labels + ++ +

Color permanence Photo-/ Normal paper + / ± ++ / + ++ / ++

Manufacturer’s guarantee 1 year 1 year 1 year
Current price $400 $700 $770
1 Manufacturer’s figures               2 6 x 4” prints made according to ISO/IEC29102, 29103

++ˇexcellent        +ˇgood        ±ˇsatisfactory         -ˇpoor        --ˇinadequate                                            vˇincluded            –ˇnot included                 n/aˇnot applicable c



94 c’t Digital Photography 21 (2015)

Martin Vieten

Risk-free Sharpening and

Contrast Enhancement
Without sharpening, digital images look dull and lifeless, with poor contrast and
low detail rendition. Every digital image is sharpened – either in the camera
immediately after shooting or later using dedicated tools on a computer.
Photoshop’s Smart Filter technology is one of the most versatile sharpening
tools available, and this article tells you all about how to apply it.



The unprocessed images that digital
cameras capture are innately quite dull

and often appear blurred. This is mainly
becasue the sensor can only capture
differences in brightness but cannot capture
color data. There are various ways to combat
this limitation, most commonly by inserting
red, green and blue filters in front of each
pixel, with half the pixels used to collect green
color data and the other half split between red
and blue. In order to create a full-color image
from the data thus recorded, the camera’s
firmware (or a computer-based raw converter)
has to interpolate the full range of color data
for each pixel from that contained in the
surrounding pixels, and the rounding errors
involved in this process affect image
sharpness.

The rules of optics are also partially
responsible for variations in image sharpness.
A lens can only reproduce points that lie on

the plane of focus with absolute sharpness,
and the farther a point lies from the plane of
focus, the less sharp it will appear in the final
image. However, the ability of the human eye
to resolve sharpness is limited, so a slight lack
of sharpness in details that are close to the
plane of focus is not usually visible. This
means that the plane of focus is effectively
transformed into a kind of three-dimensional
focal space which is usually referred to as the
“depth of focus” or “depth of field” in an
image. How far this zone stretches in front of
and behind the plane of focus depends on a
number of factors, the most important of
which is the aperture setting – the smaller the
aperture, the greater the depth of field. The
physics of light causes ‘refraction blur’ where
light rays hit the edges of the aperture
opening and prevent depth of field from
stretching to infinity. This limits the optical
resolution of the system in question, thus

reducing its effective (i.e., perceived)
sharpness. Chromatic aberrations, another
important factor affecting image sharpness,
are caused by the variations in refraction
produced by the lens for differing
wavelengths of light. Fringing effects at
high-contrast edges result, and these are
often more pronounced at the edges of the
frame than in the center. For completeness’
sake, we also need to mention the motion blur
that occurs when the camera or the subject
moves during an exposure. 

Sharpening can be performed either
directly in the camera or later using
computer-based image processing software
such as Adobe Photoshop. The latter method
offers two significant advantages over the
former. The first is Smart Filter technology,
which enables you to apply non-destructive
adjustments to your images (i.e., you can alter
or reverse your changes at any time), and lets
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you limit sharpening to precisely selected
image areas too. ‘Optimum’ sharpening is a
matter of taste, and only the photographer
can decide how much or how little to sharpen
a photo.

Shooting raw is the best way to maximize
your sharpening options. If your camera has
no raw capture option or if shooting raw is too
complex for you, you can make things easier
by limiting the processing effects your camera
applies automatically. Select a neutral image
style and, if the option is available, reduce 
the amount of automatic sharpening in the
camera menu. You can always sharpen an
image later but you cannot undo
oversharpening applied by the camera during
a shoot. 

Raw image files require three sharpening
steps, whereas JPEGs require only two. The
initial sharpening of a raw image that takes
place during conversion in Adobe Camera Raw
(ACR) or Lightroom doesn’t apply for JPEG files.
Both programs automatically sharpen images
during conversion, and although you can

regulate the effect, you can’t switch it off
completely. 

In the Detail panel in ACR, set an Amount
value of 50-80 (the default value of 25 is too
low for most subjects) and leave the Radius
value at its default 1.0. The Detail slider
improves the overall sharpening effect, while
the Masking slider is used to determine which
image areas are left untouched by the settings
you apply. Keeping the Alt key pressed while
you move the Masking slider reveals precisely
which areas will be affected. 

Chromatic aberrations can be eliminated
using the tools in the Lens Corrections panel.
Select the Color tab and check the Remove
Chromatic Aberration option before
shift-clicking ‘Open Image’ to hand your file
over to Photoshop as a Smart Object. In
Lightroom, use the Photo > Edit In > Open as
Smart Object in Photoshop command to
achieve the same thing.

The next step (the first step for JPEG files)
involves sharpening your subject to taste 
and, if necessary, altering microcontrast. The

workshop sections starting on page 98
explain in detail how to perform these steps.
Once this is done, you need to sharpen your
image for monitor viewing or print output. To
create a copy in Photoshop, use the Image >
Duplicate command and check the Duplicate
Merged Layers Only option in the dialog that
follows. Reduce the duplicate’s resolution
using the Image > Image Size command (for
example, 10 x 7 inches at 300 ppi for prints or
1920 x 1280 pixels and 96 ppi for presentation
on a computer monitor). Generally accepted
rules of thumb for sharpening using the Filter
> Sharpen > Unsharp Mask tool involve
setting an Amount value of less than ppi/2
and a Radius setting of ppi/200. In other
words, if you wish to print an image at 300 ppi,
set Amount to 150% and Radius to 1.5 pixels.
The equivalent settings for viewing on a
standard 96 ppi monitor are 50% and 0.5
pixels. Always set the Threshold value as low
as possible and only increase it if your
sharpening settings produce obvious noise or
other artifacts. (tho)
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To achieve their effects, most sharpening tools increase the
contrast at detail edges, thus emphasizing the contrast between
light and dark elements. In Photoshop and other popular image
processing programs, the most common way to do this is using
the Unsharp Mask tool, which emulates an analog darkroom
technique that subtracts a blurred copy of the image (or selected
image details) from the original. In other words, the process of
sharpening is really a local manipulation of tonal values that makes
details seem sharper rather than actually adding image data. 

The Photoshop Unsharp Mask tool offers Amount, Radius and
Threshold settings. The Amount value determines the percentage
by which edge contrast is to be increased, the Radius value
(denoted in pixels) regulates the width of the area in which
contrast is increased and the Threshold value is used to determine
the degree of edge contrast that is necessary for a detail to be

included in the sharpening process. The most obvious
disadvantage of this approach is that it produces additional light
or dark fringing artifacts. This effect can be reduced by using a low
Radius value and a high Amount setting. Other existing artifacts,
such as noise, are emphasized by additional sharpening, although
these can be attenuated by using a higher Threshold value. The
only disadvantage in this case is that fine image details are no
longer sharpened along with the rest of the image.

For everyday sharpening purposes, we recommend that you use
relatively high Amount and low Radius values. The reverse – using
a low Amount value of 30-50 and a high Radius value of 25-40
increases microcontrast in a similar way to the Clarity sliders in
ACR and Lightroom. A second application of the Unsharp Mask
filter using these kinds of settings often makes an image
noticeably sharper.

How Does Sharpening Work?

Sharpening an image involves
increasing contrast at the edges
of details (right) and makes 
the new version of the image
appear sharper than the
original. The downside of this
process is that it often produces
visible fringing artifacts.
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Using Unsharp Mask as a Smart Filter

1⎢How to use Smart Filters: Open your file using the File > Open as
Smart Object command or, if it is already open, convert it using the
Filter > Convert for Smart Filters command. In Adobe Camera Raw
(ACR), click the ‘Open Object’ button at bottom right of the program
window. If the button is labeled ‘Open Image’, press the shift key to
convert its action to ’Open Object’ before clicking it. To open a file as
a Smart Object from Lightroom, use the Photo > Edit In > Open as
Smart Object in Photoshop command. Smart Objects can be
identified in the Photoshop interface by the icon at the bottom
right-hand corner of the thumbnail in the Layers panel (see the
screenshot on the right).

It is essential to check image sharpness at 100% magnification, as one
pixel in the original file is then equivalent to one pixel on the monitor.
To switch to the 100% view, either double-click the Zoom tool icon at
the bottom of the toolbar or use the Ctrl+Alt+0 shortcut. If you are
using an ultra-high-resolution monitor, use the Ctrl++ keystroke to
switch to a 200% view. To view the entire image, use either Ctrl+0 or
double-click the Hand tool.

2⎢Accentuate details: Begin by accentuating the finer details in your
image. In our sample image these are the roof tiles and the textures
in the plaster on the house walls and the wooden beams. Use the
Filter > Sharpen > Unsharp Mask command to open the Unsharp
Mask filter and set a Radius value of less than 1 pixel with a high
Amount value (in our example 330%) to achieve extremely finely
nuanced results.

The Threshold slider determines the fineness of the details that are
affected by the sharpening process. Increase the value as far as you
can without producing additional visible noise. In our example, a
value of 2 produces the best result.

The preview image in the tool window shows a center detail by
default, but you can move the image around by dragging it with the
Hand tool that automatically appears when you move the cursor over
the preview image.

Sharpening at the post-processing stage is all about increasing
visual sharpness without creating additional artifacts such as
halos or noise. It is always a good idea to apply Photoshop
filters as Smart Filters, as this enables you to adjust or undo an
effect at any time, while masks and blend modes give you a
wide range of options for fine-tuning your effects and applying
them to selected areas only. Smart Filter technology has been
available since the release of Photoshop CS3 and the
screenshots here were made using Photoshop CC 2014.



99c’t Digital Photography 21 (2015)

Sharpening in Photoshop | Image Processing

3⎢Improve microcontrast: Our sample image was captured in very
diffuse light and shows little contrast as a result. To improve this
situation, we used the Unsharp Mask filter again. In this case, we set 
a low Amount and a higher Radius value. The Screenshot shows the
50% and 30-pixel settings we used.

To better judge the results of your changes, switch the preview image
off. This returns the main image window to its original state so that
you can compare it directly with the preview in the filter window. 
This clearly shows how strongly image contrast is increased. The
downside of this effect is that it reduces detail sharpnes in the
highlights (in our sample image, at the bright edge of the marquee).
The word ‘Libraire’ is now surrounded by a bright fringe that didn’t
exist before. But never fear – we will tackle these issues later on. For
now, click ‘OK’ to continue.

4⎢Switch the blend mode: Our contrast correction has already achieved
the right basic result, and only the highlights still look a little too
‘hard’. The image would look better if we could apply our sharpening
effect to the shadows and midtones too. To achieve this, double-click
the blending options icon at the right-hand end of the Smart Filter
entry in the Layers panel and switch Mode to Darken. This makes the
highlights softer but emphasizes the shadows, which lose detail as a
result. To counteract this, reduce opacity to 75% and check your
results by unchecking the preview box.

5⎢Enhance brightness: Shadow brightness, contrast and sharpness
are now well balanced, but the highlights could still do with a
touch more sharpness – just not as much as in step 3 above,
before we changed the mode of the Smart Filter layer. To do this,
re-open the Unsharp Mask filter (use the shortcut Ctrl+Alt+F to
speed things up) and apply the same values as before, but this
time switch Mode to Lighten and opacity to 25% to ensure that
the effect is only applied gently to the highlights.

The last two layers we created enable us to apply the Unsharp
Mask filter separately to the shadows and highlights. When
performing this type of adjustment, it is better to use opacity
settings on the Smart Filter layers that don’t exceed 100%. Lower
values are generally less critical.
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6⎢Optimize your settings: Our image now has three
separate Unsharp Mask layers, with the most recent at
the top of the stack. If you haven’t yet achieved the
result you are looking for in your own image, you can
always experiment with the opacity and mode settings
in all of your Smart Filter layers. In our example, there is
still too much noise and there are too many sharpening
artifacts. We combated this by reducing the opacity of
the bottom layer (i.e., the basic sharpening layer) to 66%.

7⎢Enhance contrast and sharpness: You may find that
your image still shows some unwanted side effects in
spite of all your attempts at balancing the highlight and
shadow effects of the Unsharp Mask filter. In our
example, the word ‘Libraire’ still has a bright fringe. To
counteract this type of effect, you have to selectively
reduce the sharpening effect in the areas where it
produces unwanted artifacts. To do this, click on the
(white) Smart Filter thumbnail and select a black brush
either in the toolbox or by pressing the B key. We set the
brush size to 30 pixels and set Hardness to 25% and used
it to mask the affected areas of the marquee. You can
adjust any other problem zones in your image in the
same way. 100% black areas in the mask completely
suppress the effect of the filter, whereas reducing the
mask’s Density in the Properties panel attenuates the
effect while keeping it visible.

8⎢Reduce noise levels: Sharpening tends to accentuate
noise, especially in high-ISO images. If this is the case,
you need to denoise your image too. Open the Filter >
Noise > Reduce Noise dialog and make the following
settings: Strength, 10; Preserve Details, 25%; 
Reduce Color Noise, 0%; Sharpen Details, 0%. Here too,
you can attenuate the effect of the new filter by reducing
its opacity.

Quick Tip: In Photoshop CS6 and later versions, Camera
Raw can also be used as a Smart Filter (Filter > Camera
Raw Filter), which makes it much easier to reduce image
noise. 
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An Easy Way to Apply Selective Sharpening

1⎢Apply the Smart Sharpen filter: Begin by
sharpening your image the normal way and, if
necessary, transform it into a Smart Object (Filter
> Convert for Smart Filters). Now navigate to
Filter > Sharpen > Smart Sharpen. Unlike the
Unsharp Mask window, the size of the Smart
Sharpen window can be adjusted to give you a
large preview image that is easier to work with.
By default, the preview image is displayed at
100% magnification. Select Lens Blur in the
Remove drop-down menu, set an Amount value
of 320% and set the Radius to 0.7 px. Instead of a
Threshold slider, Smart Sharpen has a Reduce
Noise slider which we set to 25% in our example.

2⎢Improve contrast: To improve the contrast in
your sharpened image, open the Smart Sharpen
filter again (Ctrl+Alt+F) but this time, set the
Amount to 50% and the Radius to 30 px. These
settings accentuate the highlights too much, but
you can counteract this effect directly within the
filter dialog using the additional
Shadows/Highlights sliders. To protect the
darkest shadows from the effects of the filter, set
Fade Amount to 9%, Tonal Width to 20% and
Radius to 1 px. More importantly, you need to
adjust the highlight effect. For our sample
image, we set values of 40%, 30% and 25 px.

3⎢Compare your results with the original: To
check the effect of a Smart Filter, click the eye
icon in its Layers panel entry to toggle it on and
off. Photoshop takes quite a while to apply Smart
Sharpen adjustments, so subtle adjustments
aren’t always immediately obvious. Once again,
you can lessen the effect of any Smart Filter layer
by reducing its opacity. This is often a lot simpler
than readjusting the filter settings.

The best way to achieve balanced sharpness and contrast corrections is to adjust
shadows and highlights separately. Thanks to Smart Filter technology, even
old-school filters like Unsharp Mask can be selectivey applied. The Smart Sharpen
filter in the CC version of Photoshop works even better than its earlier iterations. 
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Martin Schwabe

Tweak Your Canon DSLR with

Magic Lantern
Focus Stacking, Trap Focus and Magic Zoom are all features that some Canon
cameras have but that you can’t use unless you unlock them using the free Magic
Lantern firmware add-on. A clever piece of software that incorporates a host of
additional photo and video functions for a range of Canon DSLRs (and the mirrorless
EOS M), it is simple to install, use and uninstall. This article explains how.

Have you ever been annoyed to discover
that some of the features built in to

your Canon DSLR have been disabled by the
manufacturer for some inexplicable reason?
Well fret no more! A group of clever
programmers has discovered a back door
unintentionally left open by Canon’s
engineers that makes it possible to enhance
your camera’s feature set to include
functions it was never intended to have. 

You can even inject your own code into 
your camera’s firmware, and one of the
developers associated with the group has
created a module that enables you to play
Arkanoid on your camera’s monitor as the
hours tick slowly by when you’re out on a
wildlife shoot.

This may all sound like a lot of fun, but it is
actually highly professionally organized.
Models such as the EOS 5D Mark II and the EOS

7D with Magic Lantern installed are often used
to shoot pro-grade video in spite of the bugs
and other faults in the original camera
firmware. Increasing numbers of camera rental
companies are installing the latest version of
Magic Lantern in all their compatible EOS
cameras. Thousands of adverts and TV shows
have now been shot using camera equipped
with the software. Read on to find out why it is
so successful.
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Magic Lantern is often referred to as a hack,
although this is not a strictly accurate
description. Unlike the early hacks out of
Russia that completely replaced the original
firmware in the EOS Digital Rebel/300D, Magic
Lantern utilizes a dormant interface to load
additional code into the camera’s RAM and
run it parallel to the installed firmware. 

The additional features and functions are
saved on a memory card and loaded the same
way as a firmware update, although they are
written to the camera’s RAM rather than its
ROM. This subtle difference means that:

1. The existing firmware is not altered and
the camera can be used normally, even when
Magic Lantern is installed.

2. Magic Lantern can be completely
uninstalled without leaving a trace and, if
used properly, won’t damage the camera in
any way. But be warned: the software is not
approved or endorsed by Canon in any way,
and using it will probably void your warranty.
If damage occurs, you alone are responsible. 

In spite of its many benefits, Magic Lantern
has drawbacks too, chief of which is that it
only works with the specific camera model
each version was designed for. Hard- and

software for new models with new signal
processors have to be analyzed and new
versions of the corresponding software
written by willing developers. Additionally,
the required interfaces have to be located and
analyzed to find out if they can be exploited
the same way as previous versions. This
development process can take up to a year.
There is still no final version of the software for
EOS 7D, with its twin signal processors, even
though the Magic Lantern team has been
working on it for more than three years.

Before You Begin

It is essential to check that your camera is
running the firmware version Magic Lantern
was written for. If you attempt to load the
software with the wrong firmware running,
the installation will either simply not work or
crash and leave your camera in an undefined
state that you can only rectify by switching it
off and removing the battery. This flushes the
camera’s RAM and removes any traces of the
failed installation. 

The software is available in stable releases
and nightly builds for many of the supported

cameras. Stable releases are generally highly
reliable, whereas nightly builds (equivalent to
software beta versions) include new code and
features that have not yet been thoroughly
tested and can cause problems during
everyday use of the camera.  

Alpha builds are early releases that often
include just a few basic functions or
sometimes only a test pattern to check that
the appropriate interface can be addressed.
They can be dangerous to install if you are an
inexperienced Magic Lantern user, so handle
them with great care.

Compact Install

Once you have decided whether to run a
stable release or a nightly build, you can save
the corresponding ZIP file to your memory
card. The filename includes the camera
model, the version number and the date of
the build. The software only requires about
two megabytes of disk space so if you own
multiple supported cameras, you can load
the software for all of them onto a single
memory card.

Camera Tweaks | Magic Lantern

What is Magic Lantern?

Although Magic Lantern utilizes the
same firmware exploit as the CHDK
(Canon Hacker Development Kit)
compact camera hack, it is an
independent project specially
designed for use with Canon EOS
DSLRs and the mirrorless EOS M
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Depending on which camera you use, you
need to prepare an SD or CF card for use with
Magic Lantern. If possible use a freshly
formatted card with no more than 32 GB of
memory, as larger cards sometimes have
issues installing the software.

The rest of the procedure is a simple case
of copying the contents of the Magic Lantern
ZIP file (including the ‘ML’ folder) to the root
folder of your memory card, charging your
camera battery, switching the camera to
manual (M) mode and powering it up. 

To continue, navigate to your camera’s
‘Firmware’ menu and continue as you would
when installing a normal firmware update. The
camera looks for a suitable file with the FIR
filename extension and outputs an error
message if it cannot find one. 

Shortly after the update procedure starts,
the camera monitor goes black briefly and

then displays a message that the memory card
is now bootable. 

This part of the process is necessary to
enable the camera to load Magic Lantern into
its RAM every time it is switched on without
having to reinstall the software manually.
After about 30 seconds, the SUCCESS
message should appear in green type. The
camera then displays messages telling you
that the required files have been found and
that a BOOTDISK flag has been enabled. This
is the critical part of the mechanism that
allows you to ‘hack in’ to the camera’s
internal software.

To complete installation, restart your
camera. Magic Lantern is now available
whenever you use M, AV, Tv or P modes. The
software is automatically deactivated (but not
uninstalled) if you select one of the camera’s
creative auto modes. Once you have taken

these steps, you can duplicate the card, and
the software will work on cards with more than
32 GB of memory.

Uninstalling Magic Lantern

If you press the ‘Q’ (Quick Control) button
while formatting your memory card, the
displayed message switches from “Format
Card, keep Magic Lantern” to “Format Card,
remove Magic Lantern”. Confirming this action
by pressing ‘OK’ deletes all data from the
memory card, deactivates the boot flag and
removes Magic Lantern from the camera’s
RAM. At the next restart, the camera is restored
to its original state. 

It is always a good idea to uninstall 
the software if you have to send your camera
to an authorized dealer for repairs or
maintenance. 

Magic Lantern Availability

Nightly builds that incorporate the latest
changes to the main branch are available
on a rolling basis for most of the models
listed above.

Stable releases are no longer freely
available from the project website, but a
quick Web search for ‘Magic Lantern stable
release download’ reveals a multitude of
links to live sources.

All official downloads are available from 

http://builds.magiclantern.fm/#/

As well as the latest nightly builds, the
download page offers earlier versions that
have fewer features but are more stable. The
official project forums are a great source of

information on the latest features and their
stability:

http://www.magiclantern.fm/forum/

Facebook users who ‘like’ Magic Lantern
receive regular updates on the latest
project developments.

The following cameras were supported as we went to press: 
EOS 5D Mark II 
EOS 5D Mark III
EOS 6D
EOS 7D
EOS 50D 
EOS 60D

EOS Rebel T1i/500D 
EOS Rebel T2i/550D 
EOS Rebel T3i/600D 
EOS Rebel T4i/650D
EOS Rebel T5i/700D
EOS Rebel T3/110D
EOS M

Installing and Uninstalling Magic Lantern
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The Expo menu covers all major exposure 
parameters. The settings vary in their 
precision and granularity depending on 
which camera you use. In some cases, the 
software extends the range of operation 
of selected functions.

The individual tabs 
group functions 
according to themes

Each tab 
incorporates up to 
twelve separate 
functions

The additional notes at the 
foot of each tab provide 
information on its functions 
and how to operate them

These icons give you an 
overview of the current 
status of each function.

Menus and Nomenclature

The Display tab is where you can 
configure the monitor display and the 
behavior of the framing and composition 
overlays. Most of the settings are 
designed for use in Live View mode. The Audio tab enables you to fine-tune 

the camera‘s audio capture parameters. 
This function is most powerful when used 
with an external stereo microphone.



When you restart your camera following
installation, it will display the normal start
screen. After about 1 second of boot time,
additional Magic Lantern messages appear at
the foot of the monitor. These include the
remaining battery power (expressed as a
percentage rather than Canon’s vague bars),
a clock (which is more useful than you may
think) and the space remaining on the
memory card (expressed in gigabytes rather
than the number of remaining shots).

The software makes no changes to the
Canon menu system and the Magic Lantern
menus are called up by pressing the ‘Erase’
button, which you would not normally use
except in an image playback context. To
switch back to the camera’s own menus,
simply press the ‘Erase’ button again.

To squeeze as many items and as much
subsidiary information as possible into the
software’s menus, the developers sometimes
use much smaller typefaces than the familiar
Canon ones, but once you know which menu
items control which functions,  you are sure to
find that you can navigate mostly on
‘autopilot’ without having to actually read
every menu entry.

The Magic Lantern 
Menu System
The top row of the Magic Lantern menu
consists of icons similar to those found in the
conventional Canon menus, which denote
tabs with themed groups of functions. The
tabs are labeled Audio, Expo (exposure),
Overlay, Movie, Shoot, Focus, Display, Prefs,
Debug and Help. 

The main part of the display is taken up by
the individual menu items, and each tab
contains up to 12 items. The foot of the
display is used to provide additional
information and tips for the currently selected
item. The left-hand side of the monitor is
taken up by a row of icons that denote the
current state of the items in the menu. A
green dot means a function is switched on,
bars like the signal strength display in a
mobile phone show the current setting level
for adjustable functions and arrows indicate
the presence of sub-menus. The icon system
is generally quite simple to use and is largely
self-explanatory.
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Overlay is for users who take the setup of 
their photos seriously. The tools on offer 
include extremely precise histograms, 
ghost images to aid alignment and 
various visual focusing aids.

The Focus tools include functions like 
Trap Focus and Follow Focus that are sure 
to be of just as much interest to 
videographers as stills photographers

The Debug tab is full of tools to help you 
develop your own modules or test other 
people‘s beta modules

Prefs includes all the basic settings for the 
software itself, including power saving,
button configurations and menu 
customization

Shoot regulates automatic shutter release 
via audio or motion detection as well as 
time-lapse settings and advanced 
bracketing, giving you plenty of options 
for getting really creative
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To ensure that the Magic Lantern
commands don’t interfere with functions
already controlled by the camera’s buttons, its
handling is not like the conventional Canon
system. Additionally, because it is available for
a wide range of cameras with varying menu
systems, Magic Lantern functions differently
from model to model.

The Main Dial, Quick Control Dial and
Multi-controller are the backbone of the
system. Once you have had a little practice,
they make it quite simple to use.

The menu items themselves function in a
similar way to the camera’s own options. Some
can only be switched on and off while others
have a range of settings. Some functions also
have wide-ranging sub-menus with additional
user-controllable options. Menu items with
sub-menus are indicated by an arrow icon to
the left of the item description. To enter a
sub-menu, simply press the ‘Q’ button. The
sub-menus themselves work the same way as
the main menus. 

Keeping Track of Your Settings

The Magic Lantern menus and functions are
extremely comprehensive and offer many more
options than the camera’s own system. Because
many of the available functions override the
camera’s native settings, you need to think
carefully about which functions you really need.
If you are testing a particular function, it is always
a good idea to switch it off immediately you
have finished testing – otherwise, you will
quickly lose track of the functions you have
activated and the settings you have made.

Once you have spent a while
experimenting, you are sure to find a range of

Magic Lantern settings that you would like to
activate permanently as part of the basic
configuration. To do this, switch the Config file
option in the Prefs tab to Save config now. The
same configuration will be loaded next time
you power up your camera (provided, of
course, that you use the same memory card).
You can use this function to save different
configurations to multiple memory cards – for
example, to optimize the setup on one card for
capturing video and on another for stills.

How to Get Help

Most versions of Magic Lantern have a
comprehensive built-in user guide that you
can access either by navigating to the Help 
tab or by hitting the INFO button with the
appropriate menu item selected. The Key
Shortcuts item in the Help menu offers a
complete list of all the functions controlled by
the camera’s buttons when Magic Lantern is
installed. This list covers all supported camera
models. 

Live View

Magic Lantern significantly alters the Live View
display and uses all the available screen space
to provide permanent displays of a number of
major camera functions.

The uppermost line of data includes the
clock, the monitor brightness setting, the file
format and the amount of memory remaining,
while the lower display offers a number of
items that are much more useful than those
included in the normal Canon Live View. The
current focal length and shooting mode (P, Av,
Tv or M) are also displayed . Colored entries for

the exposure time, aperture and ISO setting
makes them much easier to read than the
usual view. The white balance display includes
a colored digit to indicate any compensation
values you have dialed in, and the subject
distance display is much more accurate and
precise than the Canon version. To use the
focal length and subject distance displays, you
will need a lens with a CPU.

In Live View mode, Magic Lantern’s greatest
strength lies in the options it offers for the 
Live View image itself. The Display tab offers a
huge range of functions and settings to aid
manual focusing, setting the right exposure
parameters and even image composition.

Using ‘Zebras’

The ‘zebras’ are another really useful Magic
Lantern feature. When it is activated,
diagonally striped shading indicates
potentially under- or overexposed image
areas. You can set the color of the zebra
display and the threshold value at which it
kicks in. You can also opt to display a
histogram with clipping warnings for the
separate RGB channels – i.e., when colors tend
toward oversaturation. The built-in spot meter
can be set to take readings for a user-defined
area.

As well as helping you to set the correct
exposure, Magic Lantern offers a number of
visual focusing aids. The Focus Peak display
uses high-contrast lines to indicate the parts of
the image area that are in sharp focus and, if
the lens you are using has its own built-in
motor, you can use the arrow keys or the
multi-controller to set focus manually without
touching the lens.

Magic Lantern enables you to add
various overlays to the Live View display.
These include comprehensive status
messages, a permanent histogram and
an extremely effective zoom/magnify
tool that appears in a separate on-screen
window.
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The idea behind focus stacking is simple and
really effective: instead of capturing a single
image with limited depth of field, you capture
multiple images with different focal points
and combine them to produce a single image
with extended depth of field. All you have to
do is select the distance at which you wish the
focus sequence to begin and end and set the
number of exposures you want it to contain.
The result is a sequence of images in which
the plane of focus shifts slightly between
shots. Obviously, this technique only works for
stationary subjects photographed using a
tripod-mounted camera. 

To shift focus between shots, you can 
use either a macro rail to shift the entire
camera/lens combo (the lens is switched 
to manual and the focus setting remains 
the same throughout) or adjust focus
manually using the focus ring. The focus 
ring method is not terribly accurate, so you 
will need mechanical assistance for it to
work properly.

One way to do this is to connect your
camera to a computer and use the EOS Utility
software that is supplied free with all Canon
DSLRs, which enables you to adjust focus in
predefined steps using the mouse. This is a
fine solution for use in a studio environment
but is not practical when you are out and
about.

Magic Lantern’s 
Stack Focus Function

The Stack focus option in the Focus tab
provides a set of useful tools for automating
the focus stacking process without using a
computer or any kind of remote release.

The two main menu items required for
focus stacking are Focus End Point and Stack
focus (see the illustrations on the right).
Although the built-in user guide is a little
vague regarding this function, the steps
involved are actually quite simple. 

Use the viewfinder to set up and prefocus
your camera so that the subject distance and
angle of view suit the subject, the focal length
you are using and the magnification you wish
to capture. 

To ensure satisfactory results, it is essential
to keep the aperture constant throughout the

sequence. Alterations to the exposure time
have little effect on the results when you 
are shooting static subjects, so using Av
(aperture-priority) mode is the best way to
ensure consistent exposures. Set ISO to a fixed
value (deactivate Auto ISO) and, to prevent
color discrepancies between shots, make sure

that the WB (white balance) setting remains
constant too. 

Once you have everything set up, switch to
the Focus tab in the Magic Lantern menu.  Use
the Multi-controller or the arrow buttons to
select the Stack focus option and press the ‘Q’
button to open its sub-menu. 

Focus Stacking
Macro photography gives you insights into fascinating and almost endless worlds
of new and exciting subjects. However, all macro photographers have to deal with
extremely shallow depth of field, a problem that can only be moderately alleviated
by stopping the aperture down. Magic Lantern’s Stack Focus function provides a
useful solution to this well-known problem.

Use the arrow buttons in the Multi-controller to set the Focus End Point. It doesn’t
matter if you set a rough value that overshoots the exact end point a little.

Sub-menus are opened by pressing the ‘Q’ button and work the
same way as main menus



The Step Size option determines the size
of the focus increment between shots and
offers values between 1 and 10. The value
you select here also determines how many
shots your sequence will contain. We found
that values between 5 and 8 provide a good
compromise between image quality and the
number of  images required to complete a
sequence.

Trigger Mode determines which button
you use to start the sequence – the Take a
pic option means using the shutter button.
This option makes sense if you are using a
remote release, whereas Press Play is a better
choice if you want to start the sequence by
hand, as the Playback button’s position
reduces the likelihood of causing unwanted
camera shake when you press it. Press the
‘Q’ button again to save your settings. The
zero in the message “will take 0 pictures“
changes to a number once you have defined
a focus end point.

To get things rolling, you have to select a
start point by selecting an appropriate AF
point in the Live View image of your subject.
You can then call up the Focus End Point
function (still in Live View), whereupon
Magic Lantern hides all text except the line
“Focus End Point: 0 steps from here.” Now
use the arrow buttons or the Multi-controller
to shift focus until it reaches your desired
end point. You don’t have to land exactly at
your designated end point; a little overrun
doesn’t do any harm. The monitor readout
increases according to the number of focus
steps you have entered (see the upper
illustration on page 109). Press SET to
confirm your settings.

Once you are done, all that remains is to
press the Playback button. The number of
images the camera captures matches the
number of steps to the focus end point.

Stacking the Results

To stack the images you have captured, you
can either use free stacking software such as
Combine ZP or a commercial program like
Photoshop. In Photoshop, load your images
using the File > Scripts > Load Files into
Stack command and use the Edit >
Auto-Align Layers command to eliminate
any inconsistencies that may have arisen
from the changes in focus distance. Finally,
execute the Edit > Auto-Blend Layers
command to merge your source images. The
blending process can take anything from a
few seconds to several minutes depending
on the number of source images and the
speed of your computer. You can then crop
the final image as necessary and save it to
the location of your choice.
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Our stacked source images produce an image with
depth of field that covers almost the entire subject –
an effect that is impossible to achieve in a single shot

Our focus sequence begins at the tip of the closest petal ...



111c’t Digital Photography 21 (2015)

... we reach our predefined focus end point... and shifts rearward with each shot until ...



The photo enthusiasts among Magic Lantern’s
developers have implemented a number of
tools that simplify manual focusing, allowing
you to capture more in-focus shots. Some of
these can be used in conjunction with the
viewfinder or Live View, whereas additional
data displays mean that others only work in
Live View mode.

Trap Focus

Many cameras have a focus priority autofocus
setting that allows the shutter to release only
if the subject is in focus at a preselected AF
point. Trap Focus works on a similar principle.
However, conventional focus-priority AF
allows the camera to actively search for focus,

so you cannot control the distance at which
focus locks and the shutter releases.
Theoretically, you could set focus manually to
a preset distance and wait until your subject
appears sharp in the viewfinder, but this is
difficult to execute and doesn’t guarantee
in-focus results.

To use Trap Focus, all you have to do is
set focus manually to the required distance
and press the shutter button. The camera
then fires the shutter when the subject is in
focus at the preset distance. This works by
either moving the camera toward the
subject or allowing the subject to approach
the camera.

In addition to Off, the Trap Focus menu
also offers Continuous and Hold AF button
options. The first of these makes the camera
shoot continually the moment focus is
achieved and without the photographer
having to intervene. The second requires you
to press the shutter button halfway (or press
the * or AF-ON button, depending on how
your camera is set up). As soon as the camera
registers focus at the preset distance, it fires
the shutter once.

Trap Focus can be used with any lens that
can be focused manually, whether it has its
own CPU, no CPU or an AF confirm adapter.
Note, however, that it works with any type of
lens in Live View mode but cannot be used
with fully manual lenses if you are using the
viewfinder. Lenses with AF confirm adapters
work fine in viewfinder mode.

Remember to deactivate Trap Focus at the
end of your session. If you forget, you will
probably end up wondering why your camera
shoots apparently at random the next time
you are out taking photos.

Focus Peak

All of the functions described so far leave the
final assessment of subject sharpness to the
camera. Depending on the AF points and
the AF mode you select, you can specify the
point you want to focus on more or less
precisely, although the AF points are often
not located exactly where you need them. In
Live View mode, the focus area is often
larger than the area covered by the subject.
You can also focus manually in Live 
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Trap Focus, Focus Peak and Magic Zoom

Focus stacking requires patience, a stationary subject and an autofocus lens. The manual
lenses, bellows units and reversing rings often required for macro photography make
automated focus stacking impossible. But never fear – Magic Lantern has solutions for
situations like these too.

In this shot, the shutter fired the moment the beetle’s head reached the preset focus point

Trap Focus makes it possible to focus precisely on moving subjects. The shutter is released
automatically at the moment of maximum sharpness and reacts much faster than a human can.



View, although it is extremely difficult 
to focus precisely with the monitor as your
only guide. 

The Focus Peak function (located in the
Overlay tab) aids manual focusing by
assessing contrast within the frame and
displaying blinking dots where the subject 
is in focus so that you can precisely select 
the point at which you wish to set focus. The
fact that the function also displays all other
in-focus points is a useful side effect.

The Focus Peak sub-menu contains
Method, Threshold and Color options. Method
determines the algorithm used to
distinguish in-focus areas from the rest of
the frame. The  1st deriv. option is optimized
for low light situations and noisy images,
while 2nd deriv. works better in normal light.
Threshold defines the percentage of pixels
(between 0.1 and 5%) that have to be in
focus for the peak display to kick in. Color
does just what it says and alters the color of
the peak display to help you keep it visible
against different-colored subjects. The
Grayscale img option switches the monitor
image to black and white, which makes it
easier to see the focus peak display against
brightly colored subjects.

We recommend using a tripod when you
use Focus Peak, as it is virtually impossible to
keep the camera still enough to focus
manually if you are shooting handheld.

Magic Zoom

Canon’s own zoom function displays an
enlarged detail that fills the entire monitor, so
you cannot see the non-enlarged parts of the
frame while you zoom. This makes shifting the
enlarged detail while zoomed a hit-and-miss
affair. Additionally, exposure metering is
switched off while the image is zoomed and
displays the values it recorded before zoom
was activated.

Magic Zoom (also located in the Overlay
tab) addresses these issues. Once you have
selected it using the SET button, press the ‘Q’
button to reveal the function’s options. 

Trigger mode determines which action
triggers the zoom display. Always on is a
great option for photographers. Zoom In (*)
triggers the function via the ‘Magnify’
button and Half Shutter when you press the
shutter button halfway. Focus Ring only
works with lenses that have a dedicated
focus ring. You can also adjust the size of the
zoomed detail and its position within the
frame. 

Focus Confirm
Magic Zoom includes a customizable focus
confirm signal. Split Screen emulates the 
split circle in the center of the focusing 

screen in analog reflex cameras. Green Bars is
self-explanatory. 

Focus Peak and other overlays are
deactivated while Magic Zoom is in use.
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Especially with brightly colored subjects, the blinking dots displayed by the Focus Peak
function are often easier to see if you switch the monitor image to grayscale. The photo
itself is nevertheless captured in color.

Among other settings, Magic Zoom can display a permanently magnified detail 
while still displaying the rest of the monitor image



An HDR image is constructed from a sequence
of source images that together cover the
entire dynamic range of the subject. Smart
software is then used to discard the parts of
each photo that are too dark or too bright and
merge the rest to create a single image with
extended dynamic range.

Canon cameras with DIGIC V and later
processors have built-in HDR functionality,
although it only has genuinely useful
user-controllable settings in more expensive
models like the EOS 5D Mark III and the EOS
7D Mark II. In general, the Canon function
captures HDR sequences with up to three
source images, which is often not enough to
produce smooth results.

Although it cannot actually merge the
source images, Magic Lantern’s HDR function
(located in the Shoot tab) is much more
flexible than the Canon version and can write
important parameters for the source images
to a script that can be read and executed by
the open source stacking software enfuse.

Using the Magic Lantern 
HDR Function
The HDR Bracketing Function is located at the
top of the Shoot tab. Its sub-menu (press ‘Q’
to open) comprises the following options:

Frames determines the number of source
images (2-9) and can be set to auto detect the
appropriate number via the camera’s
exposure metering system.

EV increment defines the difference in
exposure between shots in EV values from 0.5
to 5, where 1 EV is equivalent to 1 f-stop.

Sequence sets the sequence in which the
source images are captured following the
initial (correctly exposed) shot. You can
choose between increasing (0 + ++),
decreasing (0 -  --) or alternating (0 – + –– ++).
Alternating is best if you are shooting in P, Tv
or Av mode. The other two are intended for
use in M mode.

2-second delay delays firing the shutter to
allow the camera shake caused by pressing
the shutter button to dissipate.

ISO shifting is for use in M mode only. Off
means that only the exposure time is altered
while the aperture and ISO settings remain
constant. Half means that half the source

images are shot with varying ISO values and
the other half with varying exposure times.
Setting the Full option captures a sequence in
which only the ISO value changes.

Post scripts writes a script that can be used
to automatically merge the source sequence
using enfuse. There is also an option for
automatically aligning the source images
before merging.

Frames and EV Increment

Beginners tend to assume that more source
images means better results and end up
selecting too many frames for their HDR

sequences. In fact, having too many images
simply increases the amount of time and
computing power (and the number of
potential merging errors) required to merge
the sequence together without necessarily
providing more image data. The same is true
if you select EV increments that are too large.

If you assume your camera’s sensor has a
typical dynamic range of about 10 stops, you
can use the built-in exposure meter to
calculate the number of exposures and the
size of the EV increment required. To do this,
switch to Spot metering mode, meter for the
brightest and darkest points in your subject
and note the results.

Let’s look at an example. An evening
cityscape requires an overall exposure time of
15 seconds, while the brightest details (street
lamps, for example) require 1/500 second.
Doubling the exposure time increases the
overall exposure by 1 EV (i.e., 1 f-stop). Our
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High Dynamic Range (HDR) techniques come into play when the range
of contrast in a subject exceeds the dynamic range of the camera’s
image sensor. If you capture a conventional image of such a
high-contrast subject, some shadow and/or highlight detail will be lost.

HDR

This version is underexposed and shows good
highlight detail

This version is overexposed and displays sufficient
shadow detail
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sample scene therefore has a dynamic range
of 14 stops and cannot be adequately
captured in a single exposure.

To be on the safe side, you should
normally shoot with one extra stop of
exposure at each end of an HDR sequence,
so our sample scene requires a total
exposure range of 16 stops. Because our
camera’s sensor has a dynamic range of 10
stops, we need to shoot a sequence that
adds 6 stops of exposure. If we shoot using
an EV increment of 1, we need to shoot a
total of seven source images (the ‘correctly’
exposed image plus three under- and three
overexposed images) to be sure of capturing
the entire dynamic range of the subject. If we
increase the increment to 1.5, we only need
to shoot five source images.

Obviously, you need to switch off all other
variable shooting parameters such as Auto
WB, Auto Picture Style and ALO (Auto Lighting

Optimizer) to prevent exposure or color
discrepancies between shots. Once captured,
you can merge your source images using
Photoshop, enfuse or any other HDR-capable
software.

HDR Preview

Although Magic Lantern cannot yet merge
HDR source images, it can display an HDR
preview. To do this, navigate to the Prefs tab
and set the SET+Main Dial function to Exposure
Fusion. Now switch to playback mode, select
the first image in your sequence, press and
hold the SET button and select the next photo
in the sequence using the Main Dial. Repeat
this step for as many source images as
required. The monitor image shows a low-res
preview of the final merged image so you can
assess whether the sequence was successful or
whether you need to re-shoot it.        (keh)  c

If the camera’s hardware isn’t capable
of capturing the range of contrast in

the subject in a single image, the
solution is to capture multiple 

under- and overexposed shots and 
use HDR techniques to merge them

into a single well-exposed image
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George D. Lepp, Kathryn Vincent Lepp

Creative 

Panorama Techniques
George Lepp is renowned for his panorama expertise and specializes in
creating new and unusual forms of this fascinating photographic style. In this
workshop, he explains in detail the gear he uses and how he captures his
wonderful images. Read on to learn all about action sequence panoramas,
aerial panoramas, macro panoramas and more.
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While it may appear that this baboon was playing in the water as it crossed a wetland in Botswana’s Okavango
Delta, in fact it was attempting to avoid contact with the cold winter stream and whatever predator might be

lurking in it. Using every third frame of the 8fps capture sequence produced just the right distance between images
of the animal, while careful panning yielded an overlapping and stitchable background. The images were composited

using Adobe Photoshop and layer masks. Captured with a Canon EOS 7D and a 100-400mm lens set to 400mm.

Exposure for each of the seven images was ISO 250 | f11 | 1/750s

Those who photograph the grand views of
nature are always in search of ways to

convey this rich vision. Panoramic photography
is a useful tool for portraying the broader view,
but we can take it beyond the simple capture
and assembly of a brief sequence of horizontal
images that create a large, or long, photograph.
Innovative panorama techniques yield images
that tell a more complete, creative and
compelling story, with plenty of content that
engages the viewer for a longer time and
details that emerge as delightful surprises.
High-resolution composites and huge prints
demand fine compositional features and
meticulous capture technique if they are 
to stand up to close scrutiny. This article
presents a variety of advanced approaches 
to panoramic photography that will help 
nature photographers to communicate 

artistry, narrative and detailed information in
their images.

Action Sequence Panoramas

We are constantly pursuing worthy themes
for action sequence panoramas, which
convey a moving subject’s journey across
time and space. I discovered this unique
panorama technique completely by accident
while photographing a baboon crossing a
stream in Botswana, Africa. With the camera
firing an uninterrupted sequence of images at
8 frames per second, I followed the baboon’s
trajectory as it scampered and jumped
through the water while attempting to stay
dry and avoid whatever crocodiles might be
looking for a meal. At camp that night while
editing the days’ images, I noticed that the

baboon’s ‘water dance’ was perfectly
captured in the series and that I had held the
camera so level as I panned with the action
that each background overlapped; suddenly,
I saw a panorama. I used every third image to
create a composite that told the complete
story of the baboon’s water crossing. I later
found in my files a number of similar
sequences that, when composited into
panoramas, revealed much more about the
subject than any single image could. 

It’s important to make a distinction here
between an action sequence panorama and a
single-frame action sequence. The latter
typically involves mounting the camera on a
tripod, capturing a number of identically
framed images of a moving subject, then
compositing some or all of the images so that
the subject is shown in different positions
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within the frame. One might, for example,
compose an image large enough to
incorporate the complete arc of a
playground swing, photograph it repeatedly
as a child plays on it and then composite
images of the child in different positions in
the final image. The limitations of this
approach are the constant background, the
large frame needed to incorporate the 
range of movement and the resulting low

resolution and corresponding restricted print
size. An action sequence panorama portrays
the subject’s action over a theoretically
unlimited distance and the resulting
composited file can be printed very large. 
I’ve successfully used this technique to
photograph a variety of moving subjects
such as running cheetahs, birds in flight,
dogs competing in agility trials and hot-air
balloons floating above the landscape.

The timing of the captures can be
accomplished using a DSLR’s sequence drive;
most have a frame rate between four and
twelve frames per second. Even slower drives
are usable with most subjects because when
the composite is created there needs to be
space between each rendition of the subject
so that they don’t overlap or run into one
another. It is imperative, however, that the
series of images be captured at consistent,

Balloon over Bend, Oregon. This action sequence panorama was captured at an excruciatingly slow pace as a hot air balloon
drifted peacefully before a backdrop of the Cascade mountain range. As I saw the balloon coming toward me I quickly added an
intervalometer to my tripod-mounted camera and set it to fire every 10 seconds. All I had to do from that point was keep the
balloon centered in the frame as each image was automatically captured. The camera had been leveled on the tripod, so it was
fortunate that the balloon followed its gentle ‘S’ curve course that kept it within the upper and lower limits of the frame. 

Canon EOS 5D Mark III, EF 100-400mm f/4.5-5.6 at 220mm | ISO400 | 1/500s | f13 | Images composited in Photoshop CC 2014 using layer masks

A French poodle jumps two hurdles
in an agility competition. This action
sequence panorama was captured at
10 fps using a Canon EOS-1D Mark IV

with an EF 70-200mm f/2.8 at
73mm. Every third image was used

to compose the panorama. 

All photos: ISO 800 | f11 | 1/1500s



uninterrupted intervals; do not lift your finger
from the shutter button. In addition, be
mindful of the need to overlap images
sufficiently to create the panorama
background. Because the final composition is
a level, horizontal panorama, the subject’s
movement needs to pass before the camera
in a roughly horizontal plane while remaining
within the frame. Clearly, this aspect of 
the capture process is the random,

serendipitous part when working with
animals and birds in the wild. When possible,
I work from a tripod leveled to the horizon
and follow the subject as it moves parallel 
to me. It is possible to capture panorama
sequences handheld, as some of the
examples here demonstrate, but the
horizontal leveling must be maintained. 
For this reason, it is often useful to capture
the sequence with some extra space above

and below the subject to allow for
subsequent cropping.

For sequences of slow-moving subjects,
such as the hot-air balloon featured here, an
interval timer can be used to produce
evenly-spaced captures at longer intervals
such as those you might use for a time-lapse
sequence. I always carry an intervalometer in
my camera bag, and many newer cameras
have interval shooting functionality built in. 

Egret Flight Pattern. A single cattle egret
in flight is photographed with a
handheld Canon EOS-1D Mark IV. The
composite, created using layer masks in
Photoshop CC 2014, uses every third
image of the series captured at 10 fps.

Canon EOS-1D Mark IV and an EF 500mm f/4L
telephoto set to ISO 800 | f11 | 1/2000s
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Assembling Panoramas using Layer Masks

1⎢Open your source images in Adobe Camera Raw

2⎢Click ‘Select All’ 

3⎢Use the sliders and controls on the right to optimize all of the images in the same way 

4⎢Save all the images to a new folder

Assembling an action sequence panorama is a manual exercise. I use 
layer masks in Photoshop to composite the final image and do some minor
positional adjustments of the repeating subject. This tutorial will give you
insight into a simple Photoshop technique that can be applied to a great
variety of projects. And what you learn in post-capture will help you to plan
better for your next photography session in the field.

Preparing the Images

Optimize all the images in the sequence as a batch, using either Adobe Camera Raw (ACR)
or Adobe Lightroom. Select all of the images, choose one frame that is representative of
the series and optimize it (sharpen, and improve contrast and color). In ACR, the changes
will be applied simultaneously to all of the selected images. In Lightroom, use the Sync
function to apply the changes to the remaining selected images. This example illustrates
the sequence of steps in ACR.

1

3

4

2
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Composing the Panorama

Review the images and select those that will comprise the final
composition; create a series that best tells the story of the subject’s
journey through space and time. This could be every second, third, or
even fourth image, but remember that they must be spaced evenly and
the backgrounds must match.

1⎢Open all the images on the Photoshop Desktop, select Window > Arrange
> Float All in Windows and resize your images on the desktop so you can
see them all at once

2⎢Create a new blank image file with a white background canvas large
enough to hold the overlapping images that will comprise the action
sequence panorama. Make sure the canvas has the same bit depth and
resolution as the images that will be placed upon it. In this example, the
canvas was created at 200 dpi and 8-bit, as were the seven base images.

3⎢Select the Move tool and drag the first image into position at the left edge
of the blank canvas. I prefer to start on the left and work to the right, but
you don’t have to do it this way if right-to-left makes more sense to you.

4⎢Use the Move tool to bring the second image of the sequence onto the
canvas. It will be added automatically to the image file as Layer 2,
obscuring the first image. 

5⎢Reduce the opacity of the second layer to 50% so you can see through it,
then line up features in the two images, such as the branches in the 
foreground in our exmple

6⎢Once the images are aligned, return the second layer to 100% opacity

1

2

5
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Adding successive layers
Use a layer mask and brush to process each
successive layer and blend the images together.

1⎢With the second layer at 100% opacity, add a white,
default layer mask by clicking on the layer mask icon
(square with a hole in it) 

2⎢The mask will be indicated to the right of the highlighted
image layer in the Layers panel

3⎢Select black as your foreground color

4⎢Choose a brush with a soft edge and, with the layer mask
active, paint away (i.e., erase) the edge and other areas of
the second layer to reveal the important parts of Layer 1 

5⎢Use the Opacity slider to increase the transparency of the
top layer so you can view the details of the layer below

6⎢Use the bracket keys to make the brush smaller or larger. 
If you make a mistake, use the X key to change the
foreground color to white and paint back (i.e., replace) the
top layer.

When this process is completed, two images of the subject
will be composited. Repeat the process by bringing the
third image into the panorama file (it becomes Layer 3)
and continue with each new image until you have
completed your composition.

Finishing the image
Touch up, crop and flatten the layers to create the finished panorama.

1⎢Check the composited panorama carefully for flaws and
unwanted elements while still in layers. Saving a copy of
the Photoshop file with the layers intact will allow you to
revisit and rework the composition later if necessary. 

2⎢In the Layers menu, click on Flatten Image to composite
the layers into a single small image file 

3⎢Crop the image and optimize it in Photoshop, ensuring
that the images are merged seamlessly

1

2
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We’re all familiar with aerial panoramas, as
that’s how Google Maps are produced 
from satellite imagery. The camera captures
overlapping images as it moves parallel to the
earth below, always positioned perpendicular
to the active image area. I employ the aerial
panorama concept from airplanes and
helicopters and also on the ground and in the
studio – in other words, in any circumstance
where I can accomplish a series of captures 
by moving the camera or the subject to 
keep them on perfectly parallel planes
perpendicular to the lens. 

The simplest (but unfortunately most
expensive) way to capture an aerial panorama
is from a small private aircraft or helicopter
that allows you to work through an open door
or hatch. Taking a quick series of overlapping
images – either horizontally or vertically – is
relatively easy as the plane’s movement 
in space is minimal in relation to the distance
to the subject, rendering the nodal point 
pivot position irrelevant. Such images will
composite nicely for an interesting aerial
panorama. A variation on this technique 
uses the latest multicopter/drone technology
combined with a bit of skill. The
operator/photographer rotates the aerial
vehicle in increments and takes a series of
images that are later composited. Some
excellent examples from Russell Brown
(Adobe’s Senior Creative Director) can be seen
here: www.photoshop.com/tutorials/20223

A more interesting approach to aerial
panoramas yields a perspective the human
eye cannot see on its own. Because it applies
the concept of mapping to a panoramic
subject, I call this approach the ‘aerial
mapping panorama’. Let’s imagine a
photographer in a small airplane traveling
parallel to a scenic mountain range with the
camera pointed out the open hatch or
window and the lens perpendicular to the
subject. While the airplane’s movement
constantly repositions the camera, the
photographer takes a series of photographs
at approximately 5-second intervals,
depending on the speed of the plane and its
distance from the subject. While an interval
timer would work, the most important aspect
of the capture timing involves the 50%
overlap from one image to the next and
maintaining a consistent distance from the
camera to the subject (which, of course, is the
pilot’s job).

This technique works best with a medium
telephoto lens positioned at a generous
distance from the subject. I’ve had good
results with focal lengths of 80 to 135mm;
close perspectives and wide-angle lenses
don’t work due to the distortion at the edges
of the images, which creates havoc at the
assembly stage.

If you don’t have a private plane at your
disposal, you can use the aerial mapping
panorama technique on the ground with

similarly interesting results. As an example,
I applied it on an assignment for a landscape
architect who wanted to promote work he
had done across the front of a large
property. A single wide-angle image was not
an option, because the distance from one
end of the property to the other was too
great, and another structure across the
street precluded me from moving back far
enough to capture a panorama without
significant loss of perspective at the edges.
The solution was the mapping panorama: I
moved along the front of the property on a
parallel trajectory, capturing an image every
six feet with my 28mm lens perpendicular to
the subject. I overlapped each image by 50%
(hence six feet between captures). It wasn’t
easy to composite the captures taken from
such a close perspective, but the end result
was very satisfying and provided a detailed
view of the landscape such as a viewer
would see if strolling along the edge of the
property.

Excellent ground-level subjects for
mapping panoramas include large rock 
or ice formations and other complex
man-made and natural structures. The
multiple points of view make for challenging
assembly, but several stitching/compositing
programs do an excellent job of matching
the edges of overlapping images. I’ve 
had greatest success with Autopano/Giga
and PTGui.

Advanced Panoramas | George Lepp Workshop

Mapping Panoramas in the Air and on the Ground

A standard aerial panorama is similar to taking multiple images from the same location on the ground. For this example, 
the plane was moving while I shot the six source images, but I took them as fast as possible to minimize the change in the
camera’s position. Because the camera was so far from the subject, the forward movement of the plane didn’t affect the 
final panorama. This approach works even better from a helicopter because the forward movement can be minimized and 
the helicopter can be more precisely positioned. These images were taken with a Canon EOS 5D Mark III and an EF 24-105mm
lens (1/1000s, f11, ISO400). The fast shutter speed was important to minimize vibration and f11 was chosen because it is 
the sharpest f-stop offered by the lens. The panorama was composited using the Photo Merge tool in Photoshop CC 2014.
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Aerial mapping from a plane. This aerial mapping
panorama consists of 55 images captured at

5-second intervals from a plane flying along the
Oregon Cascades mountain range. The

camera/lens combination was positioned square
to the mountains, and the movement of the

airplane continuously repositioned it to enable a
capture sequence in which each image

overlapped the previous one by 50%. The
resulting panorama allows the viewer to recreate

the perspective of the plane’s journey. 

Canon EOS 5D Mark III with an EF 24-105mm 
lens set to 82mm

ISO 400 | f13 | 1/1000s 
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Aerial Panorama shot from a Helicopter. A grand
vision of beautiful Morro Bay, California, comprised
of five images photographed from the open door of
a small, relatively stationary helicopter. Due to the
wide-angle perspective, each of the five captures
was overlapped with the previous one by 50%. 

Canon EOS-1Ds Mark II with a 28-135mm lens set to 28mm 
ISO 200 | 1/750s | f9.5 

This 51-image panorama is an example of
aerial mapping techniques applied to a
ground-level assignment. The unusual
perspective is achieved with a 28mm lens 
at f8, taking overlapping captures at
six-foot intervals along the property line
and compositing them in Photoshop using
layer masks.



While a typical panorama is created by
capturing two or more overlapping segments
sequentially using a single camera, this
method doesn’t work with multiple subjects
that are simultaneously in action throughout
the composition. Examples of this type of
situation include a flock of birds rising from a
field, lightning strikes across a landscape or
running wild horses. The way to capture such
subjects in a high-resolution panorama that
will yield a large print is to position multiple
cameras to cover the scene and fire them all
at the same instant.

Any combination of two or more matched
camera/lens combinations will work as long

as they can be fired simultaneously and
provide sufficient overlap (20% to 50%
depending on the focal length of the lenses).
In the example shown here, I used three
full-frame cameras with identical lenses to
keep things simple. The cameras are attached
to a Really Right Stuff 18” camera bar using
three PC-PRO panning clamps with B2-Duo
clamps positioned so that the angle of view of
the outside cameras overlaps that of the one
in the center. This hefty rig is mounted on a
very sturdy tripod with a robust ball head and
allows the photographer to pan with the
action and maintain perfect synchrony among
the cameras. You can mount the cameras on

individual tripods set closely together, but this
is less than ideal if your subject will be
changing position. If you don’t have access to
all that gear, get a few friends with similar
equipment to work together on the project.

To achieve the simultaneous firing of all the
cameras, I wired three electronic cable release
cords to a single trigger. As an alternative, I also
have a wireless trigger system with a receiver
that has three cable release outputs to the
cameras. This enables me to fire them all at the
same time from a single transmitter. This
approach is perhaps a solution seeking a
photographic problem, but then maybe that’s
the definition of creativity.
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Multi-camera Panoramas

Panorama of Pacific waves. A three-camera simultaneous capture pano system made it possible to
photograph this constantly moving seascape in a high-resolution composited panorama. The three Canon
EOS 5D Mark III cameras were fitted with EF 200mm f/4L lenses at 200mm and the captures overlapped
by approximately 30% to enable compositing using the Photo Merge tool in Photoshop CC 2014.



Ultra-high-resolution composite panoramas
literally take images to greater lengths. DSLRs
assisted by a variety of equipment options can
be used to capture extremely large image files
more than a gigabyte in size that can be
printed to wall-size or explored in explicit
detail online.

The most difficult aspect of producing an
effective and interesting high-resolution
landscape is finding a subject worthy of the
work that lies ahead. Bigger is not enough and
composition counts even more than usual in
such situations. Imagine that the viewer, when
entering the image from one end, is embarking
upon a story: it must have a beginning to
capture attention, content and detail to hold
that attention throughout and a satisfying
ending. A large print with many details can be
closely inspected for surprising components or
appreciated as a whole if the viewer can move
back from it. The better the composition and
the more substance contained in the image,
the longer you will hold the viewer’s interest.

Once you have your subject and vision in
sight, capturing a high-definition composite

panorama in a series of precise rows and
columns requires meticulous organization and
workflow, aided by specialized equipment. 
The manually operated Lightweight Add-on
Pano Package, Pro from Really Right 
Stuff (www.reallyrightstuff.com) is small and
lightweight and can be carried in a camera bag
with the rest of your gear. The device keeps
each row of captures perfectly aligned, but it is
nevertheless essential to proceed methodically
and without interruption and take notes to
keep track of starting positions and overlaps so
that the images will line up properly at the
computer-based compositing stage.

For really big jobs, automated systems
such as the GigaPan Epic Series
(www.omegabrandess.com), and the Clauss
Rodeon piXplorer/piXpert (www.dr-clauss.de)
are superb tools. I’m most experienced with
the GigaPan Epic Pro system, which can
handle a camera and lens combination of up
to 10 pounds. Really Right Stuff offers an
upgrade of the mounting platform for the
Epic Pro that goes a long way toward keeping
the camera/lens more secure while it is in use.

When working with the GigaPan, my two
favorite camera/lens systems are the Canon
EOS 5D Mark III with either an EF 70-200mm
f/2.8 or EF 100-400mm lens, and the Canon
EOS 7D Mark II with the 100-400mm
f/4.5-5.6L IS II. The crop factor or angle of
view for the latter combination is equivalent
to a full-frame camera at 160-640mm. If
you’re aiming to shoot a high-definition
composite, use a telephoto lens for
maximum detail. That said, you should
choose the camera/lens combination based
upon the expected use of the image;
capturing hundreds of images with a 600mm
telephoto and painstakingly compositing
them doesn’t make sense if the final print will
be relatively small, say, 4 x 12 feet. I seldom
use a focal length longer than 200mm on the
EOS 5D Mark III, and the maximum size of the
resulting print is typically 20 feet by 60 or 44
inches (the width of the paper in my
printers). Canon USA has used my big
high-res prints in their displays at trade
shows to demonstrate the capabilities of 
the Canon bodies and lenses.
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High-definition Composite Panoramas



Mount the GigaPan on a sturdy tripod and
level it using the built-in indicator. Mount
your camera and level it to the horizon.
Choose your file format based upon your
computer’s capability and tolerance for
working with huge amounts of data. When I
am generating a large number of images, I
often work in a JPEG format. Set exposure,
focus and white balance manually. You 
can then program the GigaPan system by
following prompts to enter the focal 
length of the lens and the parameters of 
your planned composition. The system
automatically calculates the number of rows
and columns needed to optimally cover 
the image space and starts work. The
photographer steps back and, very often,

spends the next few moments answering
questions about the setup from curious
bystanders.

For more complex captures, the GigaPan
system offers many additional options that
can be selected from the front LCD at the
setup stage. Some that merit additional
commentary are:

Panorama Memory
Repeat the last panorama

Time/Exposure
Timed interval between capture positions

Mirror Lockup
Best set manually on the camera before
starting
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The GigaPan Epic Pro is now available from Omega Brandess for $995. The 2-axis bubble
level on the camera accessory shoe assists in leveling the camera to the horizon. The
attached camera is a Canon EOS 7D Mark II with an EF 100-400mm f/4.5-5.6L IS II zoom lens.

Two of the GigaPan’s LCD prompts that help
the photographer with the setup process

Capturing Gigapixel Images



Start Delay
Delay the start of the series

Pic Order
Very important, as you can order the images
in vertical columns beginning at the left
margin, or in horizontal rows beginning at
the top. I typically choose the horizontal
capture option in landscapes that include
moving clouds. 

Time-Lapse Series
Instructs the system to repeat the GigaPan
capture series at intervals of 0 seconds to 99
days. An external power source is advised.

Battery Status
Always carry an extra battery

Shutter Mode
The camera can be fired automatically at
each position or set to allow the
photographer to manually fire the shutter
with a remote. This option facilitates
capturing panoramas that use stacking at
each position.

Picture Overlap
The default horizontal and vertical overlap is
30% from one capture to the next. Overlap
can be adjusted from 25% to 75% in 5%
increments. 
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Assembling High-definition
Composite Panoramas

Now that you have hundreds of images
destined to become a high-definition single
composite, how do you handle them? You can
either assemble them for printing and/or
upload them to the GigaPan website
(www.gigapan.com), where a multitude of
GigaPan images reside and can be thoroughly
explored in minute detail.

The first element of my workflow is to load
all of the images (in this case, a total of 135)
into Lightroom, highlight them all, select one
image that is representative of the overall
color and tone and optimize it in the Develop
module. I then click the ‘Sync’ button to apply
my adjustments to the rest of my images and
save them to a single folder.The source images loaded into Lightroom
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Assembly Using GigaPan Stitch

The GigaPan Stitch software comes free with the GigaPan
but can be purchased separately. The photographer enters
the capture parameters and the software begins assembly.

1⎢Click ‘Add Images’ to
find and select the
appropriate folder.
Enter the number of
columns you captured.

2⎢Select the layout that
depicts the direction of
the capture sequence

3⎢Click ‘OK’. The images
will be properly ordered
and the rendering of
the panorama will
begin. 

1⎢When compositing is
complete, a celebratory
message will display
along with the
assembled GigaPan file

2⎢To export the
composited GigaPan to
your hard drive click on
‘Export Stitched Image’.
The menu shown on
the right will appear.

3⎢Choose Classic TIFF and
full size, click ‘Browse’
and choose the location
for your GigaPan TIFF
file. Then click ‘Export
now’.

4⎢If you want your image
to be immediately
uploaded to the
GigaPan Website, click
‘Upload>>’. However, I
suggest optimizing the
image in Photoshop
before placing it on the
website.

3

1

1

2

3

4

2

Create the image file and save it to the location of
your choice and/or upload it to the GigaPan website
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A GigaPan image of Owl Creek Pass, Colorado. 
This image was assembled in GigaPan Stich using
135 source captures and finished in Photoshop.
The final size of the finished 8-bit TIFF file is 1.33GB.

This single-image
capture extracted from

the GigaPan image
demonstrates the

extremely high
resolution and

enlargement capability
of the composited file



When a photographic situation calls for an
extreme range of tonal values or expanded
depth of field, HDR and stacking procedures
can save the day. Combination panoramas
employ these creative and problem-solving
techniques to achieve practically limitless
tonality and/or sharpness in a panorama. 

HDR Panoramas. The example shown
here is a multi-row panorama photographed
at Mono Lake, California in flat midday light.
Applying HDR at capture improved the tonal
range, luminosity and texture of the
landscape.

The Really Right Stuff (RRS) Lightweight
Add-on Pano Package, Pro was used with
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The 22 sets of exposures were batch processed in Photomatix Pro 5 to produce the 22 HDR
composites shown here, ready to be combined in a panorama using GigaPan Stitch

Combination Panoramas

A small section of the
high-resolution panorama
reproduced above is
shown here in a cropped
detail of three kayakers
moving among the tufa
formations at Mono Lake,
California. Because the
kayaks moved during the
HDR captures and were
blurred in the composite,
a mid-range exposure
was inserted in the
correct position using a
layer mask. 



an RRS BH-55 Ball Head to assist in aligning
and organizing the capture process in this
two-row panorama. A Canon EOS 5D Mark
II with an EF 70-200mm zoom set to
195mm were mounted on the RRS rig. At
each position, three images were captured
with an exposure differential of two stops
each. Careful notes of the calibrations on
the panorama rig helped to ensure that the
starting positions and intervals between
captures matched from one row to the
next – an important aid to later assembly.
Because the clouds were moving, the top
row was photographed first and as quickly
as possible. The result was 66 images

captured at 22 positions in two rows. The
kayaks in the water moved during capture
of  the three HDR images so, once the
panorama was assembled, I used a layer
mask to drop in the middle exposure of 
the three HDR images at that position 
to get a sharp image of each kayak 
while preserving the HDR look of the
surroundings. Another way to deal with
moving objects in an HDR panorama 
is to capture your source images,
re-photograph the moving objects at the
same focal length and drop them into the
composited panorama at any desired
location using Photoshop layer masks.

When assembling an HDR combination
panorama, the first step is to process the
captures for each position. In this case, I
used Photomatix (www.hdrsoft.com) to
combine each set of three exposures using
the software’s tone mapping capability. The
22 HDR composites were then assembled
using panorama software. Because the
images contained areas of undetailed sky, 
I used GigaPan Stitch and Autopano Giga;
these programs are able to make
compositing decisions based upon the
position of an image within the panorama
rather than matching features in 
adjoining frames. 
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The Really Right Stuff
Lightweight Add-on

Pano Package that was
used to photograph the

Mono Lake HDR
panorama. The main

advantage of this setup
is that it is light enough

to be carried in a
photographer’s

backpack.

To achieve a luminous effect, HDR techniques
were applied to this landscape of tufa formations
at Mono Lake, California. Three bracketed
exposures at each of 22 positions produced 66
images that were batch processed in Photomatix
Pro 5 and composited to produce the final
panorama.

Canon EOS 5D Mark II and EF 70-200mm lens at 195mm
ISO200 | f11 | exposures of 1/1000s, 1/4000s and 1/250s



Our article on macro focus stacking in Issue 16
of c’t Digital Photography introduced the
concept of creating high-magnification
composites using focus-stacking techniques.
Here we’ll take the idea further, expanding
both depth of field and image area in a
high-magnification combination panorama
that portrays a very small subject in a very
large, intimately detailed and surprising way.

While the general concept of creating 
a panorama from a series of composited 
or layered images is similar to the HDR
panorama creation process discussed 
above, high-magnification panoramas are
comparatively labor-intensive and require
meticulous execution to successfully bring all
the elements together. 

Subjects suitable for the high-mag
panorama treatment are small and
structurally complex, such as butterfly wings,
feathers, botanical specimens or crystals. In

this tutorial, we’ll photograph a tiny segment
of a moth’s wing at 8x in each position. This
magnification can be achieved with my
favorite macro setup, the Canon MP-E 65mm
1-5x macro lens mounted on a Canon EOS 7D
Mark II DSLR with its APS-C sensor (1.6x

cropped magnification and angle of view).
The camera/lens combo is mounted on a solid
copy stand or tripod and the small,
lightweight subject is placed on a stage that
can be moved in precise increments along its
x and y axes (equivalent to rows and columns).
This enables us to capture a set of
focus-stacked images at each position.

A repurposed microscope stage works well
for this method and can be found online at
sites like eBay or at universities and research
laboratories where old microscopes are being
replaced with digital units. Another useful
positioning system for panorama capture is
the Proxxon KT70 Micro Compound Table,

purchased through amazon.com for about
$100. This device is actually designed for
precise milling or drilling, but its stage works
beautifully when executing micro x/y
movements for small  panorama photography
subjects.

Focus stacking is best achieved with 
a StackShot motorized focusing rail
(www.cognisys-inc.com) that attaches to 
the copy stand/tripod and moves the
camera in increments from 2 microns to
100 mm using a dedicated controller and a
step motor. The system can be programmed
to incrementally reposition and fire the
camera through a predetermined range,
making the entire focus-stacking capture
procedure automatic and hands-off. A good
focus light, such as a small LED, is necessary
for positioning the subject and focusing, 
and a macro flash system supplies the
necessary light at capture.
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Macro and High-magnification Panoramas

Two tools that can be used to create a macro panorama,
both with the capability of making tiny, precise movements
on the x and y axes. Pictured are (left) a Proxxon KT70 Micro
Compound Table purchased from amazon.com and (right) a
re-purposed microscope base that enables not only x and y
movements, but also vertical micro movements useful in
lower-magnification stacking projects.
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A high-mag/macro panorama typically
comprises hundreds of individual source
images, but there really is no limit. At high
magnifications, the panorama captures
require an overlap of approximately 30%. A
series of stacked images is taken at each
position before moving the subject (mind
the overlap) for a new focus stacking series,
and the process is repeated until the first
row of stacks is finished. Adjoining rows can
be captured to build up a larger finished
composite, but this technique works best 
if you assemble each row and detect 
any errors before repositioning the stage 
to shoot the next row. I prefer to use 
Zerene Stacker (www.zerenesystems.com) to
composite the individual stacks, but Helicon
Focus (www.heliconfocus.com) is another
excellent option. Composite the group into
a one-row panorama using Photoshop CC
2014 or Autopano Giga. Examine your results
carefully and only realign the stage to
photograph the next row once you are sure
that the previous row is complete and
perfectly focused throughout. To complete
the panorama, stitch the rows together one
at a time.

Some of my favorite subjects for
high-magnification macro photography are
the patterns and textures found on butterfly
and moth wings. In this example, I worked
with a Madagascan Sunset Moth, one of the
most beautiful of all lepidoptera species. The
specimen I used was farm-raised, not taken
from the wild. (sea)
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The finished macro
panorama of the wing of a
Madagascan Sunset Moth is
comprised of 80 stacked
images. The number of
captures in each stack
varied from a minimum of
eight to a maximum of 50,
depending on the depth of
field necessary for the area
being photographed. With
a total of 1,438 captures,
the composited 8-bit file is
2.13GB in size.

The color of the Madagascan Sunset Moth (Urania ripheus) is
produced by iridescence rather than pigments. The red marking
shows the approximately 50x10mm area of the moth’s wing
that was photographed for this project. c



Book Review
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Modern architecture is not
always at war with nature.

Norway has a long tradition
of designing buildings that fit

in with the rawness of the
surrounding landscape. Im
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Just like many other popular destinations,
Norway has developed routes that enable

tourists to visit and enjoy the beauty and culture
of its landscape. Its 2,000 km of designated
routes take travelers through an ever-changing
landscape of coastline, fjords and mountains,
and Norway’s highway authority has been
working since 1994 to keep the views along
these roads attractive so that they enhance
Norway’s reputation as a scenic wonderland

When 50 top architects, designers and artists
were asked to contribute their creative ideas to
the tourist route project, the result was a series
of innovative structures and installations in
which architecture and art express their affinity
for and dependence on untouched landscapes.
There are sculptures, lookout points, rest areas
and walking trails that use natural materials –
mostly wood, glass and steel – to underscore
the beauty of their surroundings.

Having traveled the length and breadth 
of Norway for several years, drawn by its 

light and landscapes, photographer Ken
Schluchtmann first encountered one of these
buildings in 2008. The experience set him off
on a five-year, 20,000 km journey to visit 
each and every one of these unique
architectural sites.

Rather than aiming for maximum visual
impact, his photographs portray the places 
he visited with an authentic, timeless feel. This
was clearly a time-consuming project – the
lighting, weather and framing are always just
right for the subject, and viewing these photos
is almost as good as being there.

The presentation of the book enhances and
complements the reader’s experience. There is
no text apart from the introduction, and the
photographs are left to tell their own stories.
The cloth binding is decorated with a real
photo, and much care has been taken with the
high-quality reproductions and the layout,
which make the book a pleasure to handle as
well as to read and look at. (tho)

Architecture and Landscape 
in Norway
Nature Contrasts with Modern Buildings 

Architecture and Landscape 
in Norway

Ken Schluchtmann
Published by Hatje Cantz
160 pages, 107 color illustrations
Text in English and German
11 x 13.5 inches, Cloth hardcover
$75.00
ISBN: 978-3-7757-3837-8
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Artistic Travel Photo Workshop

❚ˇPro photographer Pavel Kaplun uses photos
from a trip to India to demonstrate how to
use color as a compositional tool and as a
stylistic device when editing your images. His
hands-on examples show how a little
carefully placed color can radically alter the
effect an image has on the viewer.

Image Editing with 
Raw Converters

❚ˇToday’s raw converters are rapidly turning
into full-fledged all-in-one image editing
solutions, with functionality like selective
color and tonal adjustments, lens error
corrections and all kinds of retouching tools
built in. We test today's most popular raw
converters and check which really deserve
the 'all-in-one' moniker.

Canon EOS 5DS R
More Pixels than Ever Before

❚ˇCanon’s 50.6-megapixel EOS 5DS R takes a
big step toward bringing medium-format
resolution to full-frame cameras. All that
resolution should provide ultra-sharp detail
reproduction, so to find out if it really makes
the grade, we pit the Canon against the
Nikon D810 and the Sony a7R, and
investigate which lenses are up to the job of
utilizing its mega-resolution to the full.

Coming up in Issue 22
• • • • •
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